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Introduction
Thank you for purchasing the Inkjet printer 330 Series.
Read this operating manual ("this document" hereinafter) thoroughly and make sure you understand its
contents to ensure safe and correct use of the product.
Please note that the illustrations contained in this manual are intended to show functions, procedures, or
operations and may sometimes differ slightly from the actual machine.
Adobe, the Adobe logo, Acrobat, Illustrator, Photoshop, and PostScript are the trademarks or registered
trademarks of Adobe Incorporated in the United States and other countries.
RasterLink and TxLink are trademarks or registered trademarks of Mimaki Engineering Co. Ltd. in Japan and
other countries.
Other company and product names mentioned herein are the trademarks or registered trademarks of the
respective companies in Japan and in other countries.
Unauthorized reproduction of any portion of this document is strictly prohibited.
© 2022 MIMAKI ENGINEERING Co., Ltd.

l DISCLAIMERS
• MIMAKI ENGINEERING REJECTS ALL LIABILITY FOR DAMAGE ARISING DIRECTLY OR

INDIRECTLY FROM THE USE OF THE 330 Series ("THIS MACHINE" HEREINAFTER), WHETHER OR
NOT THE PRODUCT IS FAULTY.

• MIMAKI ENGINEERING REJECTS ALL LIABILITY FOR DAMAGE, DIRECT OR INDIRECT, TO
MATERIALS CREATED WHILE USING THIS MACHINE.

• USING THIS MACHINE IN CONJUNCTION WITH DEVICES OTHER THAN THOSE RECOMMENDED
BY MIMAKI ENGINEERING MAY RESULT IN FIRE OR ACCIDENTS. SUCH INCIDENTS ARE NOT
COVERED BY THE PRODUCT WARRANTY. MIMAKI ENGINEERING REJECTS ALL LIABILITY FOR
DAMAGE, DIRECT OR INDIRECT, ARISING FROM SUCH INCIDENTS.

• USE ONLY GENUINE MIMAKI ENGINEERING INK AND MAINTENANCE LIQUID. USE OF OTHER
PRODUCTS MAY RESULT IN FAILURES OR REDUCE PRINT QUALITY. SUCH INCIDENTS ARE
NOT COVERED BY THE PRODUCT WARRANTY. MIMAKI ENGINEERING REJECTS ALL LIABILITY
FOR DAMAGE, DIRECT OR INDIRECT, ARISING FROM SUCH INCIDENTS.

• DO NOT ATTEMPT TO REFILL THE INK PACKS WITH UNAUTHORIZED INK. SUCH INCIDENTS ARE
NOT COVERED BY THE PRODUCT WARRANTY. MIMAKI ENGINEERING REJECTS ALL LIABILITY
FOR DAMAGE, DIRECT OR INDIRECT, ARISING FROM SUCH INCIDENTS.

• AVOID USING UV-LED UNITS OR UV POWER SUPPLY UNITS OTHER THAN THOSE SPECIFIED BY
MIMAKI ENGINEERING. USING DEVICES OTHER THAN GENUINE MIMAKI ENGINEERING
DEVICES MAY RESULT IN FAILURE, ELECTRIC SHOCK, OR FIRE. SUCH INCIDENTS ARE NOT
COVERED BY THE PRODUCT WARRANTY. MIMAKI ENGINEERING REJECTS ALL LIABILITY FOR
DAMAGE, DIRECT OR INDIRECT, ARISING FROM SUCH INCIDENTS.

l TV and radio interference

• The machine emits high-frequency electromagnetic radiation while operating. Under certain
circumstances, this may result in TV or radio interference. We make no guarantee that this
machine will not affect special radio or TV equipment.

If radio or TV interference occurs, check the radio or TV reception after turning off the machine. If the
interference disappears when the power is turned off, the machine is likely to be the cause of the
interference.
Try any of the following solutions or combinations of these solutions:

• Change the orientation of the TV or radio antenna to find a position where interference does not occur.
• Move the TV or radio away from this machine.
• Plug the TV or radio into a power outlet on a power circuit other than the power circuit to which this

machine is connected.
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l FCC (Federal Communications Commission) regulations
The machine has been tested and certified to comply with restrictions applying to Class A digital devices
under Part 15 of the FCC regulations. These restrictions are designed to provide suitable protection from
harmful interference when the printer is used in commercial environments.
This product may generate, use, or emit radio frequency energy and may cause harmful interference with
radio communications if not installed or used in accordance with the operating manual.
Use of this product in residential areas may cause harmful interference. If so, the user is responsible for
rectifying such interference.

• Use only the cables recommended by Mimaki Engineering when connecting to the machine.
Use of other cables may cause the product to exceed the restrictions stipulated by FCC
regulations. To maintain compliance with FCC regulations, use the cables recommended by
Mimaki Engineering.
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To Ensure Safe Use

Symbol Marks
This document uses symbol marks to explain precautions when operating the machine. Make sure you fully
understand the meaning of each mark to ensure safe and correct use of the machine.

Explanation

Warning Indicates a potential hazard that may result in death or serious injury
if handled improperly or if instructions are disregarded.

Caution Indicates a potential hazard that may result in minor or moderate
injury if handled improperly or if instructions are disregarded.

Notice Indicates a potential hazard that may result in property damage if
handled improperly or if instructions are disregarded.

Warning sign Indicates something that requires attention. Warning specifics are
drawn inside the symbol.

Mandatory action
sign

Indicates an action that must be carried out. The specifics of the
mandatory action are drawn inside the symbol.

Prohibition sign Indicates a prohibited action. The specifics of the prohibited action
are drawn inside the symbol.

Important Indicates important information related to use of this machine.

Tip Indicates useful reference information.

Reference
information

Indicates the corresponding page for related information.

Explanation of model icons

• Model icons are shown for items where differences exist between models.

CJV TS UCJVJV
• Model icons are not shown for items where the details are the same for all models.
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Usage Precautions

l In the event of abnormal conditions

• In the event of abnormal conditions such as smoke or unusual odor, turn off the main power
immediately and unplug the power cable. Continuing to use the machine under these conditions
may result in failure, electric shock, or fire. Once you have confirmed that smoke is no longer
being emitted, contact your local dealer or our service office. Never attempt to repair the
machine yourself, which is hazardous.

• Immediately wipe off any ink, maintenance liquid, waste ink, or other liquid used with the
product that comes into contact with your skin. Then wash using soap, and rinse with plenty of
water. Failure to wash off ink may result in skin inflammation. If your skin becomes irritated or
painful, seek medical attention immediately.

• If ink, maintenance liquid, waste ink, or any other liquid used in the product comes into contact
with your eyes, rinse immediately with plenty of clean water. Rinse for at least 15 minutes. If you
wear contact lenses and they can be easily removed, remove after rinsing for at least 15
minutes with clean water. Be sure to also rinse the undersides of your eyelids. Failure to rinse
off ink may result in blindness or impaired vision. If your eyes become irritated or painful, seek
medical attention immediately.

• If ink, maintenance liquid, waste ink, or any other liquid used in the product enters your mouth or
is swallowed, gargle with water immediately. Do not induce vomiting. Seek medical attention
promptly. Inducing vomiting may cause liquid to enter the airway.

• If a large amount of vapor is inhaled, move to a well-ventilated area, keep warm, and rest in a
posture that allows easy breathing. If the condition does not improve, seek medical attention
promptly.

• If an ink leak occurs, turn off the main power immediately and unplug the power cable. Then,
contact your local dealer or our service office.
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l Power supply precautions

• Use the power cable provided. Otherwise there is a risk of failure, electric shock, or fire. The
power cable provided is exclusive for the machine, and must not be used for other electrical
equipment.

• Always hold the plug when removing the power cable. Pulling out the power cable may damage
the cable, leading to failure, electric shock, or fire.

• Do not use the machine with dust accumulated on the power plug. Otherwise there is a risk of
failure, electric shock, or fire.

• Take care to prevent metals from touching the power plug blades. Otherwise there is a risk of
failure, electric shock, or fire.

• Do not damage or modify the power cable. Do not place heavy objects on, heat or stretch it.
Doing so may damage the cable, leading to electric shock or fire.

• Do not use extension cords or power strips. Otherwise there is a risk of failure, electric shock, or
fire.

• Do not use the power cable if it is damaged or broken or if the core wire is exposed. Otherwise
there is a risk of failure, electric shock, or fire.

• Do not handle the power plug with wet hands. Disregarding this precaution may result in electric
shock.

• Plug the power cable plug into a grounded power outlet. Otherwise there is a risk of failure,
electric shock, or fire.

• When installing electrical outlets, perform grounding work to prevent electric shock. All electrical
work (Class C grounding work; formerly Type 3 grounding work) must be handled by a licensed
electrician.

• Do not turn off the main power supply. Turning off the main power supply will disable the
automatic maintenance function (including nozzle clogging prevention function and ink
discharge channel cleaning function). This increases the risk of ejection failures (such as nozzle
clogging or deflection).

• Use the machine with a power supply that meets specifications.
• Be sure to plug the power cable into a power outlet close to the machine. Insert the power plug

blade securely.
• When connecting the power cable, check the input voltage of the power outlet and the capacity

of the breaker. Also, connect each cable to a separate power source with an independent
breaker. Connecting to power outlets linked with the same breaker will cause the breaker to trip.
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l Caution regarding moving parts

• Keep parts of the body such as the face and hands away from moving parts. Also keep clothing
(e.g., loose clothing and accessories) that may impede work away from the machine. Failure to
do so may result in injury.

• Long hair should be tied back. Failure to do so may result in injury.

l Do not disassemble or repair

• Do not attempt to disassemble or repair this machine. Otherwise there is a risk of failure, electric
shock, or fire.

l Handling the cutter

• Avoid touching the cutter blade. Failure to do so may result in injury.
• Do not shake or swing the cutter holder. Doing so may cause the blade to come off.

l Heater

• The heater becomes extremely hot. Do not touch with bare hands.

• Condensation may form on the print head nozzle surface depending on the ambient
temperature and humidity. The formation of condensation may cause ejection failures (e.g.,
nozzle clogging or deflection). Perform head cleaning if any ejection failures (e.g., nozzle
clogging or deflection) occur during printing.  "Head Cleaning"(P. 98) 
Set the print heater to a temperature not exceeding 35C, and ensure that the ambient
temperature is within the permissible operating temperature range (20 to 30C).  "Installation
Precautions"(P. 19)

l Ultraviolet light (UV) and the UV-LED unit
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• Do not place combustibles under the UV-LED unit, and do not cover it with paper or cloth. There
is a risk of fire or burns.

• Small amounts of ultraviolet light may leak from the UV-LED unit. Wear UV-blocking glasses or
a light-shielding face shield, mask, gloves, and long-sleeved clothing to avoid UV exposure to
the eyes and skin.
(1) Exposure to ultraviolet light may result in skin inflammation. Even if no inflammation occurs,

extended or repeated exposure may lead to chronic problems.
• Acute problems: Inflammation
• Chronic problems: Skin cancer, wrinkles, blotches

(2) Looking directly at the lamp while the lamp is on may result in eye pain or damage to
eyesight. Even if no eye pain occurs, extended or repeated exposure may lead to chronic
problems.

• Acute problems: Ultraviolet keratitis, conjunctivitis, discomfort, pain, watery eyes
• Chronic problems: Pterygium, cataracts

• The UV-LED unit becomes extremely hot. Be careful not to touch the LED after it has been
turned off until it has sufficiently cooled.

• Do not expose the skin or eyes directly or indirectly to light from the UV-LED unit. The UV-LED
unit emits ultraviolet (UV) light. Skin or eye exposure may result in inflammation.

• Be sure to use the UV safety glasses provided. Disregarding this precaution may result in eye
pain or damage to eyesight.

• Avoid scratching or subjecting the UV-LED unit to excessive force. Disregarding this precaution
may result in deformation or failure of the unit.

• Avoid touching the glass on the underside of the UV-LED unit with bare hands. Disregarding
this precaution may impair UV ink curing. If the glass becomes dirty, wipe clean using a soft,
clean cloth soaked with ethanol. Be careful to keep ethanol from splashing on the covers or
other parts while cleaning. Disregarding this precaution may result in deformation or failure of
the unit.

l Other usage precautions

• Keep children away from the machine.

• Do not pull the media when the clamp lever is lowered (the media is clamped). Doing so may
damage the machine.

• The underside of the media may be soiled depending on how the printed media has been stored
(due to weight when laying printed media rolls horizontally, for example) and the media type.
Perform a test beforehand to check that the media does not transfer ink to the underside of the
adjacent media.
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l Disposing of the product

• Please contact your local retailer or service agent.
• When disposing of the product yourself, contact an industrial waste disposal operator or dispose

of the product in accordance with local laws and regulations.
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Notes on Handling Ink or any Other Liquid
Used with the Machine
Precautions regarding ink, maintenance liquid, or other liquids used with this machine are included with the
containers. Thoroughly read them and make sure you understand the contents.

• Be sure to read the safety data sheet (SDS) before use. https://mimaki.com/supply/sds/

• Pay close attention to ventilation and be sure to wear safety glasses, gloves, and a mask when
handling ink, maintenance liquid, waste ink, or other solutions used with the machine. Leaking
ink may adhere to the skin or get into the eyes or mouth.

• Do not subject cases containing ink to strong shock or violent shaking. Do not attempt to refill
the ink. Leaking ink may adhere to the skin or get into your eyes or mouth.

• Do not disassemble cases containing ink. Leaking ink may adhere to the skin or get into your
eyes or mouth.

• Do not store ink, maintenance liquid, or other liquids used with the machine in locations where
children may enter.

• When disposing of ink, maintenance liquid or other liquid used with the product, or containers or
non-woven fabric contaminated with ink or other liquid, contact an industrial waste disposal
operator or dispose of the product in accordance with the local laws and regulations.

• Do not store ink, maintenance liquid, or other liquids used with the machine in locations
exposed to direct sunlight.

• Do not store ink, maintenance liquid, or other liquids used with the machine in environments
where cutting fluid or other volatile substances (such as amines or modified amine alcohol) are
present in significant quantities. Storage in such places increases the risk of failure or ejection
failures (e.g., nozzle clogging or deflection).

• Do not use ink, maintenance liquid, or other liquids used with this machine with other printers.
Doing so may cause failure.

• Be sure to store them in a low place no higher than 1 m above the floor. Otherwise there is a
risk of scattering if the containers fall.

• Store in tightly sealed containers.
• Store in a cool, dark place.

(1) Store ink in a place where ink does not freeze. Using defrosted ink may deteriorate ink
constituents and reduce print quality.

(2) When ink is moved from a cold place to a warm place, leave it in the environment where
the machine is installed for at least three hours before using it.

(3) Open the container just before installing it, and use it up as quickly as possible. If it is
opened and left for an extended period of time, print quality may be reduced.

https://mimaki.com/supply/sds/
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• Do not touch the metal parts of the ink IC chip. Static electricity may damage the ink IC chip,
and dirt or damage may cause the ink IC chip read error.

• Printing is not possible when different types of ink IC chips are used.
• If the ink bottle mounted on the machine is dented, it may still be used.
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Ink Specifications

Item JV330 Series, CJV330
Series

UCJV330 Series TS330-1600
TS330-1800

TS330-1600
TRAPIS

Type Special solvent ink
(Mimaki Engineering
product)

Special UV curing ink
(Mimaki Engineering
product)

Special sublimation
transfer ink (Mimaki
Engineering product)

Special pigment
trasnfer ink (Mimaki
Engineering product)

Color Cyan (C)
Magenta (M)
Yellow (Y)
Black (K)
Light cyan (Lc)
Light magenta (Lm)
Light black (Lk)
Orange (Or)
White (W)

Cyan (C)
Magenta (M)
Yellow (Y)
Black (K)
Light cyan (Lc)
Light magenta (Lm)
White (W)
Clear ink (Cl)

Blue (BL)
Magenta (M)
Yellow (Y)
Black (K)
Light blue (Lbl)
Light magenta (Lm)
Light black (Lk)
Violet (Vi)
Orange (Or)
Fluorescent pink (FP)
Fluorescent yellow
(FY)

Cyan (C)
Magenta (M)
Yellow (Y)
Black (K)
Red (R)
Green (G)
Blue (BL) 
Light black (Lk)

Form Aluminum pack Bottle Aluminum pack, 
ink tank*2

Aluminum pack

Ink
capacity*1

2,000 ml, 1,000 ml,
500 ml

1000 ml 2,000 ml, 10,000 ml*2 2000 ml

Expiration
date

As indicated on the ink pack. However, after
opening, it should be consumed within three
months, even if before the expiration date.

As indicated on the ink pack. However, after
opening, it should be consumed within one
month, even if before the expiration date.

Stora
ge
temp
eratur
e
*3

When
store
d

10 to 35 °C (daily
mean temperature)

• However, not
more than 1
month at 30 °C

5 to 30 °C (daily
mean temperature)

• However, not
more than 1
month at 30 °C

10 to 35 °C (daily mean temperature)

Durin
g
trans
portat
ion

1 to 40 °C
• However, not

more than 120
hours at 60 °C,
and not more
than 1 month at
40 °C

• Where possible,
avoid storing in
cold locations
below 0 °C and
hot locations
above 40 °C.

1 to 60 °C
• However, not

more than 120
hours at 60 °C,
and not more
than 1 month at
40 °C

• Where possible,
avoid storing in
cold locations
below 0 °C and
hot locations
above 40 °C.

0 to 40 °C

*1. Depends on ink type.
*2. Depends on options.
*3. Ink quality may deteriorate if stored outside this temperature range.
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Restrictions Concerning the Expiration Date of Ink Used in the
Machine

Example: When the expiration date is April 20xx
• May 20xx: Replace with new ink or use up as quickly as possible. Printing is possible.
• June 20xx: Replace with new ink or use up as quickly as possible. Printing is possible.
• July 20xx: Printing is not possible.

• The message appears on the display.

• The ink expiration date is indicated on the ink containers. Expired ink may cause ejection
failures or alter the color tone. Printing is possible even if the ink has passed its expiration date.
Nevertheless, we recommend replacing with new ink or using up as quickly as possible.

Restrictions Concerning Ink Set Changes
The following combinations of ink sets cannot be changed.

• For solvent ink
– 6-color, W (C, M, Y, K, Lc, Lm, W) -> 8-color (C, M, Y, K, Lc, Lm, Lk, Or)
– 8-color (C, M, Y, K, Lc, Lm, Lk, Or) -> 6-color, W (C, M, Y, K, Lc, Lm, W)
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Installation Precautions

• Do not install the machine in a place close to fire. Doing so may result in inflammation of solvent
ink.

• Do not place flower vases, pots, cups, containers containing cosmetics, chemicals or water, or
small metal items on or close to the machine. If they enter the machine, there is a risk of failure,
electric shock, or fire.

• Do not install this machine in humid locations or locations where it may be exposed to splashing
water. Otherwise there is a risk of failure, electric shock, or fire.

• Do not install the machine in a place where children may enter.

• A ventilation system must be provided if this machine is installed in a poorly ventilated area or
sealed room.

• Be sure to observe the following points when installing an extractor outlet:
(1) The extractor outlet must be installed in accordance with applicable local EHS

(environmental, health, and safety) guidelines.
(2) If the extractor outlet is fitted with a shutoff valve, the valve must be open when this

machine is in use.

• Do not install this machine in locations where dust or powder is present. Failure or printing
defects may result (e.g., nozzle clogging, deflection) if dust gets inside this machine.

• Do not install this machine in locations exposed to drafts (e.g., from air conditioning).
Disregarding this precaution may result in dust or powder getting inside this machine.

• Do not install this machine in unstable locations or locations subject to vibration. This will
increase the risk of failure or printing defects (e.g., nozzle clogging, deflection).

• Do not install this machine in locations exposed to direct sunlight.
• Do not install this machine in locations subject to sudden temperature changes. This will

increase the risk of failure or printing defects (e.g., nozzle clogging, deflection).
• Do not install this machine in locations exposed to excessive noise from large machinery.
• Do not install this machine in locations where photographic fixing agents generate vapor or acid

gas (e.g., acetic acid, hydrochloric acid) or locations filled with metal working fluids or highly
volatile substances (e.g., amines, amine-modified alcohols). Malfunctions or printing defects
may result (e.g., nozzle clogging, deflection) as print head ink is more likely to harden under
such environments.

• Operating environment: 20 to 30 °C (68 to 86 °F), 35 to 65 %RH (no condensation)
• Temperature range in which accuracy is guaranteed: 20 to 25 °C (68 to 77 °F)
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Installation Space
Provide the following space around the machine to allow safe and proper replacement of ink and media:

Installation space (width) Installation space (fro
nt to

 rear)

1000 mm or m
ore

1000 mm or m
ore

500 mm or more

500 mm or more

l JV330 Series
Size 160 130

Width*1 At least 4,170 mm (3,170 mm) At least 3,920 mm (2,920 mm)

Depth*1 At least 4,050 mm (2,050 mm*Including media chute)

Height*1 (1,305 mm)

Weight 368 kg 358 kg

*1. The figures in parentheses indicate machine dimensions.

l CJV330 Series
Size 160 130

Width*1 At least 4,170 mm (3,170 mm) At least 3,920 mm (2,920 mm)

Depth*1 At least 4,050 mm (2,050 mm*Including media chute)

Height*1 (1,305 mm)

Weight 373 kg 363 kg

*1. The figures in parentheses indicate machine dimensions.

l TS330 Series
Size 1600 1800

Width*1 At least 4,170 mm (3,170 mm) At least 4,500 mm (3,500 mm)

Depth*1 At least 2,820 mm (820 mm)

Height*1 (1,305 mm)

Weight 240 kg 250 kg

*1. The figures in parentheses indicate machine dimensions.
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l UCJV330 Series
Size 160 130

Width*1 At least 3,890 mm (2,890 mm) At least 3,640 mm (2,640 mm)

Depth*1 At least 2,805 mm (805 mm)

Height*1 (1,480 mm*Excluding ink bottle)

Weight 227 kg 217 kg

*1. The figures in parentheses indicate machine dimensions.

When Relocating This Machine
Contact your local dealer or our service office. Attempting to handle relocation yourself may result in failure
or damage.



Safety Interlocks

22

Safety Interlocks
The machine is equipped with interlocks to ensure safety during use.
Printing will abort if you open the covers while printing is underway. The RIP data will need to be resent.

• Safety interlock locations
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Warning Label
Make sure you fully understand the details indicated on the various warning labels.
If any of the warning labels becomes dirty and illegible or peel off, contact your local dealer or our service
office to request new warning labels.
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No. Order code Label Details

1 M910931 Beware of opening and closing
parts. Injury may result if hands
become trapped.

2 M907833 Indicates dangerous moving parts.

3 M903239 Indicates hot parts.
• JV/CJV: Pre-heater, post-heater
• TS: Post-heater
• UCJV: Preheater, UV-LED unit

4 M903330 Wear safety glasses and gloves
while working.

5 M906144 Indicates hot parts.
• JV/CJV only

6 M903405 Beware of the cutter.
• JV: Carriage, XY carriage
• CJV/UCJV: Carriage, cutter unit,

XY carriage
• TS: Carriage

7 M905811 Indicates dangerous moving parts.

8 M916035 Describes the power cable.
• JV/CJV only

9 M907935 Indicates dangerous live parts.

10 M917747

ATTENTION

VORSICHT

CAUTION

Beware of the cutter.
• JV/CJV/UCJV only

11 M917991 Indicates illuminating LED hot parts.

12 M905935 Avoid touching the pinch roller lever.
• CJV/UCJV only
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No. Order code Label Details

13 M913419 Beware of ultraviolet light.
• UCJV only

14 M918910 Media is heavy. At least two people
should carefully set up the media.
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1.1 Part Names and Functions

Front

1

2

3

7

11

4

6

8

5

13

9
10

12

14

5

No. Name Overview

1 Platen Print area.  "Platen"(P. 32)
The platen on the JV and CJV is fitted with a heater to prevent ink bleeding
(UCJV: option  "UCJV330 Heater Unit"(P. 319)). Adjust the temperature
setting to suit the type of media used.  "Setting the Heater
Temperature"(P. 95)

2 Pinch roller
Grit roller

The pinch rollers and grit rollers are used to grip and feed the media. 
"Pinch Rollers and Grit Rollers"(P. 33)

3 Cutter unit
*CJV/UCJV only

Holds a cutter and a pen for cutting.  "Cutting"(P. 111)  "Cutting Data
with Register Marks"(P. 127)

4 Carriage Consists of a print head, the jam sensor, and the media cutter. 
"Carriage"(P. 32)
The UCJV is equipped with a UV-LED lamp, which cures the ink
simultaneously with printing.

5 Maintenance cover Open the cover to perform maintenance on locations such as the carriage
underside. Printing and automatic maintenance are not possible while the
covers are open.

6 Operating Panel Includes operating keys and displays indicating various settings and other
items.  "Operating Panel"(P. 35)

7 Station Includes caps for protecting the print head, wipers, and an NCU for
monitoring print head nozzle conditions.  "Station"(P. 32)

8 Clamp lever Lowering the clamp lever secures the media. Raising the clamp lever
releases the media. Linked to the clamp lever at the rear.

9 Waste Ink Tank Contains the container for waste ink.  "Waste Ink Tank
Replacement"(P. 251)

10 XY slitter Cuts the media to the specified size after printing.  "Using the XY
Slitter"(P. 141)
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No. Name Overview

*JV/CJV only

* UCJV: Optional

11 Take-up unit Rolls up the printed roll media.  "Take-up unit"(P. 71)

12 Media Edge Guides
* TS only

* JV/CJV/UCJV: Option

In some cases, roll media may shift sideways and start to curl inwards.
Using the media edge guides prevents the roll media from becoming offset.

 "Using media edge guides"(P. 74)

13 Post-heater
*JV/CJV/TS only

* UCJV: Optional

Allows ink to dry after printing. Adjust the temperature setting to suit the type
of media used.  "Setting the Heater Temperature"(P. 95)

14 Front cover Open the cover for loading the media, performing maintenance on the area
around the platen, and for replacing consumable items. Printing and 
automatic maintenance are not possible while the covers are open.

1
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Rear and Right Side View

1

2

3

6

4

8

9

10

11

12

7

5

No. Name Overview

1 Clamp lever Linked to the clamp lever at the front.

2 Media Sensor Detects whether media is present.  "Media Sensor"(P. 33)

3 Blowing fan
*JV/CJV/TS only

Blows air to dry ink after printing.

4 Preheater
*JV/CJV/UCJV only

Preheats the media before printing to suppress rapid temperature change.
Adjust the temperature setting to suit the type of media used.  "Setting
the Heater Temperature"(P. 95)

5 Exhaust fan box Discharges air for holding down the media.

6 Media Changer
Feeding unit

Compatible with 2-inch and 3-inch paper cores.  "Loading the Roll
Media"(P. 80)

• Media changer (JV/CJV (UCJV: option)): Allows up to three rolls of
media to be loaded.  "Media Changer"(P. 78)

• Feeding unit (TS/UCJV): Allows one roll of media to be loaded.

7 AC inlet
*TS/UCJV: One provided

The inlet at the rear (INLET1) is for the machine and the inlet at the front
(INLET2) is for the heater. Use the power cable provided.  "Connecting
the Power Cable"(P. 39)

8 Main power switch The main power supply for the machine. To prevent ejection failures
attributable to the print head (e.g., nozzle clogging or deflection), do not turn
off the main power supply.  "Power Supply Switch"(P. 34)  "Turning
On the Power"(P. 39)  "Turning Off the Power"(P. 40)

9 Heater power supply
switch
*JV/CJV only

The power supply for the heater is at the front.  "Setting the Heater
Temperature"(P. 95)

10 LAN port Connects to PC via a LAN cable.  "Using a LAN Cable"(P. 42)

11 USB port Connects to PC via a USB interface cable.  "Using a USB Cable"(P. 43)

12 Maintenance liquid
cartridge
*JV/CJV/TS only

Used to automatically feed maintenance liquid to the cap, and to prevent ink
solidifying inside the ink discharge channel during maintenance.
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Ink Supply Unit
[JV / CJV / TS] [UCJV]

1

2

4

3

6

2

5

3

7

No. Name Overview

1 Ink Eco-case The ink eco-cases are mounted here.  P. 51

2 Ink lever JV/CJV/TS: Push down the lever to remove the ink eco-cases.  P. 48
UCJV: Slide the lever to the right to remove the ink bottles.  P. 54

3 Ink IC chip slot For inserting the ink IC chips provided with the ink.  P. 51
This manages the ink information.

4 Ink leak check tube If ink enters the tube, contact your local dealer or our service office.

5 Ink wipe pad Pad for soaking up ink droplets from the ink bottle special caps.  P. 54

6 Ink bottle Mount the ink bottles.  P. 58

7 Light-blocking cover Cover to prevent light entering the ink supply unit when the ink bottles are
removed.

1
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Carriage
The carriage includes a print head for ejecting ink, and a jam sensor for stopping the carriage when media
clogs. Printing occurs as ink is ejected while traversing left and right.

The UCJV is equipped with a UV-LED lamp, which cures the ink.

• Be sure to use the UV safety glasses provided. Disregarding this precaution may result in eye
pain or damage to eyesight.

Station
The station includes caps for keeping the print head nozzle surface from drying out, a wiper required for print
head maintenance, and an NCU for monitoring print head nozzle conditions.
The NCU (Nozzle Check Unit) automatically checks whether the nozzle is clogged. Setting various functions
enables automatic print head cleaning or printing using other nozzles.  "Registering Nozzle
Recovery"(P. 186)

Cloth wiper

NCU

Cap

Platen
Print area. The platen secures the media under vacuum pressure. This also features a cutting slot for cutting
the media.

[JV/TS] [CJV/UCJV]

Platen

Cutting slot

Platen

Cutting slot
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Pinch Rollers and Grit Rollers
The pinch rollers and grit rollers are used to grip and feed the media.

Pinch roller

Grit roller

Pinch roller

Grit roller

[JV/TS] [CJV/UCJV]

When the machine is not in use, raise the clamp lever to separate the pinch rollers from the grit
rollers.

• Leaving the pinch rollers lowered may cause them to become deformed and prevent media from
being fed correctly.

• Leaving media loaded will subject it to force from the pinch rollers, which may leave pinch roller
marks on it.

For JV
• Attach the clamp changeover sliders to the pinch rollers at the left and right-hand ends of the

media. The pinch rollers can be raised by attaching clamp changeover sliders. This prevents
gripping the left and right-hand ends of the media for consistent feeding.

Clamp changeover
slider

Media Sensor
The media sensor detects the presence/absence of media. The sensor must be covered by the media to
detect the media width.

Media Sensor

[Rear view]

• The TS330-1800 is equipped with media sensors on the left side and in the center.

1
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Power Supply Switch

l Main power switch
This is located at the rear on the right-hand side of the product.

[JV/CJV] [TS/UCJV]

Heater power supply switch

Main power switch Main power switch

• Do not turn off the main power supply. Turning off the main power supply will disable the
automatic maintenance function (including nozzle clogging prevention function and ink
discharge channel cleaning function). This increases the risk of ejection failures (such as nozzle
clogging or deflection).

l [END/POWER] key
The [END/POWER] key is the key normally used to turn the power on and off.
To turn off the power, hold down the [END/POWER] key. Press the [ENTER] key once the instructions
appear on the display.

[END/POWER] key
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Operating Panel
This is used to control the product and make/change settings.

REMOTEMENU
TEST PRINT

CLEANING

xxxx

1

2 3

4

5 6

7

No. Name Overview

1 Display  "Display"(P. 36)

2 [SEL] key Selects the function for the corresponding [FUNCTION] key.

3 [FUNCTION] key Used for test printing, head cleaning, and editing settings  "[FUNCTION]
key"(P. 38)

4 [JOG] key Used to move the carriage, feed media, and select settings

5 [END/POWER]
key

Used to cancel the last setting entered, return to the previous level of the setting
menu, or to turn power on and off

• Illuminates in blue when the power is on.  "Turning On the Power"(P. 39)
• To turn off the power, hold down the key.  "Turning Off the Power"(P. 40)

6 [ENTER] key Used to move to the next level menu and to confirm settings. This can also be
used to display product information.  "Displaying Machine Information (Local
Guidance)"(P. 38)

7 Status lamp This lamp indicates the machine status.

Off Indicates LOCAL mode. Used for test printing, maintenance,
and settings

Light
blue

Illumina
ted

Indicates REMOTE mode. The product is in standby to receive
print data.

Flashin
g

Indicates that printing is in progress. This also flashes to
indicate test printing—for example, when printing built-in
patterns.

Blue Illumina
ted

Indicates that data remains to be printed. Switch to REMOTE
mode and start printing

Green Flashin
g

Indicates that automatic maintenance is underway. Some
functions will be limited until maintenance has ended.

Yellow Flashin
g

Ink Near End status (very little ink remains).  "When Ink
Near End is Displayed"(P. 47)

Red Flashin
g

An error has occurred. Refer to the error code list and take
appropriate action.  "Error Message"(P. 282)

Illumina
ted

A system error (SYSTEM HALT) has occurred. Contact our
service office.  "SYSTEM HALT"(P. 293)

1
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Display

PRE PRINT POST

35°/40° 40°/40° OFF

REMOTE
TEST PRINT

CLEANING
MENU

LOW 1620mm

SETUP 1 Connected cable type

Detected media width

Function name assigned to
[FUNCTION] key

MENU mode <setting type number>

Heater temperature (actual
temperature/temperature setting)

Head height

Ink status

Ink heating status (UCJV only)

l Heater temperature
The heater status is indicated by different colors.

• Orange: Adjusting to temperature setting.
• Green: At temperature setting.
• Gray: Heater is turned off.

• TS330-1600: Only equipped with a post-heater. (The print heater is optional 
"Options"(P. 303).)

• TS330-1800: Only equipped with post-heaters 1 and 2.
• UCJV: Only equipped with a pre-heater. (The print heater and post-heater can be installed as

options  "Options"(P. 303).)

l Ink heating status (UCJV only)
The ink heating status and errors are indicated by different colors.

• Orange: Adjusting to temperature setting. Ink heating starts automatically before printing.
• Light blue: Temperature being maintained stable after reaching temperature setting.
• Green: Ink temperature is stable. Printing can be started immediately.
• Gray: Ink heating is turned off.
• Red: An ink heating related error has occurred.

MENU mode
Four menu modes are available.

Name Overview

LOCAL mode Used for test printing, maintenance, and settings

REMOTE mode Prints the print data received from a PC.

MENU mode Press the [MENU] on the LOCAL mode screen to switch to MENU
mode. This is used to set various functions.

NOT-READY mode Status before media is detected

Ink status
Ink pack status such as remaining ink levels and ink errors are indicated by icons.

Icon Overview

Displays remaining ink levels using a 9-stage icon.
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Icon Overview

Full 1/8 used 1/4 used 3/8 used 1/2 used 5/8 used 3/4 used 7/8 used

Very little ink remains. Prepare fresh ink.

Printing is not possible. Displayed when ink is depleted or an ink error has occurred.  "Ink
Error"(P. 281)

1
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[FUNCTION] key
This section describes the functions and roles assigned to the [FUNCTION] key.

Icon Overview

Displays the various menu screens.  "Setup"(P. 179)

Displays maintenance functions such as test printing and cleaning.

Switches from LOCAL mode to REMOTE mode.

Displays adjustment functions such as feed adjustment and drop position adjustment.

Displays the Heater Temperature Setup screen.

Clears received data.

Used to switch from REMOTE mode to LOCAL mode

Used to cut media

Used to move to the previous menu screen

Used to move to the next menu screen

Used to close the confirmation screen in response to prompts or other messages

Used to disable functions

Indicates that the function is assigned. Displays settings and functions.

Used to enable or disable multiple items

Displays the cutting condition input screen.

Displays the test cutting and other cutting related function screens.

Displays the pinch roller setting screen.

Displaying Machine Information (Local Guidance)
Press the [ENTER] key on the LOCAL mode screen to display the following information.

• Ink information: Displays ink type, remaining ink levels, and ink errors.
• Information: Displays information such as media width, head height, product serial number, firmware

version, command version, and LAN connection status.
• Nozzle check: Displays the number of nozzles detected as clogged in the nozzle check.
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1.2 Connecting the Power Cable
1 Check to confirm that the main power supply is turned off.

2 Connect the cable band to the machine.

3 Connect the power cable to the inlet of the machine.

4 Secure the power cable to the cable band.

• Pass the power cable through the clamp and clamp until it clicks into place.

Power cable

Cable band

Power cable

Cable band

[TS/UCJV][JV/CJV]

5 Plug the power plug into the power outlet.

Power plug

Power outlet

• Do not handle the power plug with wet hands. Disregarding this precaution may result in
electric shock.

Turning On the Power

1 Check to confirm that the main power supply is turned on.

• If the main power supply switch is not turned on, set to "I".

[JV/CJV] [TS/UCJV]

Heater power supply switch

Main power switch Main power switch

1
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2 Press the [END/POWER] key to turn on power.

• The firmware version appears on the display, and the initial operation is executed. The machine
will then enter the Media Select mode, and is ready for use.

[END/POWER] key

• If sudden temperature fluctuations (of ±10 °C or more) are detected while the power is
turned off, maintenance will be performed automatically when the machine is restarted. If
a warning message appears when the machine is restarted, perform a test print to check
the nozzle state.

3 Turn on the power for the connected PC.

• Close the front cover and maintenance covers. Leaving any of the covers open will disable the
automatic maintenance function (including nozzle clogging prevention function and waste ink
draining channel cleaning function). This will increase the risk of failure or ejection failures (e.g.,
nozzle clogging or deflection).

Turning Off the Power

• Check the following when turning off power:
(1) The front cover and maintenance covers are closed.

• Leaving any of the covers open will disable the automatic maintenance function (including
nozzle clogging prevention function and waste ink draining channel cleaning function).

(2) The carriage has returned to the capping station.
• If not, the print head nozzle may dry out, resulting in ejection failures (such as nozzle

clogging or deflection).
(3) Data is not being received
(4) No errors have occurred.

•  "Problems Causing Messages to Appear"(P. 279)

1 Turn off the power to the PC connected.

2 Hold down the [END/ POWER] key.

• A power off confirmation screen appears. Press the [ENTER] key to turn the power off.

[END/POWER] key
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• Do not turn off the main power supply. Turning off the main power supply will disable the
automatic maintenance function (including nozzle clogging prevention function and ink
discharge channel cleaning function). This increases the risk of ejection failures (such as nozzle
clogging or deflection).

1
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1.3 Connecting a PC to the Product
Connect the machine to the RIP PC. The following cables can be used:
1.  "Using a LAN Cable"(P. 42) (Recommended)
2.  "Using a USB Cable"(P. 43)

When using the USB cable
• Data may be transferred to the machine too slowly, causing the carriage to pause at the left-

hand or right-hand end during printing.

Using a LAN Cable
Connect a PC to this product using a LAN cable. Insert a LAN cable until it engages with a click.

• Do not unplug the cable while data is being transferred.

l Network Connection Precautions
Make sure the network is set up as follows: Printing is not possible if the network is not set up correctly.

• Use a Category 6 or 6A LAN cable.
• The PC used to transfer print data must be located on the same network as this product. This product

cannot be connected via a router.
• Use a 1000BASE-T compatible computer or switching hub. Printing requires 1000BASE-T support.

Switching hub

l Checking the LAN connection

1 Check the display on this product.

• Local guidance can be used for checking.  "Displaying Machine Information (Local
Guidance)"(P. 38) Printing is not possible if "100Mbps", "10Mbps", or "No Connect" is displayed.

INFORMATION

LAN Status 1000Mbps

2 Check the lamp on the LAN connector.

• The LAN connector lamp illuminates when the machine is running.
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Color Status Overview

Green Illuminated Connected via 1000BASE-T

Off Connected via a network other than 1000BASE-T
• 1,000 Mbps is not supported if only the orange lamp is illuminated or

flashing. Check the specifications for the PC, peripheral devices, and
cable.

Orange Illuminated Linked up (connected).

Flashing Data being received

Off Link down (not connected)

Using a USB Cable
Connect a PC to this product using a USB interface cable.

• Do not unplug the cable while data is being transferred.

• Use RIP software that supports the USB interface.

• If the PC does not have a USB port, contact your local distributor, our sales office, or service
center.

When using the USB cable
• Data may be transferred to the machine too slowly, causing the carriage to pause at the left-

hand or right-hand end during printing.

l USB Connection Precautions
• When connecting more than one 330 Series to a PC

– If the PC has more than one USB port, try connecting to a different USB port to check whether the
product is correctly recognized. If the product is still unrecognized even when connected to a
different USB port, use a commercially-available USB active repeater cable.

• When extending the USB cable
– Use a commercially-available USB active repeater cable. However, make sure that the combined

length of the USB cable and the USB active repeater cable does not exceed 20 m.
– If the USB cable is extended, this may reduce the data transfer speed to the machine, causing the

carriage to pause at the left-hand or right-hand end during printing.
• USB high-speed mode peripheral devices

– It may not be possible to recognize USB peripheral devices if USB high-speed mode peripheral
devices (e.g., USB memory, USB HDD devices) are connected to the PC to which the product is
connected. If external USB hard disk drives or other similar devices are connected, this may reduce
the data transfer speed to the machine, causing the carriage to pause at the left-hand or right-hand
end during printing.

• Unplugging USB memory devices
– When unplugging USB memory devices from the PC to which this product is connected, use "Stop"

in "Safely removing hardware" before unplugging. Otherwise, an [ERROR 201 Command Error] will
occur.

1
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1.4 System Configuration
Use RIP software to request to print data created using applications like Illustrator or Photoshop.

Preparing RIP Data

[Ethernet connection]
RIP-PC

Print request

[Local network]

Receiving Print Data
Generating RIP Data
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Installing the Mimaki Driver

1 Download the  Mimaki driver from our website.

• https://mimaki.com/download/inkjet.html
[330 Series] > [Driver/Utility]

2 Install the MIMAKI driver.

Installing RIP Software
The explanation here applies to MIMAKI RIP software (RasterLink).

• If using TxLink, refer to the TxLink operating manual.

1 Install RasterLink.

• The following icon appears on the PC desktop once the software has been installed.

• For more information, refer to the RasterLink installation guide. https://mimaki.com/download/
software.html

• Once installed, activate the license for Rasterlink. Otherwise, "Profile Update" will not start.

Obtaining Color Profiles
Print quality (e.g., tone, bleeding) will vary depending on the media and ink set. To maintain consistent print
quality, select a color profile that suits the media and ink set.

• The RasterLink Series includes a function allowing color profiles to be downloaded and installed directly
from the Internet. For more information, refer to "Installing Profiles" in the RasterLink Series installation
guide. 
https://mimaki.com/download/software.html
[RasterLink Series used] > [Manuals]

• Color profiles for Mimaki RIP software (RasterLink/TxLink) are available on the Mimaki website. 
https://mimaki.com/download/inkjet.html
[330 Series] > [Profile]

Setting Up RIP Software
The explanation here applies to MIMAKI RIP software (RasterLink).

• If using TxLink, refer to the TxLink operating manual.

1 Launch RasterLink.

• The [Printer Management] screen appears.
• To add a new model, launch RasterLink, then select [Environment] > [Printer Management].

1

https://mimaki.com/download/inkjet.html
https://mimaki.com/download/software.html
https://mimaki.com/download/software.html
https://mimaki.com/download/software.html
https://mimaki.com/download/inkjet.html
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2 Register 330 Series.

(1) Click [Add].

(2) Set the specifics for 330 Series.

• Model: Select the model.
• Color: Select the ink set filled.
• Output Port: Select the cable connected.
• Available Printers: Select 330 Series connected.
• Printer: Enter a name as required.

(3) Click [OK].
• A confirmation screen appears.

(4) Click [Yes].
• Printer registration starts.

• For more information, refer to the RasterLink installation guide. https://mimaki.com/download/
software.html

https://mimaki.com/download/software.html
https://mimaki.com/download/software.html


Chapter 1 Before Use

47

1.5 Ink Replacement Method

When Ink Near End is Displayed
Ink levels are low. We recommend replacing with new ink as soon as possible, because the ink packs are
nearly empty. Printing is still possible but continuous printing is not, and some maintenance functions such
as cleaning are disabled. Note that ink may run out during printing.
To check which color ink needs to be replaced, press the [ENTER] key on the LOCAL mode screen. 
"Displaying Machine Information (Local Guidance)"(P. 38)

When Ink End is Displayed
The ink has run out. Replace with new ink.
Thoroughly read the following and make sure you understand its contents.

 "Notes on Handling Ink or any Other Liquid Used with the Machine"(P. 15)

• Pay close attention to ventilation and be sure to wear safety glasses, gloves, and a mask when
handling ink, maintenance liquid, waste ink, or other solutions used with the machine. Leaking
ink may adhere to the skin or get into the eyes or mouth.

1
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Replacing Ink

JV/CJV/TS

CJV TSJV

• The ink pack is filled with slightly more ink than the indicated value. A small amount of ink
remains when the indicated amount of ink has been consumed and Ink End is displayed. The
ink in the ink pack cannot be used up completely.

l Removing Ink Eco-cases

1 Push down the lever on the pedestal, and remove the ink Eco-case.

2 Open the ink eco-case, then remove the ink pack.

3 Remove the ink IC chip.
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4 Wipe off any ink adhering to the ink eco-case opening.

• Check to confirm no foreign matter such as dust or paper towel matter is adhered to the
opening. If foreign matter is present, this may block the ink path and lead to leakage.

• We recommend replacing the ink absorber each time you replace the ink pack, to prevent dirt
building up on the pedestal of the ink supply unit.

• When disposing of ink, maintenance liquid or other liquid used with the product, or containers or
non-woven fabric contaminated with ink or other liquid, contact an industrial waste disposal
operator or dispose of the product in accordance with the local laws and regulations.

l Preparing the Ink

1 Pull out the ink pack and ink IC chip from the ink package.

Ink pack

Ink IC chip

1
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2 Shake the ink eco-case slowly from left to right at least 20 times.

• Shake the bottle slowly from left to right to ensure that the ink moves inside, holding the ink pack
opening with a paper towel.

Repeat

• When using an ink pack with ink remaining, hold a paper towel over the ink eco-case
opening and shake slowly with the ink eco-case tilted upright.

3 Remove the seal attached to the ink pack opening.

• Remove the seal completely. If any parts of the seal remain, ink may leak when the ink
eco-case is removed from the base.

OK No good

4 Place the ink pack inside the ink eco-case.

• Push the ink pack connector into the ink eco-case slot. Ink may not be supplied if the connector is
out of position.

• Position the pack as indicated on the label on the ink eco-case.

Seal

Ink pack

Slot

5 Close the ink eco-case gently to avoid pinching the ink pack.

• Be careful to avoid catching your hands or fingers.
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l Mounting the ink
The order of the ink eco-cases to be set varies depending on the ink set you are currently using. Check the
ink slot numbers, then insert the correct color ink eco-cases.

11
22
33
44
55
66
77
88

Ink set Ink positions

1 2 3 4 5 6 7 8

JV/CJV 4-color M M C C Y Y K K

6-color, W M Lm C Lc Y W K W

8-color M Lm C Lc Y Or K Lk

TS 4-color M M BL BL Y Y K K

6-color M Lm BL Lbl Y Y K K

M M BL BL Y FY K FP

7-color M Lm BL Lbl Y Y K Lk

8-color M Lm BL Lbl Y FY K FP

M R C BL Lk G K Y

M Or BL Vi Y FY K FP

M Lm BL Lbl Y Or K Vi

1 Set an eco-case on the base.

• Fully push in the eco-case. Otherwise, ink may not be fed properly.

1
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2 Insert the new ink IC chip into the ink IC chip slot.

• Insert the ink IC chip with the metal side facing up. Inserting it in the wrong way may
cause failure of the machine or damage the ink IC chip.

• Do not touch the metal parts of the ink IC chip. Static electricity may damage the ink IC
chip, and dirt or damage may cause the ink IC chip read error.

• Ink IC chips: The marking on the ink IC chip indicates the color information.

Marking location

Ink Color Marking

Cyan  (One blue circle)

Magenta  (One red circle)

Yellow  (One yellow circle)

Black  (One black circle)

Light cyan  (Two blue circles)

Light magenta  (Two red circles)

Light black  (Two black circles)

Orange  (One orange circle)

White  (One white circle)

Blue  (One blue circle/one red circle)

Light blue  (Two blue circles/one red circle)

Fluorescent pink  (Two orange circles)

Fluorescent yellow  (Two yellow circles)

Red  (One red circle/one yellow circle)

Green  (One green circle)

Violet  (One blue circle/two red circles)
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• Insert the ink IC chip included in the package with the ink. The ink IC chip stores information
such as the ink color, remaining amount, and expiration date. Printing is not possible if an
incorrect ink IC chip is inserted.

1
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UCJV

UCJV

l Ink caps
The type of ink cap that can be used will differ depending on the ink type. Note that only the following
combinations can be used.

Ink type Cap type

• LUS-170/175 ink
• LUS-200 ink
• LUS-190/210 ink

[Cap B]

l Replacing Ink

1 Rotate the lever on the tank section from left to right.

• Never attempt to rotate the ink bottles. Doing so may result in leaking ink.

2 Lift the ink bottles vertically.

Light-blocking
cover

• Check to confirm that the light-blocking cover is closed when removing ink bottles. Close
the light-blocking cover by hand if it is open. If the light-blocking cover is left open, the ink
may harden, resulting in printer failure.

• Be careful to prevent ink leaks from the ink bottles.
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• The O-rings fitted to the bottle caps may become detached when removing ink bottles.
Refit the O-ring if it becomes detached.

3 Soak up any ink droplets on the ink bottle caps.

• Use an ink wipe pad to absorb the ink sufficiently so that it does not drip.

Ink wipe pad

4 Wipe off any ink on the ink bottle caps with paper wipes.

• Check to confirm that there is no foreign matter, such as non-woven fabric scraps or dust,
adhering to the ink bottle caps. Continuing to use it when it is dirty may result in foreign
matter blocking the ink channels, causing ink leakage.

5 Remove the bottle caps from the ink bottles.

• If the ink bottle caps are tight, remove using a tightening tool.

6 Remove the ink IC chip.

1
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l Preparing the Ink

1 Shake the ink bottle to the left and right slowly at least 20 times.

• Tighten the ink bottle lid securely, then shake the bottle slowly from left to right to ensure that the
ink moves inside, holding the ink bottle lid with a piece of recommended non-woven fabric.

Repeat

• Shake slowly. If the bottle is shaken too violently, ink may leak out or the air mixed in the
ink may cause nozzle clogging.

• If the ink bottle is partially used, tilt it slowly until the ink bottle is upright.

2 Remove the ink bottle lid.

If the mouth of the ink bottle is fitted with a seal
• Cut the seal open using a craft knife. There is a risk of ink leakage if parts of the seal

remain.
OK No good

• Take care not to damage the mouth of the ink bottle. There is a risk of ink leakage if the
mouth is damaged.

• Be careful not to drop any of the seal fragments into the ink bottle. If the ink bottle is used
with seal fragments inside, these may clog the bottle cap, preventing ink from being
supplied.

3 Attach the bottle cap to the ink bottle.
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• Wipe off any ink or maintenance liquid remaining on the ink bottle or the bottle cap.
Otherwise there is a risk of ink leakage due to loosening of the ink bottle cap.

• Check to confirm that there is no foreign matter, such as paper towel scraps or dust,
adhering to the ink bottle caps. If foreign matter is present, this may block the ink path and
lead to leakage.

4 Use the tightening jig to tighten the ink bottle caps in place.

Tightening tool

Position the upper
arrow within this
range!

1 2

Good example Bad example

Position the upper
arrow within this
range!

Bad exampleGood example[SPA-0328]

[SPA-0232]

• Do not overtighten the ink bottle caps. Disregarding this precaution may result in damage,
idling or ink leakage. If the arrow goes beyond the range indicated above, loosen the
bottle cap, and repeat the steps again.

• Do not leave ink bottles with the ink bottle caps fitted for extended periods. Disregarding
this precaution may result in the ink hardening.

5 Turn the ink bottle upside-down to check that no ink leaks occur.

1
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l Mounting the ink
The order of ink bottles to be set depends on the ink set you are currently using. Check the ink slot numbers
and insert the correct color ink bottles.

UCJV Ink positions

Ink Type Ink set 1 2 3 4 5 6 7 8

LUS-170/175, 200 4-color M C Y K K Y C M

LUS-170/175 4-color, W, Cl M C Y K Cl Cl W W

6-color, W M C Y K Lc Lm W W

LUS-170/175+LUS-200
W

4-color, W, Cl M C Y K Cl Cl W W

6-color, W M C Y K Lc Lm W W

LUS-200 4-color, W M C Y K C M W W

LUS-190/210 4-color M M C C Y Y K K

4-color, W M M C C Y K W W

1 Insert the new ink IC chip into the ink IC chip slot.

• Insert the ink IC chip with the metal side facing up. Inserting it in the wrong way may
cause failure of the machine or damage the ink IC chip.

• Do not touch the metal parts of the ink IC chip. Static electricity may damage the ink IC
chip, and dirt or damage may cause the ink IC chip read error.
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2 Mount the ink bottles.

• Rotate the lever from the left to the right end, then mount the ink bottle.

Lever

• You may apply the maintenance liquid onto the O-ring of the ink bottle caps so that the ink
bottle can be inserted easily. Use the appropriate maintenance liquid to suit the ink being
used.

3 Rotate the lever from right to left to secure the bottle in place.

• Never attempt to rotate the ink bottles. Doing so may result in leaking ink.

• Once the ink bottle is mounted, use up the ink as quickly as possible.

• Ink IC chips: The marking on the ink IC chip indicates the color information.

Marking location

• Insert the ink IC chip included in the package with the ink. The ink IC chip stores information
such as the ink color, remaining amount, and expiration date. Printing is not possible if an
incorrect ink IC chip is inserted.

1
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2.1 Print Process
• Please check the machine specifications and installation environment.

"Specifications"(P. 296)
• If the installation environment does not satisfy the requirements, it may result in poor ink

ejection consistency or media transport stability. In particular, when performing high-density
printing on roll media at low ambient temperatures, the media may lift up (wrinkles) due to
shrinkage.  "The media jams or the media is dirty."(P. 260)

1. Turn on the power.

 "Turning On the Power"(P. 39)

[END/POWER] key

2. Connect a RIP PC to the machine.

 "Using a USB Cable"(P. 43)
 "Using a LAN Cable"(P. 42)

3. Setting Up RIP Software

 "Installing RIP Software"(P. 45) (required first time only)
 "Obtaining Color Profiles"(P. 45)
 "Setting Up RIP Software"(P. 45) (required first time only)

4. Adjusting Print Head Height

Adjust the height adjustment lever to suit the media.  "Adjusting Print Head Height"(P. 65)

Height adjustment lever

[JV/CJV/TS] [UCJV]

Height adjustment lever

Low

High

Low

High

5. Adjust the Pinch Roller Positions.
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Adjust the pinch roller positions to suit the width of the set media. Adjust the pinch roller positions so that the
pinch rollers are positioned above the grit rollers. The pinch rollers at both ends should be aligned to within
10 cm from the left edges and 2 cm from the right edges of the media.  "Adjust the Pinch Roller
Positions."(P. 67)

• The description here applies to the CJV/UCJV.

6. Loading the Media

This machine can be used with roll media and leaf media.  "Loading the Media"(P. 70)

Paper core Take-up unit

7. Adjust the number and pressure of pinch rollers to use.

Set an appropriate pressure for the set media.  "Setting the Pressure and Number of Pinch Rollers to
Use"(P. 93)

• The description here applies to the CJV/UCJV.

8. Setting the Heater Temperature

 "Setting the Heater Temperature"(P. 95)

9. Check the state of the print head nozzles.

 "Test Printing"(P. 96)

Good example Bad example

Nozzle Deflection Nozzle clogging

10. Clean the head to clear malfunctioning nozzles.

There are three different head cleaning methods. Choose the head cleaning method based on test print
results.  "Head Cleaning"(P. 98)

2
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11. Adjust the media feed amount.

 "Feed Correction"(P. 99)

Second band

First band

Good example Bad example

12. Adjust the drop position for bi-directional printing.

 "Correcting the Drop Position"(P. 101)

In this case, the drop position correction value will be "+4.0".

Media feed direction

13. Preparing RIP data

 "Preparing RIP data"(P. 103)

14. Printing RIP data

 "Printing"(P. 105)

15. Cutting the media

 "Cutting the media"(P. 108)
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2.2 Adjusting Print Head Height
Adjust the height of the print head according to the thickness of the media you are using.

Range Gap between print head and platen

JV/CJV/UCJV TS

Low (recommended) 2.0 mm (default setting) 3.0 mm (default setting)

Middle 2.5 mm 3.5 mm

High 3.0 mm 4.0 mm

• Be sure to correct the dot position after altering the print head height.  "Correcting the Drop
Position"(P. 101)

• With inkjet printers, if the gap between the print head and media increases, the ink droplets tend
to vaporize before they reach the media. Vaporized ink may adhere to the print head nozzle
surface and media, affecting print quality and causing failure of the print head. Adjust the print
head height to suit the media.

• With the UCJV, more reflected light from the UV-LED unit hits the print head, which may cure
any ink adhering to the nozzle face, increase the ink viscosity, and cause print head defects.

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Platen Right End], then press the [ENTER]
key.
• The carriage moves over the platen.

3 Open the front cover.

4 Use the height adjustment lever to adjust the height.

• Set the height adjustment lever so that the desired height is at the top. If the lever is not set to the
correct position, problems such as media jamming and misting may occur, resulting in impaired
print quality.

Height adjustment lever

[JV/CJV/TS] [UCJV]

Height adjustment lever

Low

High

Low

High

5 Once adjustment is complete, close the cover, then press the [ENTER] key.

2
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• Check the head height indicated on the display. Readjust the height using the height
adjustment lever if it is not at the set height.

PRE PRINT POST

35°/40° 40°/40° OFF

REMOTE
TEST PRINT

CLEANING
MENU

LOW 1620mm

SETUP 1

Head height
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2.3 Adjust the Pinch Roller Positions.
CJV UCJV

• The description here applies to the CJV/UCJV.

Adjust the pinch roller positions to suit the width of the media being used.

1 Choose the grit rollers capable of holding down the media at equal intervals.

Pinch roller

Grit roller

2 Move the pinch rollers above the grit rollers.

• Use the pinch roller guide marks as references.

• When adjusting from the front

Pinch roller guide mark

Pinch roller unit (viewed from above)
Adjust so that the triangular mark lies between the two pinch roller guide marks.

• When adjusting from the rear

Pinch roller unit

3 Align the pinch rollers at both the ends to within 10 cm from the left edges and 2 cm from the
right edges of the media.
• Placement farther from the edges may leave some portions of the media uncut.

4 Remove the pinch rollers lying outside the media from the grit rollers.

• Feeding media with the pinch rollers and grit rollers in contact will cause pinch roller wear.

2
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1,600 mm Size

1446 ~ 1514mm

1212 ~ 1272mm

1032 ~ 1092mm

732 ~ 792mm

576 ~ 644mm

364 ~ 424mm

241 ~ 301mm

1501 ~ 1561mm

1370 ~ 1438mm

1136 ~ 1196mm

956 ~ 1016mm

656 ~ 716mm

500 ~ 568mm

288 ~ 348mm

165 ~ 225mm

1413 ~ 1473mm

1284 ~ 1350mm

1048 ~ 1108mm

868 ~ 928mm

568 ~ 628mm

414 ~ 480mm

200 ~ 260mm

85 ~ 137mm

GR1

GR2GR4

GR3

GR11 GR10 GR5GR6GR7GR8GR9

1577 ~ 1620mm

Set the right edge of the media so that
it falls within this range.

Choose the GR based on media width.

GR: Grit roller
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1,300 mm Size

1212 ~ 1272mm

1032 ~ 1092mm

732 ~ 792mm

576 ~ 644mm

362 ~ 422mm

241 ~ 301mm

1252 ~ 1312mm

1136 ~ 1196mm

956 ~ 1016mm

656 ~ 716mm

500 ~ 568mm

286 ~ 346mm

165 ~ 225mm

1164 ~ 1224mm

1048 ~ 1108mm

868 ~ 928mm

568 ~ 628mm

414 ~ 480mm

198 ~ 258mm

85 ~ 137mm

GR1

GR2GR4

GR3

GR10 GR5GR6GR7GR8GR9

1328 ~ 1371mm

Set the right edge of the media so that
it falls within this range.

Choose the GR based on media width.

GR: Grit roller

2
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2.4 Loading the Media
• Adjust the head height before loading media. Moving the carriage after the media has been

loaded may result in the print head coming into contact with the media and being damaged.

Media

l Media handling precautions

• Use Mimaki-approved media to ensure consistent high-quality printing.

• Assign at least two people to load roll media. Otherwise there is a risk of back injury due to the
weight of the media.

• Protect media from dust when stored. Otherwise print quality may be reduced.
• When storing standard-size media rolled up, store with the coated surface facing out.
• Static electricity countermeasures (such as ionizers, anti-static bars, water mist humidification,

and alcohol-based anti-static agents) should be provided for the media. Do not use anti-static
agents that contain surfactants.

• Do not leave the media in the machine when not in use. Otherwise dust may accumulate on the
media. Do not use media that has been wiped free of dust. Wiping media can generate static
electricity, possibly affecting print quality.

• Do not use media immediately after removing it from the package. The media may expand or
contract depending on the temperature and humidity of the location in which it was stored. Allow
the media to stand for at least 30 minutes in the same indoor environment as the machine
before loading it.

• Do not use media if it is curled. Curled media may not only damage the print head, but may also
affect print quality.

• When using UV ink, do not use media that reflects light, such as media containing gold or silver
foil. Light reflected from the media surface may cure the ink on the print head, damaging the
head. Please note that this is not covered by the warranty.

• The underside of the media may be soiled depending on how the printed media has been stored
(due to weight when laying printed media rolls horizontally, for example) and the media type.
Perform a test beforehand to check that the media does not transfer ink to the underside of the
adjacent media.
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Take-up unit
Use the switch on the take-up unit to change the media take-up direction.

ON/OFF button

Direction selector switch

Name Overview

Direction selector
switch

Up To take up media with printed surface on the inside

Down To take up media with printed surface on the outside

ON/OFF button Press the button to start/stop the take-up unit. The setting can be altered so that the
take-up unit operates only while the button is depressed.  "Function Setting
Menu"(P. 189)

2
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Adjusting the torque limiter
The left and right take-up units are fitted with a torque limiter.
Turn the torque limiter adjustment nut to adjust take-up tension. When adjusting the torque limiters, be sure
to adjust to the same torque for both the left and right take-up units.

Adjustment nut

Torque scale

Mid (recommended) MaxMin

• For normal printing: Adjust the torque to "Mid".
• When using the XY slitter: Adjust the torque to "Max" if wrinkling occurs during slitting, or if

thinner media is used.
• Depending on the media, increasing the torque may cause image defects due to the pinch roller

and grit rollers failing to grip the media. Reduce the torque if the media slips.

l Increase tension (clockwise)
Increase tension when using with heavy or thick media, such as tarpaulin. Perform adjustments manually.

• Do not use the torque adjustment handle. Using the torque adjustment handle will cause
overtightening. Overtightening may damage the take-up unit.

l Decrease tension (counterclockwise).
Decrease tension when using lightweight media. Use the "torque adjustment handle" provided.
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Replacing Printed Roll Media
The take-up unit can be replaced easily by pulling it out toward you.

l Pull out the take-up unit
Release the latch and detach the hook.

Hook

• There are latches on both sides of the take-up unit. Unlatch on both sides.

l Secure the take-up unit
Slide in the take-up unit fully, then secure the hooks on the latches, and lock the lever.

Hook

• There are latches on both sides of the take-up unit. Secure the hooks on both sides to lock them
in place.

2
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Using media edge guides

CJV TS UCJVJV

• The description here applies to the JV/CJV/TS/UCJV*.
• Included as standard for the TS, and optional for the JV/CJV/UCJV.

Adjust the media edge guide positions to suit the roll media diameter.

Media diameter Distance between media edge guide and media edge

Not more than ⌀120 mm 1 mm

⌀121 mm to ⌀160 mm 3 mm

⌀161 mm to ⌀200 mm 5 mm

l Unlocking the Media Edge Guides
UnlockedLocked

• The media edge guides can be moved up and down once they have been unlocked. These can
be adjusted to the optimal positions to suit the diameter of the paper core.
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l Removing the Media Edge Guides

1 Turn the knob screw and open the media edge guide cover.

1

2

2 Rotate the media edge guides to remove them.

1

2
2
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Feeding unit

Using the Media Stopper
When pulling out a fixed length of media by hand, the roll holder locks, stopping the media from being pulled
out.

l Lock the media stopper
Push the side pin while pressing on the media stopper. Releasing the media stopper in this state locks the
roll holder.

1

2

3

Media stopper

Roll holder

• Be sure to lock the media stopper when loading roll media or printing.

l Release the media stopper
Press the media stopper to release the roll holder.
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Roll holder setting position
Loosen the knob screw on the rear left roll holder, then move it to the roll setting position.

l JV
A label showing the roll holder setting position is placed on the roll guide of the media changer. Use it as a
reference to move the roll holder, then secure using the knob screw.

2 Inch Roll Media

3 Inch Roll Media

Set Position

Roll Holder

Set Posi t ion
Rol l  Holder 3 Inch Rol l  Media

2 Inch Rol l  Media

Set the roll holder reference line within the area
indicated by the arrows.

Setting position for 3-inch paper core

Setting position for 2-inch paper core Reference

l CJV/UCJV
Use the pinch roller guide marks as references to move the roll holder, then secure using the knob screw.

Setting position for 3-inch paper core

Setting position for 2-inch paper core

Set the roll holder within the pinch roller guide marks.

l TS
A label showing the roll holder setting position is placed on the leg stay. Use it as a reference to move the
roll holder, then secure using the knob screw.

Roll Holder

Set Position

3 Inch Roll Media

2 Inch Roll Media

Rol l  Holder
Set Posi t ion

3 Inch Rol l  Media

2 Inch Rol l  Media

Set the roll holder reference line within the area
indicated by the arrows as shown below.

Setting position for 3-inch paper core

Setting position for 2-inch paper core

Reference

2
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Media Changer

CJV UCJVJV

• The description here applies to the JV/CJV/(UCJV)*. (*  "Options"(P. 303))

Three media rolls can be loaded. The media used can be switched by rotating the selection handle.

Selection handle

Unlocking pin

Lock Unlocked

Name Overview

Unlocking pin • Pulling out the unlocking pin unlocks and allows the selection handle to be
rotated. If the unlocking pin is difficult to pull out, rotate the selection handle
approximately 5 to 15 degrees counterclockwise before pulling out the unlocking
pin.

Lock Unlock

Selection handle • Rotate the Selection handle clockwise to select the media. Even if you hear a
click while rotating the handle, it does not indicate that the media to be printed is
selected. When the media is moved to the specified position, the handle
automatically locks, preventing it from being rotated.

• To select media successively, be sure to pull the unlocking pin to unlock and rotate the
selection handle. Attempting to rotate the handle without unlocking it may result in damage.

• Rotate the selection handle slowly (approximately 2 seconds per revolution). Rotating it
too quickly may cause it to spin.
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• Do not position the media stopper where it might hit the leg. Otherwise, the media stopper may
be damaged when you select media.  "Using the Media Stopper"(P. 76)

Good example Bad example [Rear view][Rear view]

Leg

Media stopper Media stopper

Leg

2



Chapter 2 Printing

80

Loading the Roll Media

1 Raise the clamp lever.

2 Move the rear left roll holder to the roll setting position.

• Unscrew the roll holder retaining screw, move the roll holder, then retighten the retaining screw.
 "Roll holder setting position"(P. 77)

3 Insert the paper core of the roll media on to the rear left roll holder.

• Push in until the paper core moves no farther.

[JV / CJV] [TS / UCJV]

4 Insert the rear right roll holder into the paper core.

• Unscrew the roll holder retaining screw, move the roll holder, then retighten the retaining screw.

[JV / CJV] [TS / UCJV]

5 Insert the media between the pinch rollers and the grit rollers.

• Inserting the media at an angle allows smooth insertion without catching or sticking.
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6 Lower the clamp lever.

• Hold the media with the pinch roller and grit rollers.

7 Lock the media stopper.

•  "Using the Media Stopper"(P. 76)

8 Move to the front of the machine and open the front cover.

9 Raise the clamp lever and pull out the media.

• Make sure the media does not fall to the rear.

• Adjust the rear roll holder position so that the media does not cover the right-hand slit line
on the platen. Movement at an angle may result in damage to the print head.

Slit line

Media

Media holder

• The areas extending 5 mm from both sides of the media are margins.

10 (CJV/UCJV only) Lower the clamp lever and confirm that the pinch rollers are uniformly
spaced.
•  "Adjust the Pinch Roller Positions."(P. 67)

• If the spacing is not uniform, repeat all steps from the start.

11 (CJV/UCJV only) Raise the clamp lever.

2
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12 Gently pull out the media and stop at the position where it is gently locked in place.

13 Check how far the media was pulled out.

• Pull the front edge of the media gently at several points to confirm that the media was pulled out
by the same amount.

14 Load an empty paper core on the take-up unit.

Paper core Take-up unit

• Use the take-up unit for media with low stiffness (such as tarpaulin). If not, the media may
rise up on the platen and damage a print head.

• If film or other media adheres to the platen, preventing it from being transported correctly,
perform the procedure described in  "The media adheres to the platen, preventing it
from being transported correctly."(P. 266).

15 Lower the clamp lever.

• Do not pull the media when the clamp lever is lowered (the media is clamped). Doing so
may damage the machine.
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16 Secure the media in the media holder.

Media holder

• Do not use the media holder when printing on thicker media.
• Do not use the media holder when cutting media.

17 Close the front cover.

18 Select the media to be used.

Media selection
● PVC
○ Tarpaulin
○ Unregistered
○ Unregistered

1/2
1300 mm
1600 mm

○ Unregistered

• To use unregistered media, select [Unregistered] to register the media.  "Registering
the Media"(P. 89)

19 The media width is detected.

• No change: Only the right side of the media is detected.
• Media width re-detection: The media width is detected.

PVC
Media Width 1300 mm

No change
Media width re-detection

• Media width may not be detected correctly for certain colors or types of media. When
media width cannot be detected correctly, set the media width detection method to
"MANUAL".

• If the media width detection method is set to "MANUAL", set the media width manually
([MENU] > [Media Setting] > [Media Information] > [Media Width] > [Detection Type]

 P. 182).
• A notification reading "Media Set Position R" will appear after media width detection if the

media is too far to the right of the specified position. Reload media in the specified
position.

• If Media Remain Manage is set to "ON", the Input Media Length screen will be displayed.
([MENU] > [Media Setting] > [Media Information] > [Media Remain] > [Media Remain
Manage]  P. 182).

20 (CJV/UCJV only) Enter the number of pinch rollers being used.

• If the setting for [Function Setting] > [Use PR Number Query] is "OFF", the screen for entering the
number of pinch rollers will not be displayed.

21 Press  to feed the media until it reaches the paper core on the take-up unit, then press the
[ENTER] key.

2
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• Do not put media through the XY slitter.

22 Secure the middle of the media to the paper core with adhesive tape.

• If the media edge is straight, secure the left and right sides of the media. Pull the lower
edge of the media evenly on both the left and right sides, check to confirm that it is free of
sagging and creasing, then affix the tape.

23 Press  to wrap the media about one and a half turns around the paper core, then press the
[ENTER] key.

• Move the take-up unit to the left or right when it is not in use. Print quality may be affected
if the front edge of the media hits the take-up unit.



Chapter 2 Printing

85

Setting Leaf Media

CJV UCJV

• The description here applies to the CJV/UCJV.

• Move the take-up unit out of the way to the left and right when it is not in use. Print quality may
be affected if the front edge of the media hits the take-up unit.

1 On the LOCAL mode screen, select [MENU] > [Media Setting], then press the [ENTER] key.

• The Media Setting menu is displayed.

2 Select [Media Information] > [Media Operation Form] > [Leaf], then press the [ENTER] key.

• The media bottom end will not be detected if Leaf is not selected.

3 On the LOCAL mode screen, select [MENU] > [Media Setting], then press the [ENTER] key.

4 Raise the clamp lever.

5 Open the front cover.

6 Insert the media.

• Insert into the gap between the pinch rollers and the grit rollers.

• Inserting the media at an angle allows smooth insertion without catching or sticking.

2
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7 Adjust the position of the right media edge.

• Set the media straight so that the media does not lie beyond the slit line on the platen.

First three grit rollers from the right end on the front of the machine

• The areas extending 5 mm from both sides of the media are margins.

8 Adjust the position of the front media edge.

• Set the media so that about 40 mm of it lies on the after cover. If not, the media width may not be
detected.

Media

9 Lower the clamp lever to confirm that the spacing from the pinch roller is uniform.

• Hold the media with the pinch roller and grit rollers.
•  "Adjust the Pinch Roller Positions."(P. 67)

• If the spacing is not uniform, repeat all steps from the start.
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10 Secure the media in the media holder.

Media holder

• Do not use the media holder when printing on thicker media.
• Do not use the media holder when cutting media.

11 Select the media to be used.

Media selection
● PVC
○ Tarpaulin
○ Unregistered
○ Unregistered

1/2
1300 mm
1600 mm

○ Unregistered

• To use unregistered media, select [Unregistered] to register the media.  "Registering
the Media"(P. 89)

12 The media width is detected.

• No change: Only the right side of the media is detected.
• Media width re-detection: The media width is detected.

PVC
Media Width 1300 mm

No change
Media width re-detection

• Media width may not be detected correctly for certain colors or types of media. When
media width cannot be detected correctly, set the media width detection method to
"MANUAL".

• If the media width detection method is set to "MANUAL", set the media width manually
([MENU] > [Media Setting] > [Media Information] > [Media Width] > [Detection Type]

 P. 182).
• A notification reading "Media Set Position R" will appear after media width detection if the

media is too far to the right of the specified position. Reload media in the specified
position.

13 Detect the media bottom.

• Select [Execute].

Media detect
Start detecting the media trailing edge.

Execute
Not execute

2
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14 Enter the number of pinch rollers being used.

• If the setting for [Function Setting] > [Use PR Number Query] is "OFF", the screen for entering the
number of pinch rollers will not be displayed.
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Registering the Media
When the clamp lever is lowered with media being loaded, the Select Use Media screen is displayed.
Registration is required to use media that is not registered on the machine.

• To set print conditions for a single use, select "Temporary". The conditions set in "Temporary"
are cleared when the machine is restarted.

1 Select [Unregistered].

Media selection
● PVC
○ Tarpaulin
○ Unregistered
○ Unregistered

1/2
1300 mm
1600 mm

○ Unregistered

2 Select the media type.

Media Type
● PVC
○ Tarpaulin
○ Transfer paper
○ Illuminated Film
○ Cutting Sheet

3 Select the media width detection type.

• AUTO: The media width is automatically detected.
• MANUAL: The media width is manually set.

Media Detection Type
Please Select.

AUTO
MANUAL

• Media width may not be detected correctly for certain colors or types of media. When
media width cannot be detected correctly, set the media width detection method to
"MANUAL".

4 (CJV/CJV only) Select the media form.

• Select whether roll media or leaf media is used.

Media Operation Form
Please Select.

Roll
Leaf

• When [Roll] is selected, the Media Remain Manage screen is displayed.

2
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5 Select the method for managing the media remaining amount.

• Select whether or not to manage the media remaining amount with the machine.

Media Remain Manage
Please Select.

ON
OFF

6 Enter the name to be displayed.

• If you do not register the name, press the [ENTER] key.

Media Name Change
Media 3
will be changed
(maximum 10 characters)

7 Select whether or not to register the set information.

do you optimize setting?
Execute

Do not
execute

•  "Media optimization settings"(P. 91)
• You can change the settings later.  "Media Setting Menu"(P. 180)



Chapter 2 Printing

91

Media optimization settings
Optimizing the settings sets the various items as follows, depending on media type:

CJV UCJVJV

Settings Default Tarpauli
n

PVC Syntheti
c paper

Film Cutting
sheet

Flexible
packagi
ng film
(UCJV
only)

MAPS Auto Auto Auto Auto Auto Auto Auto

Heater
temperature
(UCJV: 
Optional for
PRINT and
POST)

PRE Off 50 50 50 50 50 50

PRINT Off 45 45 45 45 45 45

POST Off 60 60 60 60 60 60

Vacuum Fan Strong Low Standar
d

Standar
d

Standar
d

Standar
d

Low

Vacuum fan constant operation On Off On On On On Off

Feed speed (%) Host 100 100 100 100 100 100

Clamp pressure (JV only) Strong Strong Strong Strong Strong Standar
d

-

TS

Settings Default Decalcoman
ia paper

(thin)

Decalcoman
ia paper

(mid)

Decalcoman
ia paper
(thick)

MAPS Auto Auto Auto Auto

Heater temperature
(Optional for PRINT)

PRINT*1 Off Off Off Off

POST Off Off Off Off

POST 1*2 Off Off Off Off

POST 2*2 Off Off Off Off

Vacuum Fan Strong Strong Strong Strong

Vacuum fan constant operation On On On On

Feed speed (%) Host 100 100 100

Clamp pressure Strong Standard Strong Strong

Pre Feed Host Off Off Off

*1. TS330-1600 only
*2. TS330-1800 only

2
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l Restricted operations

CJV UCJVJV
The following operation is not available when tarpaulin or flexible packaging film is selected:

• V-shaped cutting

l Operation changes

CJVJV
The following operation will change when tarpaulin is selected, to prevent media sagging caused by the
media adhering:

• For the initial feed only at the start of printing, the media will be fed at a slower speed than normal.

UCJV
1. The following operation will change when tarpaulin or flexible packaging film is selected, to prevent the

media adhering:
– The vacuum fan will be stopped during feeding when printing patterns such as test prints or when

using operations such as JOG (origin setting) and view feed. 
Note that the vacuum fan will not stop when printing RIP data.

2. The following operation will change when flexible packaging film is selected, to prevent the media
jamming:

– When printing dot position correction patterns with a resolution of [600Hi] or [1200Hi], some
patterns will be printed without backward feeding. 
The print output will therefore be approximately 10 mm longer in the feed direction. Note that the
adjustment method will not be affected.
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2.5 Setting the Pressure and Number of
Pinch Rollers to Use

CJV UCJV

• The description here applies to the CJV/UCJV.

Set the pressure and number used to hold media based on the tool and media being used. Incorrect pinch
roller pressure settings may result in media skew or leave pinch roller marks on the media.

1 On the LOCAL mode screen, select [PR].

width:1340mm

PRTOOL TEST CUT

LOCAL

2 Make settings based on the tool and media used.

• The following items can be configured:
• The settings are retained even when the power is turned off.

Item Setting Overview

Number for Use 160: 2–7
130: 2–6

Sets the number of pinch rollers to use.

Print LOW/MID/HIGH Sets the pressure used for printing.
• Recommended value (normal): MID

Cut:Ends LOW/MID/HIGH Sets the pressure for both the pinch rollers on the edges
(left and right) used for cutting.

• Recommended value (normal): HIGH

Cut:Inner OFF/LOW/MID/HIGH Sets the pressure for the pinch rollers used for printing
other than those on the edges.

• Recommended value (normal): HIGH
– To reduce pinch roller marks, change to MID or LOW.

Note that this may reduce cutting accuracy.

Pullback setting:
Ends
* UCJV only

LOW/MID/HIGH Sets the pressure for both the pinch rollers on the edges
(left and right) used for multi-layer printing. All of the other
pinch rollers are raised to avoid leaving roller marks on the
printed surface.
Allows only "White ink → Color + Gloss" printing to be
used.
For more information, refer to the "RasterLink Reference
Guide" or "Clear Ink Print Guide".

Change Execution - Used to check settings. Switch to configured settings
before printing the built-in pattern (e.g., test printing, test
cutting).

2
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When the machine is not in use, raise the clamp lever to separate the pinch rollers from the grit
rollers.

• Leaving the pinch rollers lowered may cause them to become deformed and prevent media from
being fed correctly.

• Leaving media loaded will subject it to force from the pinch rollers, which may leave pinch roller
marks on it.
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2.6 Setting the Heater Temperature
Set the heater temperature to suit the type of media used. The temperature can be altered while printing is in
progress, but this may cause color variations to occur.

• Adjust the heater temperature to suit the media type and characteristics. Depending on the type,
the media may expand or shrink or become rippled.

• The temperature setting in the RIP software takes precedence. If you are using the Mimaki RIP
software (RasterLink), the recommended values are stored in the color profile.

Name Overview

PRE (Preheater) Preheats the media before printing to suppress rapid temperature
change.

PRINT (Print heater) Helps prevent ink bleeding.

POST (Post-heater) Allows ink to dry after printing.
• The temperature at the lower part of POST is lower than the upper

part.

POST1, POST2 (post-heater 1,
post-heater 2)

Allows ink to dry after printing.
• The temperature at the lower part of POST is lower than the upper

part.
• The POST1 and POST2 heater temperatures can be set separately.

• TS330-1600: Only equipped with a post-heater. (The print heater is optional 
"Options"(P. 303).)

• TS330-1800: Only equipped with post-heaters 1 and 2.
• UCJV: Only equipped with a pre-heater. (The print heater and post-heater can be installed as

options  "Options"(P. 303).)

1 On the LOCAL mode screen, select [HEATER].

• The Heater Temperature Setup screen appears.

2 Enter the heater temperatures, then press the [ENTER] key.

• Printing is possible once the heater temperatures reach the temperature settings ±3 °C.

2
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2.7 Test Printing
Print a test pattern to confirm that the ink prints correctly. Perform head cleaning if you observe any ejection
failures (e.g., nozzle clogging or deflection).  "Head Cleaning"(P. 98)

Head 1Head 1

Head 2Head 2

Check beforehand

• Was the print head adjusted?  "Adjusting Print Head Height"(P. 65)
• Is media loaded?  "Loading the Media"(P. 70)

• Load media at least 500 mm wide. You cannot print the entire pattern if media less than 500
mm wide is used.

• Select [Maintenance] > [Nozzle Recovery] > [Test Print], then select "ON" to perform nozzle
recovery and test printing. 
Registration is required to perform nozzle recovery.  "Registering Nozzle Recovery"(P. 186)

• The ink used in the UCJV is warmed before printing. Printing is disabled while the ink is
warmed.

Changing the Layout Direction for Test Printing
You can change the layout direction for test printing.

1234

2

3

4

: Feed direction
(Feeds the medium and prints repeatedly in the longitudinal direction.)

: Scan direction
(Prints repeatedly in the horizontal direction.)

1 On the LOCAL mode screen, select [TEST PRINT/CLEANING] > [Test Print], then press the
[ENTER] key.
• The Test Print menu is displayed.

2 Select [Scan Dir.] or [Feed Dir.], then press the [ENTER] key.

• Test printing starts.

Good example Bad example

Nozzle Deflection Nozzle clogging

3 Check the print results.
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Checking White Ink Ejection
The following two methods are available for checking white ink:

• Print on clear film.
• Print the background for the test pattern using black ink.

l Method for printing the background using black ink

1 On the LOCAL mode screen, select [TEST PRINT/CLEANING] > [Test Print], then press the
[ENTER] key.
• The Test Print menu is displayed.

2 Select [SpotColor Check], then press the [ENTER] key.

• Test printing starts.
• The layout direction is fixed at [Scan direction].

Good example Bad example

Deflection Nozzle clogging

3 Check the print results.

Ejection Failures
Typical examples of ejection failures (e.g., nozzle clogging, deflection) are as shown below. In order to
prevent printing in such a state, check whether the ink has been properly ejected regularly before printing.

1
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30

41

50
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90
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Nozzle Deflection Nozzle clogging Ink drips

Mixed airMist

2
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2.8 Head Cleaning
The following head cleaning methods are available. Choose the method based on test results. Cleaning is
not possible when the [Ink Near End] or [Ink End] errors are displayed. Replace with new ink.  "Replacing
Ink"(P. 48)

Item Details

Soft If the print shows a bent line (Nozzle deflection)

Normal If the print shows a missing line (nozzle clogging)

Hard If soft cleaning and normal cleaning fail to resolve ejection failures (e.g., nozzle clogging
or deflection).

Wash Wiping
*JV/CJV/TS only

If hard cleaning fails to resolve ejection failures (e.g., nozzle clogging or deflection) or
color mixing

• Wash Wiping cannot be performed if an error ([Wash Liquid End] or
[WashLiquidCart.None]) is displayed. Load a maintenance liquid cartridge
containing liquid.

High Power
* UCJV only

When chronic color mixing cannot be remedied.
• Selecting the applicable head increases the power for each cleaning mode. This

should remedy color mixing issues.

UCJV:
• The ink used in the UCJV is warmed before printing. Printing and cleaning is disabled while the

ink is being warmed.

UCJV
• If there is considerable nozzle clogging with white ink (dropouts), perform Air PG.  "There is

considerable nozzle clogging with white ink"(P. 264)

1 On the LOCAL mode screen, select [TEST PRINT/CLEANING] > [Cleaning], then press the
[ENTER] key.
• The Cleaning menu is displayed.

2 Select the cleaning type, then press the [ENTER] key.

3 Select the Head to clean, then press the [ENTER] key.

• Check the check box. Heads with checked check boxes will be cleaned.

4 Run another test print and check the print results.

• Repeat the cleaning and test printing process until the print results appear normal.

• Do the following if head cleaning fails to resolve the ejection failures (e.g., nozzle clogging
or deflection).

 "Cap Rubber Cleaning"(P. 206)
 "Print Head Nozzle Washing"(P. 263)

• Perform the following steps if an abnormal noise is heard during cleaning:
 "Abnormal noise occurs during cleaning"(P. 272)
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2.9 Feed Correction
Changing the media may affect the feed amount due to various factors, including the weight and thickness of
the media and whether the take-up unit is used. Correct the drop position to suit the type of media used.
Image defects (e.g., dark or light streaks) will result if the feed is not properly corrected.

Check beforehand

• Is media loaded?  "Loading the Media"(P. 70)
• Does the heater temperature suit the media to be used?  "Setting the Heater

Temperature"(P. 95)
• For roll media, is the rear roll media free of sagging?
• When using the take-up unit, is the media mounted on the paper core of the take-up unit?  "Loading

the Roll Media"(P. 80)

UCJV:
• The ink used in the UCJV is warmed before printing. Printing and cleaning is disabled while the

ink is being warmed.

l Pullback printing

UCJV
• The description here applies to the UCJV.

[Feed Comp.(pull-back)] adjustment must be performed before using pullback printing. The correction value
will be applied when pullback printing is performed.

• For more information, refer to the "UCJV300/UCJV330 Clear Ink Print Guide". https://
mimaki.com/download/software.html

The adjustment method is the same as for [Feed Comp.].  "Feed Correction Procedure"(P. 99)

l Performing [[Feed Comp.(pull-back)]] causes the following actions:
(1) Media forward/backward feeding starts.

• The media will become slack.
(2) A correction pattern is printed.

Feed Correction Procedure
Print a correction pattern, then enter the correction value. The value corrected here will also be updated on
the Media Setting menu.

• When using the take-up unit, load media on the take-up unit before correcting.

1 On the LOCAL mode screen, select [ADJUST].

width:1340mm

DATA CLEARADJUST

LOCAL

2

https://mimaki.com/download/software.html
https://mimaki.com/download/software.html
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2 Select [Feed Comp.], then press the [ENTER] key.

• Correction pattern printing starts.

3 Check the print results.

• A correction value input screen appears.
• Adjust the bands so that the region between them is evenly colored.

Second band

First band

Good example Bad example

4 Enter the correction value, then press the [ENTER] key.

• "+" input: Increases the separation between bands.
• "-" input: Reduces the separation between bands.
• Increment the correction value by "30" to move the bands by approximately 0.1 mm.

5 Press the [ENTER] key.

• Print another correction pattern to check.

• Once adjustment is complete, the medium will be fed to the print origin. Sagging may
occur in the rear roll medium. Rewind roll media by hand to eliminate any sagging.

Correcting the Media Feed During Printing
You can also correct the media feed amount in REMOTE mode or during printing.

1 Press [ADJUST] in REMOTE mode or during printing.

2 Enter the correction value, then press the [ENTER] key.

• Correction value: -9999 to 9999
• The value entered here will be updated immediately.
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2.10 Correcting the Drop Position
Changing the media and print head height and temperature changes around the print head will also alter the
drop positions. Correct the drop position to suit the type of media used. Image defects (e.g., overlaid lines or
blurred images) will result if the drop position is not properly corrected.

Check beforehand

• Was the print head adjusted?  "Adjusting Print Head Height"(P. 65)
• Is media loaded?  "Loading the Media"(P. 70)
• Does the heater temperature suit the media to be used?  "Setting the Heater

Temperature"(P. 95)

• Load media at least 500 mm wide. You cannot print the entire pattern if media less than 500
mm wide is used.

UCJV:
• The following screen display indicates that the print head is being warmed. Printing starts once

the proper temperature is reached.

Waiting Temp stabilize
0:01:20

• Printing can be started without waiting for the print head to reach the proper temperature by
pressing the [ENTER] key while the screen is displayed, but dot printing may be offset.

Drop Position Correction Procedure
Print a correction pattern, then enter the correction value. The value corrected here will also be updated on
the Media Setting menu. This must be adjusted for each print resolution.

1 On the LOCAL mode screen, select [ADJUST].

width:1340mm

DATA CLEARADJUST

LOCAL

2 Select [Drop.PosCorrect], then press the [ENTER] key.

3 Select the resolution, then press the [ENTER] key.

• Select the resolution to be adjusted. When "All" is selected, correction patterns for all resolutions
will be printed.  "Media Setting Menu"(P. 180)

• The indicated resolutions are those in the scan direction.

2
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4 Check the print results.

• A correction value input screen appears.
• Enter the position where the two upper and lower lines coincide.

In this case, the drop position correction value will be "+4.0".

Media feed direction

5 Enter the correction value, then press the [ENTER] key.

• Correction value: -40 to 40

• If the lines do not coincide when the correction value is within the range -40 to 40, the
print head height may have been improperly adjusted. Adjust the print head height.

 "Adjusting Print Head Height"(P. 65)

6 Enter the correction value in the same way for pattern 2 and subsequent patterns.
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2.11 Preparing RIP data
The explanation here applies to MIMAKI RIP software (RasterLink).

• If using TxLink, refer to the TxLink operating manual.

• Prepare suitable image data for printing.

1 Launch RasterLink.

• Click the icon on the PC desktop.

2 Select the image data to print.

(1) Select [File] > [Open].
(2) Select the desired image data, then click [Open].

• If multiple printers are registered, select 330 Series in "Printer Name".

2
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3 Select the image data imported.

• The image data is added in the tab for 330 Series selected in "Printer Name".

4 Edit the image.

• Specify the following settings by clicking the function icons shown on the right-hand side of the
screen: 

 (General Print): Specifies settings like enlargement/reduction and rotation. 
 (Quality): Selects a color profile for the media and ink set loaded in this machine.

• For more information, refer to the RasterLink reference guide. https://mimaki.com/
download/software.html

5 Print image data.

•  "Starting Printing"(P. 106)

(1) Click  (Execution) from the function icons on the right-hand side of the screen.
(2) Select "Immediate Print" or "RIP and Print", then click [Start].

• Media width must be reacquired after replacing media.
(1) Select the tab for 330 Series in the main window.

(2) Click  (Update the printer status) in the Printer tab.

https://mimaki.com/download/software.html
https://mimaki.com/download/software.html
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2.12 Printing
Check beforehand

• Was the print head adjusted?  "Adjusting Print Head Height"(P. 65)
• (CJV/UCJV only) Were the pinch roller positions adjusted?  "Adjust the Pinch Roller

Positions."(P. 67)
• Is media loaded?  "Loading the Media"(P. 70)
• (CJV/UCJV only) Was the pinch roller pressure adjusted?  "Setting the Pressure and Number of

Pinch Rollers to Use"(P. 93)
• For roll media, is the rear roll media free of sagging?
• When using the take-up unit, was the media mounted on the paper core of the take-up unit? 

"Loading the Roll Media"(P. 80)

• Condensation may form on the print head nozzle surface depending on the ambient
temperature and humidity. The formation of condensation may cause ejection failures (e.g.,
nozzle clogging or deflection). Perform head cleaning if any ejection failures (e.g., nozzle
clogging or deflection) occur during printing.  "Head Cleaning"(P. 98) 
Set the print heater to a temperature not exceeding 35C, and ensure that the ambient
temperature is within the permissible operating temperature range (20 to 30C).  "Installation
Precautions"(P. 19)

Changing the origin
The print start position can be altered. Use the LED pointer to set the origin.

• Print origin default value
– Feed (longitudinal, X') direction: Approx. 75 mm to rear from platen cutting slot
– Scan (lateral, Y') direction: 15 mm from right edge of media

Cutting
slot Approx. 75 mm (X')

15 mm (Y')

1 On the LOCAL mode screen, press .

• The Origin Setup screen appears.

2 Press  to move the origin to the desired position.

• The carriage moves left and right and feeds the medium.

3 Press the [ENTER] key.

• The origin is updated.

2
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Starting Printing

• Before starting printing, check to confirm that the remaining amount of cloth wiper is sufficient.
Auto maintenance may be performed during printing depending on the ambient temperature in
which the machine is located and the [Print Maint.] (  P. 185) setting. If the cloth wiper is
insufficient, printing will pause without performing auto maintenance. If there is insufficient cloth
wiper remaining, replace with a new cloth wiper.  "Cloth Wiper Replacement"(P. 228)

1 Send the RIP data from the PC.

•  "Preparing RIP data"(P. 103)

• If the message "Attention20A Driver version" appears, install the latest Mimaki driver.
https://mimaki.com/download/inkjet.html

2 Start printing.

• Printing starts once RIP data is received.

REMORT

NRS 0.0m

600x600    16p / Bi / Hi / Vd

[Resolution]

[Number of passes]

[Scan direction] (Uni: unidirectional, Bi: bidirectional)

[Scan speed] (Std: standard, Hi: high speed)

[Dot type]
VD: Variable dot
ND: Normal dot

Length of medium printed

[Nozzle Recovery]

: A part of nozzles can be recovered
: All nozzles can be recovered

: Not registered or the print mode
where nozzles cannot be recovered

NRS
NRS
OFF

• Print speeds may differ for the same image data, depending on the width of the medium
loaded, print origin position, and resolution.

• If an error occurs, the machine switches to LOCAL mode once printing is completed.
Further printing is not possible.

• The ink used in this machine is warmed before printing. Printing is disabled while the ink is
warmed.

Pausing Printing

1 Press [LOCAL] while printing is in progress.

• Printing is paused.
• If data is being sent from a PC, data transmission is paused at the PC.

2 Press [REMOTE].

• Printing resumes.

• No other functions can be used when printing is paused.

https://mimaki.com/download/inkjet.html
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Stopping Printing (Data Clear)

1 On the LOCAL mode screen, select [DATA CLEAR].

width:1340mm

DATA CLEARADJUST

LOCAL

2 Press the [ENTER] key to clear the received data.

• The receive buffer is cleared.

2
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2.13 Cutting the media
1 On the LOCAL mode screen, press .

• The Origin Setup screen appears.

2 Press  to feed the media to the position required for cutting.

3 Select [CUT].

4 Select a cutting method.

• [Horizontal Cut]: The media edge is cut straight.
• [Horizontal + V Cut]: The media is cut straight and then cut into a V shape.  "V-shaped

Cutting"(P. 109)

5 Press the [ENTER] key.

• The media is cut.

• Pressing the [FUNC2] key while the [Horizontal + V Cut] run screen is displayed creates a tape
while simultaneously cutting the media. This can be used to tape the media to the paper core
(only for self-adhesive media).

When the machine is not in use, raise the clamp lever to separate the pinch rollers from the grit
rollers.

• Leaving the pinch rollers lowered may cause them to become deformed and prevent media from
being fed correctly.

• Leaving media loaded will subject it to force from the pinch rollers, which may leave pinch roller
marks on it.

• With thinner media or curled media, the media may catch in the groove on the platen after
cutting. Be careful to avoid bending or dirtying the media when handling it.
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V-shaped Cutting
The media edge is cut into a V shape. As only one point of the media is fixed to the paper core with adhesive
tape, the media can be wrapped around the paper core with uniform tension.  "Loading the Roll
Media"(P. 80)

l Conditions where V-shaped cutting is not available
• The media width detection method is set to "MANUAL". 

([MENU] > [Media Setting] > [Media Information] > [Media Width] > [Detection Type]  P. 182)

Do not use V-shaped cutting in the following cases!
• The remaining roll media amount is low. Otherwise there is a risk of media jamming or the print

head nozzle face coming into contact with the media, making prints dirty.
• When using low stiffness media such as tarpaulin. A media jam may occur.
• The clamp at the right media edge is raised. Some portions of the media may be left uncut.

When using hard, thick media (such as PET or illuminated film)
• The cutter blade will become worn more quickly compared to with other media.
• Some portions of the media may be left uncut. 2
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Chapter 3 Cutting

This chapter

CJV UCJV Describes cutting procedures and setting methods (CJV/UCJV).

Cutting Process .............................................112
Installing Cutting Tools ..................................114

Using the Cutter ....................................... 114
Using a Pen.............................................. 118

Setting the Cutting Conditions.......................122

Test Cutting ....................................................123
Cutting the Cutting Data .................................124

Changing the origin....................................124
Starting Cutting ..........................................124
Stopping Cutting (Data Clear) ....................125
Retracting the Cutter Unit ..........................125
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3.1 Cutting Process

1. Turn on the power.

 "Turning On the Power"(P. 39)

2. Connect this machine to the PC on which the cutting software is installed.

 "Using a USB Cable"(P. 43)
 "Using a LAN Cable"(P. 42)

3. Adjust the Pinch Roller Positions.

Adjust the pinch roller positions to suit the width of the set media. Adjust the pinch roller positions so that the
pinch rollers are positioned above the grit rollers. The pinch rollers at both ends should be aligned to within
10 cm from the left edges and 2 cm from the right edges of the media.  "Adjust the Pinch Roller
Positions."(P. 67)

4. Loading the Media

This machine can be used with roll media and leaf media.  "Loading the Media"(P. 70)

5. Adjust the number and pressure of pinch rollers to use.

Set an appropriate pressure for the set media.  "Setting the Pressure and Number of Pinch Rollers to
Use"(P. 93)

6. Installing Cutting Tools

This machine can be used with a cutter and a pen (ballpoint pen).  "Installing Cutting Tools"(P. 114)

7. Set the cutting speed and pressure.

Set the cutting speed and pressure to match the type of media and tools in use.  "Setting the Cutting
Conditions"(P. 122)

8. Perform test cutting.

Perform a test cut to confirm that the tool conditions are set appropriately.  "Test Cutting"(P. 123)
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9. Cutting the Cutting Data

 "Cutting the Cutting Data"(P. 124)

10. Cutting the media

 "Cutting the media"(P. 108)

3
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3.2 Installing Cutting Tools
This machine can be used with the following tools:

• Cutter (for cutting media)
Used to cut the printed image on media or to cut characters with the cutting sheet.  "Using the
Cutter"(P. 114)

• Pen (ballpoint pen)
Used to adjust register marks This machine can be used with a ballpoint pen or cartridge refill.  "Using
a Pen"(P. 118)

Using the Cutter

Installing the Cutter in the Cutter Holder
Be careful to keep the cutter from falling into a gap in this machine. We recommend replacing the cutter on
the media so you can easily pick up the cutter blade if it falls.

• Avoid touching the cutter blade. Failure to do so may result in injury.
• Do not shake or swing the cutter holder. Doing so may cause the blade to come off.

1 Remove the cap from the cutter holder.

• Turn in the direction indicated by the arrow in the picture.

Cutter holder

Cap

2 Insert the cutter into the cutter holder.

• Use tweezers to insert the cutter.

Cutter

3 Fix the cap by turning in the direction indicated by the arrow in the picture.
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Adjusting the Cutting Blade Protrusion Length
Adjust the cutting blade protrusion length (0.2 to 0.5 mm).

• If the base paper is thicker than the label film: (label film thickness + base paper thickness)/2

Label film

Base paper

Cutting blade
protrusion Cutting depth

• If the base paper is thinner than the label film: As far as to cut into label film

Cutting blade
protrusion

Label film

Base paper

Cutting depth

• An option is available to accurately adjust the protrusion amount of the blade tip. 
Part number: OPT-C0066 "blade adjuster (for eccentric cutter)"

1 Turn the adjusting knob to adjust the protrusion of the cutting blade.

• Turn the adjusting knob in the direction indicated by the arrow in the picture to have the blade
protrude. (0.5 mm per turn)

Adjusting knob

Cutter

2 Check the cutting performance.

• Adjust the pressure so that it leaves slight marks on the base paper. A cutting blade that protrudes
too far may damage the machine.  "Setting the Cutting Conditions"(P. 122)  "Test
Cutting"(P. 123)

• When using the cutter holder included in the delivery, you can adjust the protrusion length while
the cutter is attached to the tool holder. (0.5 mm per turn of the adjusting knob)

3
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Installing the Cutter Holder

1 On the LOCAL mode screen, select [MENU] > [Cutting], then press the [ENTER] key.

• The Cutting menu is displayed.

2 Select [Tool Change], then press the [ENTER] key.

3 Open the maintenance cover on the left side.

• The cutter unit can be moved manually. Move the carriage slowly to a position allowing
easy access while working.

4 Turn the knob screw and loosen the holder presser.

Holder presser

Knob screws

5 Insert the cutter holder into the tool holder.

• Push the brim of the cutter holder against the holder presser.

Brim

6 Secure the cutter holder.

• Turn the knob screw to secure the holder presser. Failure to secure firmly may result in lower
quality.

Knob screws

7 Close the maintenance cover, then press the [ENTER] key.
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Using the Included Cutter Holder (SPA-0001)

1 Loosen the lock nut of the cutter holder and extract the adjusting knob.

• Turn in the direction indicated by the arrow in the picture.

Lock nut

Adjusting knob

2 Insert the cutter into the adjusting knob.

• Use tweezers to insert the cutter.

3 Fix the lock nut by turning in the direction indicated by the arrow in the picture.

Adjusting the Cutting Blade Protrusion Length

1 Loosen the lock nut of the cutter holder.

Lock nut

2 Turn the adjusting knob to adjust the protrusion of the cutting blade.

Adjusting knob

3 Fix the lock nut by turning in the direction indicated by the arrow in the picture.

3
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Using a Pen

Installing a Refill Cartridge for a Ballpoint Pen in the Pen Holder
The image quality can vary depending on the type of refill cartridge. Recommended: SXR-5 (Mitsubishi
Pencil Co., Ltd.)

1 Remove the cap from the pen holder.

• Turn in the direction indicated by the arrow in the picture.

Pen holder

2 Insert a refill cartridge into the pen holder.

• Insert the refill cartridge until it hits the pen holder.

Refill cartridge

3 Insert the spring into the refill cartridge.

Spring

4 Fix the cap by turning in the direction indicated by the arrow in the picture.
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Installing a Ballpoint Pen in the Pen Adapter
Use a ballpoint pen with a diameter of 8 to 9 mm. The ballpoint pen type may affect image quality.
Recommended: K105-GA (Pentel Co., Ltd.)

• Do not use ballpoint pens as shown below. Some types of ballpoint pens may tilt.

Pens with shafts that change thickness
midway

Pens with protrusions or bumps on the shaft

1 Put the cap on the pen adapter.

• The cap is used to adjust the height of the pen nib.

Pen adapter

Cap

2 Insert the ballpoint pen into the pen adapter.

• Insert the pen nib until it hits the cap.

Ballpoint pen

3 Fix the pen nib by turning the knob screw in the direction indicated by the arrow in the
picture.
• Be careful to avoid overtightening the knob screw. Disregarding this precaution may damage or

break the ballpoint pen.

Knob screws

3
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4 Remove the cap.

Installing a Pen

1 On the LOCAL mode screen, select [MENU] > [Cutting], then press the [ENTER] key.

• The Cutting menu is displayed.

2 Select [Tool Change], then press the [ENTER] key.

3 Open the maintenance cover on the left side.

• The cutter unit can be moved manually. Move the carriage slowly to a position allowing
easy access while working.

4 Turn the knob screw and loosen the holder presser.

Holder presser

Knob screws

5 Insert the pen holder or pen adapter into the tool holder.

• Push the brim of the pen holder or pen adapter against the holder presser.

Brim
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6 Secure the pen holder or pen adapter.

• Turn the knob screw to secure the holder presser. Failure to secure firmly may result in lower
quality.

7 Close the maintenance cover, then press the [ENTER] key.

3
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3.3 Setting the Cutting Conditions
You can set the cutting speed and pressure to match the type of media and tools in use.

1 On the LOCAL mode screen, select [TOOL].

width:1340mm

PRTOOL TEST CUT

LOCAL

2 Set the conditions.

• The following items can be configured:
• The settings are retained even when the power is turned off.

Item Setting Overview

TOOL CUT1 to 7/
PEN

• Press the key repeatedly to change the tool condition in the
sequence shown below.

CUT 1～ 3 PEN

CUT 4～ 7

Speed 1 to 30 cm/s • Sets the speed for cutting or pen writing.

Pressure TOOL: 10 to
450 g

PEN: 10 to
150 g

• Sets the pressure for cutting or pen writing.
• This setting is also required for half cuts.

Offset*1 0.00 to 2.50
mm

• Sets the length from the center of the cutter holder to the cutting
blade.

Cutter holder

Cutting blade

Offset

Half Cut*1 ON/OFF • Cuts across a dotted line without cutting out the base paper.

[Pressure] Cutter

[H-Leng][C-Leng]

[Half Cut Pressure]
Label film

Base paper

• If Half Cut is set to "ON", the three items listed below are displayed:
Set the following three items and pressure in the Cutting Conditions
menu:

Half Cut
Pressure

0 to 300 g • Sets the pressure for the uncut portion.

H-Leng 0.1 to 5.0 mm • Sets the uncut length.

C-Leng 5 to 150 mm • Sets the cut length.

*1. This cannot be set when PEN is selected.
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3.4 Test Cutting
Execute test cutting to confirm that the tool conditions are set appropriately.
Increase pressure as the cutter blade grows dull with wear. This is only a temporary measure. We
recommend replacing the cutter blade to maintain cutting quality.

1 On the LOCAL mode screen, select [TEST CUT].

width:1340mm

PRTOOL TEST CUT

LOCAL

2 Select [Test Cut], then press the [ENTER] key.

• Test cutting starts.

• Check the test cut results, and change the cutting conditions accordingly.

Symptom Cause Solution

An uncut section was
identified.

• Because the speed is too
high, the cutting blade
passed over the media.

• Reduce the [Speed].  "Setting the
Cutting Conditions"(P. 122)

• Tighten the knob on the tool holder. 
"Installing the Cutter Holder"(P. 116)

The base paper of the media
is cut.

• The pressure is
excessive.

• The cutting blade
protrudes too far.

• Reduce the [Pressure].  "Setting the
Cutting Conditions"(P. 122)

• Reduce the protrusion of the cutting
blade.  "Adjusting the Cutting Blade
Protrusion Length"(P. 115)

The corners are rounded. • The length from the center
of the cutter holder to the
cutting blade is not set
correctly.

• Adjust the [Offset] value according to
the cutter used.  "Setting the Cutting
Conditions"(P. 122)

The corners are turned up. Two or more of the following
apply:

• The cutting blade
protrudes too far.

• The pressure is
excessive.

• The [MENU] > [Cutting] >
[Setup Sub Menu] > [Adj-
prs Offset] value is large.

• Reduce the protrusion of the cutting
blade.  "Adjusting the Cutting Blade
Protrusion Length"(P. 115)

• Reduce the [Pressure].  "Setting the
Cutting Conditions"(P. 122)

• Reduce the [Adj-prs Offset] value. 
"Cutting Menu"(P. 195)

3
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3.5 Cutting the Cutting Data
Check beforehand

• Was the head gap adjusted?  "Adjusting Print Head Height"(P. 65)
• Were the pinch roller positions adjusted?  "Adjust the Pinch Roller Positions."(P. 67)
• Is media loaded?  "Loading the Media"(P. 70)
• Are the pinch rollers configured?  "Setting the Pressure and Number of Pinch Rollers to Use"(P. 93)

Changing the origin
You can change the cutting start position. Use the LED pointer to set the origin. The origin set here will be
the origin of the cutting software you are using.
When cutting the same data again, change the origin. If not, cutting starts at the same position.

New origin

1 On the LOCAL mode screen, press .

• The Origin Setup screen appears.

2 Press  to move the origin to the desired position.

• The carriage moves left and right and feeds the medium.

3 Press the [ENTER] key.

• The origin is updated.
• The set tool conditions are displayed on the display.

Starting Cutting

1 Press [REMOTE].

• The machine switches to REMOTE mode and is ready for cutting.

2 Send the cutting data from the PC.

• For more information, refer to the operation manual of the cutting software you are using.

3 Cutting starts.

• Cutting starts once the cutting data is received.
• The remaining amount of data is displayed on the display.

• If the media moves out of place during cutting, immediately turn off the power. Continuing to cut
while the media is not in place may damage the machine.
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Pausing Cutting

1 Press [LOCAL] while cutting is in progress.

• Cutting is paused.
• If data is being sent from a PC, data transmission is paused at the PC.

2 Press [REMOTE].

• Cutting resumes.

• No other functions can be executed while printing is paused.

Stopping Cutting (Data Clear)

1 On the LOCAL mode screen, select [DATA CLEAR].

width:1340mm

DATA CLEARADJUST

LOCAL

2 Press the [ENTER] key to clear the received data.

• The receive buffer is not cleared.

Retracting the Cutter Unit
When cutting or printing-with-a-pen is completed, the cutter unit is positioned on the platen. To check the
cutting result or to set new media, retract the cutter unit from the platen.

1 On the LOCAL mode screen, select [TEST CUT].

width:1340mm

PRTOOL TEST CUT

LOCAL

2 Select [Cut Head Move/Retract], then press the [ENTER] key.

• If the cutter unit is not connected to the carriage, it moves to the station to connect to the carriage.

• If the cutter unit is connected to the carriage, detach the carriage and move it to the
maintenance space on the left side.

3
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Chapter 4 Cutting Data with Register
Marks

This chapter

CJV UCJV Describes the register mark creation conditions and basic information (CJV/
UCJV).

Process for Cutting Data with Register Marks
......................................................................128
Creating Register Marks................................130

Register Marks ......................................... 130
Register Mark Size................................... 131
Spacing Between Register Marks ............ 132
Reading Range of Register Marks ........... 133
No-Plotting Areas Around Register Marks 134
Combined Operations of Printing and Cutting
................................................................. 135

Setting Mark Detection Conditions .................136
Detecting the Position of the Register Mark
Origin..............................................................137
ID Cut Process ...............................................138

When using the XY slitter...........................139



Chapter 4 Cutting Data with Register Marks

128

4.1 Process for Cutting Data with Register
Marks

1. Create data with register marks.

 "Creating Register Marks"(P. 130)
This machine can detect the following three types of register marks:

Type 1 Type 2 Zero margin register mark

2. Print printing data with register marks.

 "Print Process"(P. 62)

3. Prepare for cutting.

 "Cutting Process"(P. 112) (Steps 4 to 8)

4. Register the information for the printed register marks.

 "Setting Mark Detection Conditions"(P. 136)

5. Detect the register mark origin.

 "Detecting the Position of the Register Mark Origin"(P. 137)

(Mark shape) Type 1 (Mark shape) Type 2
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6. Cut the data.

 "Cutting the Cutting Data"(P. 124)

7. Cutting the media

 "Cutting the media"(P. 108)

4
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4.2 Creating Register Marks
Printing image data with "register marks" can increase cutting accuracy and quality. There are some
limitations to register marks. Read the following thoroughly before creating register marks.

• Trimming register marks cannot be used with the machine.

Register Marks
The following three types of register marks can be used with this machine:

Type 1 Type 2 Zero margin register mark

• Use mark 4 (TP4) to perform trapezoidal corrections. Mark 4 can be skipped, but doing so will
reduce cutting accuracy. 
Trapezoidal correction: Corrects the difference between the right and left feed amount of the
media.

l How cutting accuracy varies by speed
Accuracy Speed Register Mark Layout Detection Type

All register marks are detected.Register marks are arranged at the four corners of
each item of image data.

Register marks are arranged at the four corners of
the image data as a whole and at positions
between them.

All register marks are detected (4 marks).

Only the origin register mark is detected (1 mark).

No register marks No register marks

Higher

Lower

Slower

Faster
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Media and Register Mark Color
We recommend using white media and black register marks. The machine may fail to detect register marks
in other colors.

Blurred Register Marks
Ensure that printed register marks are not blurred. If the register marks are blurred, the mark origins may be
incorrectly identified, or the machine may fail to detect the register marks.

Register Mark Size
The recommended  register mark size (A) is within the range of A4 size (210 mm × 297 mm) to A3 size (297
mm × 420 mm). If the dimensions exceed A3, the machine may fail to detect register marks due to media
feeding problems (e.g., media meandering).

Register mark size (A)

Standards for Register Mark Length and Line Width

Line width

Register mark length (B)

The recommended register mark length and line width are as shown below. The machine may fail to detect
register marks that lie outside the recommended range.

Register mark size (A) Register mark length (B) Line width

200 mm or less 5 mm 0.5 mm

201 to 500 mm 8 mm

4
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Register mark size (A) Register mark length (B) Line width

501 to 1,000 mm 15 mm 1.0 mm

1,001 to 2,000 mm 25 mm

2,001 mm or more 35 mm

• If the "Fill around the registration marks" function of the RIP software is enabled, the register mark length
(B) should be 10 mm or more.

When Printing Register Marks Continuously
The register mark length (B) should be 8 mm or more. The machine may fail to detect register marks less
than 8 mm if it reads them continuously.

8 mm or more

Spacing Between Register Marks
The spacing between register marks (C) is as shown below.

(Mark shape) Type 1 (Mark shape) Type 2

Register mark length (B) x 2 + α, up to 1,000 mm

(C
)

(B
)

(B)

(C)

Register mark length (B) + α, up to 1,000 mm

(C
)

(B
)

(B)(C)
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l Mark Origin Mis-detection Example
• If the spacing between register marks (C) is narrow, as shown in the figure below, the machine may fail

to detect them.

(C
)

(B
)

(B)(C)

Reading Range of Register Marks
This machine can detect register marks in the range shown below. If the margin is small, the edge of the
media may be incorrectly identified as a register mark.
When copying data with MIMAKI RIP software (RasterLink), leave a space of at least 210 mm from the rear
edge of the media.

(Mark shape) Type 1 (Mark shape) Type 2
[Rear]

[Front]

50 mm or more

110 (or 210) mm

20 mm or more

50 to 3,000 mm

: Cut area

: No-plotting area

: Media

5 mm or more 5 mm or more

[Rear]

[Front]

50 mm or more

110 (or 210) mm 
+ (mark length (B)/2) or more

20 mm 
+ (mark length (B)/2) or
more

Within 3,000 mm

: Cut area

: No-plotting area

: Media

5 mm or more 5 mm or more

50 mm or more

ID Cut
This machine can detect register marks in the range shown below. If the margin is small, the edge of the
media may be incorrectly identified as a register mark.
When copying data with MIMAKI RIP software (RasterLink), leave a space of at least 210 mm from the rear
edge of the media.

4
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(Mark shape) Type 1 (Mark shape) Type 2
[Rear]

[Front]

70 mm or more

110 (or 210) mm

110 mm or more

70 to 3,000 mm

: Cut area

: No-plotting area

: Media

15 mm or more 15 mm or more

[Rear]

[Front]

70 mm or more

110 (or 210) mm 
+ (mark length (B)/2) or more

110 mm 
+ (mark length (B)/2) or more

Within 3,000 mm

: Cut area

: No-plotting area

: Media

15 mm or more 15 mm or more

70 mm or more

• For more information, refer to the ID Cut Guide. https://mimaki.com/download/software.html

No-Plotting Areas Around Register Marks
Do not plot data around register marks. The mark origins may be identified incorrectly, or the machine may
fail to detect the register marks.

(Mark shape) Type 1 (Mark shape) Type 2

〃〃

〃
〃

(A
)

(B
)

(B)

: No-plotting area

: Plotting area

〃〃
〃

〃
(A

)
(B

)
(B)

: No-plotting area

: Plotting area

l Mark Origin Mis-detection Example
• If register marks are plotted in the no-plotting area as shown in the figure below, the line may be

incorrectly identified as a register mark.

Mis-detected

Mark origin

: No-plotting area

: Plotting area

https://mimaki.com/download/software.html
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Combined Operations of Printing and Cutting
When printing and cutting with MIMAKI software (RasterLink, FineCut), please note the following:

• The mark size and mark shape settings configured in the machine will be disregarded. Software settings
take precedence.

• We recommend printing and cutting using data with register marks. The volume of print data may affect
cutting accuracy.

• Although it is possible to print and cut data without register marks using take-up units, doing so may
reduce cutting accuracy.

4
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4.3 Setting Mark Detection Conditions
Set the conditions of the printed register marks.

1 On the LOCAL mode screen, select [MENU] > [Cutting], then press the [ENTER] key.

• The Cutting menu is displayed.

2 Select [Mark Detect], then press the [ENTER] key.

• The Mark Detect menu is displayed.

• The Mark Detect menu can also be displayed as follows:
(1) On the LOCAL mode screen, select [TEST CUT].
(2) Select [TP Detect Setup], then press the [ENTER] key.

3 Select and set the items.

•  "Cutting Menu"(P. 195)
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4.4 Detecting the Position of the Register
Mark Origin

1 On the LOCAL mode screen, select [TEST CUT].

width:1340mm

PRTOOL TEST CUT

LOCAL

2 Select [Mark Detection], then press the [ENTER] key.

• The machine switches to MARK DETECT mode.
• The cutting unit moves over the platen.

• If the machine does not switch to MARK DETECT mode, set the [TEST CUT] > [TP
Detect Setup] > [Detect] setting to "ON".

3 Press     to move the LED pointer 
to the center of the register mark.

(Mark shape) Type 1 (Mark shape) Type 2

4 Press the [ENTER] key.

• Register mark detection starts.

4
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4.5 ID Cut Process

1. Create data with ID Cut.

• For more information, refer to the ID Cut Guide. https://mimaki.com/download/software.html

2. Print printing data with ID Cut.

 "Print Process"(P. 62)

3. Prepare for cutting.

 "Cutting Process"(P. 112) (Steps 4 to 8)

4. Register the information for the printed register marks.

 "Setting Mark Detection Conditions"(P. 136)

5. Detect the register mark origin.

 "Detecting the Position of the Register Mark Origin"(P. 137)

6. Cut the data.

 "Cutting the Cutting Data"(P. 124)

7. Cutting the media

 "Cutting the media"(P. 108)

https://mimaki.com/download/software.html
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When using the XY slitter
• When using slitting afterwards (  "Slitting the Print Media Afterwards"(P. 163)) in combination, set

"Offset X" ([MENU] > [Cutting] > [Mark Detect] > [Detect Area] > [Offset X]  P. 195) so that this comes
after the XY slitter detection mark.

Not OK: Not set

Print data (second sheet)

Print data (first sheet)

[Offset X]: Set position

OK: Set

4
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This chapter

CJV UCJVJV Describes the procedures for slitting with the XY slitter and RIP
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5.1 XY Slitter
 "Specifications (XY Slitter)"(P. 302)

3
1

7

5

4

8
2

6

No. Name Overview

1 X Cutter Cutter for cutting the media in the feed direction.  "X Cutter"(P. 144)

2 XY carriage The XY carriage is made up of the mark sensor for reading slitting marks
and the Y cutter for slitting the media in the scan direction.

3 XY clamp Hold the media. These can be individually unclamped and moved. 
"Operating the XY clamps individually"(P. 143)

4 Tension bar Tensions the media to prevent it sagging.  "Using the Tension
Bar"(P. 145)

5 XY Clamp Lever Raising the clamp lever secures the media. Lowering the clamp lever
releases the media. This operation is reverse to that on the main unit. 
"XY Clamp Lever"(P. 143)

6 Media Chute This box holds the media slit by the XY slitter.  "Media Chute"(P. 145)

7 Media guides These parts guide the slit media into the media chute.

8 stopper Clamps and unclamps the tension bar.
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XY Clamp Lever

• This operation is reverse to that of the clamp lever on the main unit.

l Raising the XY clamp lever
The media is secured (clamped).

• Do not pull the media when the XY clamp lever is raised (the media is clamped). Doing so may
damage the machine.

l Lowering the XY clamp lever
The media is released (unclamped).

• The XY carriage can be moved by hand when the XY clamp lever is lowered.

Operating the XY clamps individually
The XY clamps can be individually unclamped and clamped. Pushing the XY clamp lever to the rear releases
the XY clamp, enabling it to be moved.

Release Clamp

• The XY clamps should be unclamped individually in locations where the media is not present.
Note that they cannot be operated using the XY clamp lever if they have been individually
unclamped.

5
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X Cutter

l Method for securing the X cutter
Raise the X cutter lever to secure the cutter.

l Method for mounting the X cutter
Insert the X cutter groove onto the L-shaped slide rail.

l Unused X cutter

• Slide out the unused X cutter, or move it away from the media and secure it by raising the lever.
If you start printing with the lever being lowered (unsecured), the X cutter may hit the XY
carriage and result in damage.
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Using the Tension Bar
To move the XY slitter tension bar, push down on it while moving.

Media Chute
This box holds the media slit by the XY slitter.
The box provided with the machine can be used as a media chute.  "Using the Media Chute"(P. 145)

• Not using the media chute may lead to inconsistent discharge, resulting in media jamming and
affecting the slitting quality. Either use the box provided with the machine or provide a separate
media chute.

• [Line Space] should be set when printing continuously.  "When set to [Normal] or [Line
Space]"(P. 146)

• Be aware of the volume of media inside the media chute when using the XY slitter for the first
time. Print quality may be reduced if the media chute is full.

• There is a risk of media printed surfaces sticking together if the media is folded in half or if the
media surfaces are left in contact with each other. Take great care to ensure that media sheets
are not stuck together when using the XY slitter for the first time.

• Media should be removed from inside the media chute as often as possible.

• The storage capacity varies depending on the media material and cut size.

Using the Media Chute
The way in which the media chute is used will vary depending on the RasterLink [Y Slit] setting.

5
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When set to [Normal] or [Line Space]

1 Place the media chute under the XY slitter.

2 Push the media chute front forward.

• Remove the screws at the front of both sides. Be careful not to lose the screws.

• Place so that the blank pieces cut off are ejected to the media chute.
• Use the media support.
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Try the following if the print length is 600 mm or less and the prints do not fall consistently into
the media chute.

• Pattern 1: Close the front of the media chute and secure it with screws. (Use the media
support.)

• Pattern 2: If problems occur when arranged as described above, turn the media chute
around so that the front is at the rear. (Do not use the media support.) 

Leave gap of about 80 mm

If the prints make contact with the media chute, move the media chute closer to the
machine.

Move closer

5
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When set to [Nothing]

1 Place the media chute under the XY slitter.

• Place so that the blank pieces cut off are ejected to the media chute.
• Use the media support.
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5.2 Slitting Simultaneously With Printing
• Slitting cannot be performed at the same time as "Print&Cut" or "Cut&Print".

1. Enable the XY Slitter.

 "Enable the XY Slitter."(P. 150)

2. Loading the Media

Put the media through the XY slitter.  "Loading the Media"(P. 150)

3. Printing guide (slit) line

Select "Slit at the same time as printing" in RasterLink.  "Printing guide (slit) line"(P. 154)

4. Mounting the X cutter

Cut the frame for positioning the media guides. Align the X cutter with the printed guide (slit) line. 
"Mounting the X cutter"(P. 157)

5. Printing RIP data

RIP data is slit at the point it is printed.  "Printing RIP data"(P. 161)

5
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Enable the XY Slitter.

1 On the LOCAL mode screen, select [MENU] > [Function Setting], then press the [ENTER] key.

• The Function Setting menu is displayed.

2 Select [Finisher] > [XY Slitter], then press the [ENTER] key.

○ None
● XY slitter
○ Unpublished

Loading the Media

l Media path

Tension bar

XY slitter

Pinch roller
Grit roller

Feeding unit

Take-up unit

• Adjust the head height before loading media. Moving the carriage after the media has been
loaded may result in the print head coming into contact with the media and being damaged.

• For instructions on how to load media, refer to  "Loading the Roll Media"(P. 80) (Steps 1 to
22).

• The torque limiter should ideally be set to "Mid".  "Adjusting the torque limiter"(P. 72)

1 Detach the stopper and move the tension bar to the rear.

stopper
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2 Lower the XY clamp lever.

• The XY carriage can be moved by hand when the XY clamp lever is lowered.

3 Move the X cutter to the side and raise the X cutter lever to secure it.

• Avoid touching the cutter blade. Failure to do so may result in injury.

4 Press  to feed the media to a position approximately 300 mm from the bottom face of the
front cover, then press the [ENTER] key.

5 Engage the media on to the tension bar and pull it out from the bottom.

Tension bar

5
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6 Insert the media between the pinch rollers and the grit rollers of the XY slitter.

Tension bar

XY clamp

• If it is difficult to insert the media, the XY clamps should be individually unclamped,
clamped, then unclamped again.

Release Clamp Release

7 Pull the tension bar to the front and secure it.

• This releases any tension from the media.

8 Press  to feed the media until it reaches the paper core on the take-up unit, then press the
[ENTER] key.

9 Secure the middle of the media to the paper core with adhesive tape.

• If the media edge is straight, secure the left and right sides of the media. Pull the lower
edge of the media evenly on both the left and right sides, check to confirm that it is free of
sagging and creasing, then affix the tape.

10 Press  to wrap the media about one and a half turns around the paper core, then press the
[ENTER] key.
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11 Move the XY clamps.

• Position the XY clamps on both edges and at the center of the media.
• Align the XY clamps with the mark (square hole) positions.

Mark (square hole)

• Position the XY clamps so that the clamp centerlines align with the marks (square holes).
The media cannot be transported correctly unless the XY clamp centerlines are aligned
with the marks (square holes).

Good example Bad example

Mark (square hole) Mark (square hole)

12 Check the XY clamp states.

• XY clamps that are not used: Check that they are unclamped.
• XY clamps that are used: Check that they are clamped.

Release Clamp

• The XY clamps should be unclamped individually in locations where the media is not
present. Note that they cannot be operated using the XY clamp lever if they have been
individually unclamped.

13 Raise the XY clamp lever.

• Hold the media.

5
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• Do not pull the media when the XY clamp lever is raised (the media is clamped). Doing so
may damage the machine.

14 Individually unclamp the clamps in locations where the media is not present (i.e. Clamps that
are not used).
•  "Operating the XY clamps individually"(P. 143)

15 Press  to decrease the media tension slightly, then press the [ENTER] key.

16 Unlock the tension bar.

• This applies tension to the media.

Printing guide (slit) line
The explanation here applies to MIMAKI RIP software (RasterLink).

• The slitting size is 210 mm or more in the Y (scan) direction and 297 mm or more in the X (feed)
direction.

• For more information, refer to the RasterLink reference guide. https://mimaki.com/download/
software.html

• Prepare suitable image data.
• When slitting from the front edge of the media, leave at least 1,000 mm of space from the front

edge to the guide (slit) line.

1 Launch RasterLink.

• Click the icon on the PC desktop.

https://mimaki.com/download/software.html
https://mimaki.com/download/software.html
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2 Select the image data to print.

(1) Select [File] > [Open].
(2) Select the desired image data, then click [Open].

• If multiple printers are registered, select 330 Series in "Printer Name".

3 Select the image data imported.

• The image data is added in the tab for 330 Series selected in "Printer Name".

4 Click  (General Print) to check the settings and alter as necessary.

• Specify settings like scaling and rotation.

• The XY slitter cannot be used with the following print conditions. Alter the print conditions
if you wish to use the XY slitter.
(1) Resolution: 600 × 600 dpi, Passes: 2 passes

5 Enter the number of prints for [Copy] on the Image Edit tab.

5
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6 Select the [XY Slitter Edit] check box on the Image Edit tab.

Guide line

7 Select the slitting method for the Y (scan) direction.

• "None" is used when slitting only in the X (scan) direction.

8 Select the timing for slitting.

• Slit at the same time as printing: To slit simultaneously with printing.
• Slit Afterwards: To slit after printing.

9 Click [Print X-Cutter Reference line].

• Guide (slit) line printing starts.

• Do not print any other data after printing the guide (slit) line until the X cutter has been
mounted. Otherwise, the X cutter cannot be mounted.
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Mounting the X cutter

• Do not touch the X cutter when the XY clamp lever is raised. Otherwise, you may get injured by
the moving XY carriage.

1 Press the [ENTER] key.

• The printed guide line is fed to the slitter.

XY slitter usage preparation
Start XY Slitter preparation

[ENT]

2 Lower the XY clamp lever.

Up the clamp lever of XY Slitter

• The XY carriage can be moved by hand when the XY clamp lever is lowered.

3 Move the XY clamps.

• Align the XY clamps with the mark (square hole) positions.

Mark (square hole)

• Position the XY clamps so that the clamp centerlines align with the marks (square holes).
The media cannot be transported correctly unless the XY clamp centerlines are aligned
with the marks (square holes).

Good example Bad example

Mark (square hole) Mark (square hole)

5
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Alter the XY clamp positions according to the RasterLink [Y Slit] setting.

• With "Normal" or "Line Space" selected: 
Always clamp at both edges of the media. 
Do not clamp over the print data area. 
Unclamp the XY clamps that are not used.

XY clamp XY clampXY clamp

XY clamp unclamped

• With "None" selected: 
Clamp over the print data area (inside the X cutter). 
Unclamp the XY clamps that are not used.

XY clampXY clamp

4 Align the groove in the X cutter with the printed guide line, embed the blade in the media, then
raise the lever to secure.

Set X cutter
[ENT]

Left guide line

Lever

Right guide line

• Avoid touching the cutter blade. Failure to do so may result in injury.
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• Slide out the unused X cutter, or move it away from the media and secure it by raising the
lever. If you start printing with the lever being lowered (unsecured), the X cutter may hit
the XY carriage and result in damage.

5 Raise the XY clamp lever.

• Hold the media.

Up the clamp lever of XY Slitter

• Note that the carriage moves when the clamp lever is raised.

6 Press the [ENTER] key.

• Cutting starts for the frame for positioning the media guides.

RasterLink [Y Slit] setting: [Normal] [Line Space] RasterLink [Y Slit] setting: [Nothing]

Start Frame Cut
[ENT]

Start cutting blank space
[ENT]
[ENT]

• The cut form will vary depending on the RasterLink [Y Slit] setting.

5
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7 Attach the cut-off piece of the frame to the media with tape.

Roll the media to the roll core
[ENT]

RasterLink [Y Slit] setting: [Normal] [Line Space] RasterLink [Y Slit] setting: [Nothing]

• Data cannot be printed in succession if it has different slit positions in the scan direction or
different slit widths. To print data with different slit positions or different widths, replace the
paper core and repeat the process from the beginning (  "Loading the Media"(P. 150)).

• When using the XY slitter, Backward feed (backward feed after pressing the  key or
view feed) is disabled.

8 Position the media chute.

•  "Using the Media Chute"(P. 145)

9 Position the media guides.

Set media guides
[ENT]

Media guides Media guides

Position the media guides 10 to 20 mm away from the media
edges.

Position media guides in blank space. 
The blank pieces cut off will be ejected to the media chute.

RasterLink [Y Slit] setting: [Normal] [Line Space] RasterLink [Y Slit] setting: [Nothing]
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Printing RIP data
The explanation here applies to MIMAKI RIP software (RasterLink).

• Slitting cannot be performed at the same time as "Print&Cut" or "Cut&Print".

1 Click  (Quality).

• This selects a color profile for the media and ink set loaded in this machine.

• For more information, refer to the RasterLink reference guide. https://mimaki.com/
download/software.html

2 Print image data.

•  "Starting Printing"(P. 161)

(1) Click  (Execution) from the function icons on the right-hand side of the screen.
(2) Select "Immediate Print" or "RIP and Print", then click [Start].

• Once printing is complete, feed the media to slit as far as the rear edge of the print media
(final print media in the case of continuous data). In this case, feed the media
intermittently (the [Function Setting] > [WhiteSpace Setting >[Space Feed Mode] setting is
disabled).

Starting Printing

• Before starting printing, check to confirm that the remaining amount of cloth wiper is sufficient.
Auto maintenance may be performed during printing depending on the ambient temperature in
which the machine is located and the [Print Maint.] (  P. 185) setting. If the cloth wiper is
insufficient, printing will pause without performing auto maintenance. If there is insufficient cloth
wiper remaining, replace with a new cloth wiper.  "Cloth Wiper Replacement"(P. 228)

1 Send the RIP data from the PC.

•  "Preparing RIP data"(P. 103)

• If the message "Attention20A Driver version" appears, install the latest Mimaki driver.
https://mimaki.com/download/inkjet.html

2 Start printing.

• Printing starts once RIP data is received.

REMORT

NRS 0.0m

600x600    16p / Bi / Hi / Vd

[Resolution]

[Number of passes]

[Scan direction] (Uni: unidirectional, Bi: bidirectional)

[Scan speed] (Std: standard, Hi: high speed)

[Dot type]
VD: Variable dot
ND: Normal dot

Length of medium printed

[Nozzle Recovery]

: A part of nozzles can be recovered
: All nozzles can be recovered

: Not registered or the print mode
where nozzles cannot be recovered

NRS
NRS
OFF

5

https://mimaki.com/download/software.html
https://mimaki.com/download/software.html
https://mimaki.com/download/inkjet.html


Chapter 5 Using the XY Slitter

162

• Print speeds may differ for the same image data, depending on the width of the medium
loaded, print origin position, and resolution.

• If an error occurs, the machine switches to LOCAL mode once printing is completed.
Further printing is not possible.

• The ink used in this machine is warmed before printing. Printing is disabled while the ink is
warmed.

Pausing Printing

1 Press [LOCAL] while printing is in progress.

• Printing is paused.
• If data is being sent from a PC, data transmission is paused at the PC.

2 Press [REMOTE].

• Printing resumes.

• No other functions can be used when printing is paused.
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5.3 Slitting the Print Media Afterwards
• Slitting cannot be performed at the same time as "Print&Cut" or "Cut&Print".
• Media cannot be slit after it has been laminated.

1. Disable the XY Slitter.

 "Disable the XY Slitter."(P. 165)

2. Setting the Media Width Detection Type to AUTO

 "Setting the Media Width Detection Type to AUTO"(P. 165)

3. Loading the Media

The XY slitter is not used. Do not put media through the XY slitter.  "Loading the Roll Media"(P. 80)

4. Printing guide (slit) line

Select "Slit Afterwards" in RasterLink.  "Printing guide (slit) line"(P. 154)

5. Printing RIP data

 "Printing RIP data"(P. 161)
If you wish to slit from the rear edge of the media, print the guide (slit) line after the RIP data has been
printed.  "Slitting from the Media Rear Edge"(P. 165)

6. Enable the XY Slitter.

 "Enable the XY Slitter."(P. 166)

7. Positioning printed media

Put the printed media through the XY slitter.  "Loading the Media"(P. 150)

5
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8. Detecting slitting marks

Load the printed media, then detect the marks.  "Detecting slitting marks"(P. 167)

9. Mounting the X cutter and slitting

 "Mounting the X cutter and slitting"(P. 170)
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Disable the XY Slitter.

1 On the LOCAL mode screen, select [MENU] > [Function Setting], then press the [ENTER] key.

• The Function Setting menu is displayed.

2 Select [Finisher] > [None], then press the [ENTER] key.

● None
○ XY Slitter
○ Unpublished

Setting the Media Width Detection Type to AUTO

1 On the LOCAL mode screen, select [MENU] > [Media Setting], then press the [ENTER] key.

• The Media Setting menu is displayed.

2 Select [Media Information] > [Media Width] > [Detection Type] > [AUTO], then press the
[ENTER] key.

• Slitting cannot be performed afterwards if set to "Manual".

Loading the Media

• For details of how to load media, refer to  "Loading the Roll Media"(P. 80).

Printing guide (slit) line

• For details of how to print the guide (slitting) lines, refer to  "Printing guide (slit) line"(P. 154).

Printing RIP data

• For details of how to print RIP data, refer to  "Printing RIP data"(P. 161).

Slitting from the Media Rear Edge
Once printing has ended, print the guide (slit) lines to allow slitting from the rear edge of the media.

• When slitting from the rear edge of the media, leave at least 1,000 mm of space from the guide
(slit) lines to the rear edge.

1 Select the printed image data.

5
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2 Select the slitting method for the Y (scan) direction.

RL_XY Slitter_Y Slit method

• "None" is used when slitting only in the X (scan) direction.

3 Select [Slit Afterwards].

4 Click [Print X-Cutter Reference line].

• Guide (slit) line printing starts.

Enable the XY Slitter.

1 On the LOCAL mode screen, select [MENU] > [Function Setting], then press the [ENTER] key.

• The Function Setting menu is displayed.

2 Select [Finisher] > [XY Slitter], then press the [ENTER] key.

○ None
● XY slitter
○ Unpublished

Positioning printed media

1 Position the printed media in the feeding unit.

•  "Loading the Media"(P. 150)
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Detecting slitting marks

1 On the LOCAL mode screen, select [MENU] > [Function Setting] > [XY Slitter] > [Slit Position
Detection].

XY slitter
Slit Position Adjustment
Slit Position Detection
Slitting Feed

>
>
>

2 Select the detection method.

•  "Auto Detect"(P. 167): To detect marks automatically
•  "Entering Positions"(P. 169): To input the mark positions

Slit Position Detection
Auto Detect
Entering Positions

>
>

l Explanation of marks
[1]

 20
.0

[2
] 5

5.0

[3
] 6

55
.0

[4
] 7

05
.0

[5
] 1

30
5.0

Y slit register mark

Afterwards slitting mark

Guide line
(X cutter position) X cutter positioning marks

Cut line

Slit position detection assistance mark

Distance from media edge

Auto Detect

1 Select [Auto Detect].

2 Select the color of the slitting marks.

• Select the color of the printed marks.

Select the color of the detection mark

Black
White

5
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3 Lower the XY clamp lever.

• The carriage moves over the platen.

Up the clamp lever of XY Slitter

• The XY carriage can be moved by hand when the XY clamp lever is lowered.

4 Move the LED pointer to the center of the mark at the right edge of the media, then press the
[ENTER] key.

Slit Position Detection
0.0 0.0

[1]
 20

.0

[2
] 5

5.0

[3
] 6

55
.0

[4
] 7

05
.0

[5
] 1

30
5.0

Afterwards slitting mark

LED pointer position
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• The slit position detection assistance mark can be used to align the LED pointer with the
center of the mark at the right edge of the media more easily.
(1) Align the  mark on the carriage with the slit position detection assistance mark. 

 keys: Carriage movement
Carriage

Slit position detection assistance mark

(2) Align the slit position detection assistance mark with the front edge of the carriage. 
: Media feed

Carriage

Slit position detection assistance mark

• Align with the center of the Afterwards slitting mark. The mark may not be successfully
detected unless aligned with its center.

5 Check the width of the detected slit line, then press the [ENTER] key.

Width (R) : 500 mm
Width (L) : 500 mm
Completed [ENT]

• If mark detection fails, press the [ENTER] key and repeat the process from Step 3
(  P. 168Lower the XY clamp lever).

Slit detection failure
[ENT]

Entering Positions

1 Select [Enter the position].

2 Select the color of the slitting marks.

• Select the color of the printed marks.

Select the color of the detection mark

Black
White

5
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3 Enter the values printed on the media.

[1]
[2]
[3]
[4]

20.0 mm
55.0 mm

555.0 mm
605.0 mm

[5] 1105.0 mm

[1]
 20

.0

[2
] 5

5.0

[3
] 6

55
.0

[4
] 7

05
.0

[5
] 1

30
5.0

4 Check the width of the slit line entered, then press the [ENTER] key.

Width (R) : 500 mm
Width (L) : 500 mm
Completed [ENT]

Mounting the X cutter and slitting

1 On the LOCAL mode screen, select [MENU] > [Function Setting] > [XY Slitter] > [Slitting Feed].

2 Select the slitting method for the Y (scan) direction.

Y direction slitting method
Please Select.

Normal slitting (XY)
No Y slitting (X only)

Be sure to select the slitting method according to the RasterLink [Y Slit] setting.

• [Normal] [Line Space]: Normal slitting (XY)
• [Nothing]: Y slitting (X only)

3 Select whether guidelines are present.

• YES: The media is fed. Proceed to the next step.
• NO: Proceed to Step 9 (  P. 173Raise the XY clamp lever).

Are there guidelines?
NO < > YES
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4 Lower the XY clamp lever.

Up the clamp lever of XY Slitter

• The XY carriage can be moved by hand when the XY clamp lever is lowered.

5 Press the up/down keys to feed the media.

• Align the groove in the X cutter with the X cutter alignment mark position.

Feed to the X Cutter set position
[1]

 20
.0

[2
] 5

5.0

[3
] 6

55
.0

[4
] 7

05
.0

[5
] 1

30
5.0

X cutter positioning marks

Enlarged view

6 Press the [ENTER] key.

7 Move the XY clamps.

• Align the XY clamps with the mark (square hole) positions.

Mark (square hole)

5
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• Position the XY clamps so that the clamp centerlines align with the marks (square holes).
The media cannot be transported correctly unless the XY clamp centerlines are aligned
with the marks (square holes).

Good example Bad example

Mark (square hole) Mark (square hole)

Alter the XY clamp positions according to the RasterLink [Y Slit] setting.

• With "Normal" or "Line Space" selected: 
Always clamp at both edges of the media. 
Do not clamp over the print data area. 
Unclamp the XY clamps that are not used.

XY clamp XY clampXY clamp

XY clamp unclamped

• With "None" selected: 
Clamp over the print data area (inside the X cutter). 
Unclamp the XY clamps that are not used.

XY clampXY clamp
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8 Align the groove in the X cutter with the printed guide line, embed the blade in the media, then
raise the lever to secure.

Set X cutter
[ENT]

Left guide line

Lever

Right guide line

• Avoid touching the cutter blade. Failure to do so may result in injury.

• Slide out the unused X cutter, or move it away from the media and secure it by raising the
lever. If you start printing with the lever being lowered (unsecured), the X cutter may hit
the XY carriage and result in damage.

9 Raise the XY clamp lever.

• Hold the media.

Up the clamp lever of XY Slitter

• Note that the carriage moves when the clamp lever is raised.

10 Unlock the tension bar of the XY slitter.

• Tension is applied to the media.

5
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11 Press the [ENTER] key.

• Cutting starts for the frame for positioning the media guides.

RasterLink [Y Slit] setting: [Normal] [Line Space] RasterLink [Y Slit] setting: [Nothing]

Start Frame Cut
[ENT]

Start cutting blank space
[ENT]
[ENT]

• The cut form will vary depending on the RasterLink [Y Slit] setting.

12 Attach the cut-off piece of the frame to the media with tape.

Roll the media to the roll core
[ENT]

RasterLink [Y Slit] setting: [Normal] [Line Space] RasterLink [Y Slit] setting: [Nothing]

• Data cannot be printed in succession if it has different slit positions in the scan direction or
different slit widths. To print data with different slit positions or different widths, replace the
paper core and repeat the process from the beginning (  "Loading the Media"(P. 150)).

• When using the XY slitter, Backward feed (backward feed after pressing the  key or
view feed) is disabled.

13 Position the media chute.

•  "Using the Media Chute"(P. 145)
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14 Position the media guides.

Set media guides
[ENT]

Media guides Media guides

Position the media guides 10 to 20 mm away from the media
edges.

Position media guides in blank space. 
The blank pieces cut off will be ejected to the media chute.

RasterLink [Y Slit] setting: [Normal] [Line Space] RasterLink [Y Slit] setting: [Nothing]

15 Press the [ENTER] key.

• Slitting starts.

Width (R) : 500 mm
Width (L) : 500 mm
Start [ENT]

• Slitting is repeated until reaching the end of the media. To stop slitting, press the [END]
key.

5
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5.4 Troubleshooting

If a Media Jam Occurs in the XY Slitter

1 Lower the XY clamp lever.

• The XY carriage can be moved by hand when the XY clamp lever is lowered.

2 Move the XY carriage away from the media.

3 Lower the X cutter lever.

4 Move the X cutter to the side and raise the lever to secure it.

• Avoid touching the cutter blade. Failure to do so may result in injury.

5 Use the cutter to cut the media near the tension bar.

6 Remove the jammed media.
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If the Y Slit Position is Offset
If the Y slit position is offset on the slitted media, adjust the Y slit position by entering a correction value.

1 On the LOCAL mode screen, select [MENU] > [Function Setting] > [XY Slitter] > [Slit Position
Adjustment].

2 Select the position to be adjusted (X or Y position), then press the [ENTER] key.

Slit Position Adjustment
X position
Y position

0.0
0.0

Slit position

Y slit line (RIP setting)

Y

X

(+) (-)

(-)

(+)

3 Enter the adjustment value, then press the [ENTER] key.

• Entering 0.1 moves the position by 0.1 mm.

5
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6.1 Media Setting Menu
When you use the machine for the first time, the Select Use Media screen is displayed.  "Registering the
Media"(P. 89) The media Information and correction value can be saved in advance for specific media.

• To set print conditions for a single use, select "Temporary". The conditions set in "Temporary"
are cleared when the machine is restarted.

The user can select to prioritize the settings on the machine or the settings on the PC. Setting individual
menus to "Host" prioritizes PC settings. To prioritize settings for this machine, select a setting other than
"Host".

• For more information on how to specify RIP software, refer to the RIP software operating
manual.

l Menu List
Item Setting Details

*1 *2

Feed Comp. -9999 to 0 to
9999

- Corrects the media feed amount. Print a pattern and enter the
correction amount.  "Feed Correction"(P. 99)

Drop.PosCorrect - - Corrects the drop position for bi-directional printing. 
"Correcting the Drop Position"(P. 101)

(Resolution) * - Select the resolution to be corrected.
When "All" is selected, correction patterns will be printed for all
resolutions.

* The available resolutions vary according to the model.

(Correction
Value)

-40.0 to 0 to
40.0

- Check the pattern and enter correction values.

Auto-correction - - The auto-correction function (DAS: Dot Adjustment System)
detects a correction pattern with the sensor and automatically
corrects the drop position.
When "All" is selected, "Feed Comp." and "Drop.PosCorrect"
are corrected.

• Check to confirm that the media does not lift up.
• Load white and clean media.
• Media such as synthetic paper, tarpaulin, or cloth media

may not be detected.
• Do not send RIP data from the PC during pattern printing.
• If automatic correction is unsuccessful, correct the position

manually. [MENU] > [Media Setting] > [Feed Comp.] or
[Drop.PosCorrect]

• UCJV: The following screen display indicates that the print
head is being warmed. Printing starts once the proper
temperature is reached. 

Waiting Temp stabilize
0:01:20

Printing can be started without waiting for the print head to
reach the proper temperature by pressing the [ENTER]
key while the screen is displayed, but dot printing may be
offset.

All -

Feed Comp. - -

Drop.PosCorrect - -
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Item Setting Details

*1 *2

(Resolution) * - Select the resolution to be corrected.
When "All" is selected, correction patterns will be printed for all
resolutions, and the drop position is corrected automatically.

* The available resolutions vary according to the model.

Feed Comp.(pull-
back)

-9999 to 0 to
9999

- This adjustment must be performed before using pullback
printing. Corrects the media feed amount specifically for the
pullback printing function.

• Print a pattern and enter the correction amount.  "Feed
Correction"(P. 99)

UV mode
* UCJV only

ON/OFF/
NoPrint

ON Sets whether to turn on or off the UV-LED lamp.
• ON: Turns on the lamp.
• OFF: Does not turn on the lamp.
• NoPrint: Turns on the lamp without printing. (Not used

under ordinary conditions)

UV AdjVal
* UCJV only

-50 to 0 to
+50 %

- The preset UV-LED lamp brightness can be altered. Check
the performance (e.g. stickiness and odor) after printing.

• Minus direction: Reduces hardness.
• Plus direction: Increases hardness.

MAPS* - - MAPS: Mimaki Advanced Pass System
This function disperses the boundaries between passes to
make feed streaks between passes less visible.
Altering MAPS may alter the color. This function may be less
effective with certain types of images.

* The MAPS version will vary according to the model.

MAPS* AUTO/
MANUAL

- This should normally be set to "AUTO". When set to
"MANUAL", the following items are displayed:

Speed 50 to 100 % - Reducing speed will make streaks less visible. However,
printing will be slower.

Smoothing
Level (Color)

0 to 100 % - Increasing smoothing makes streaks less visible. Make
separate settings for color and spot color (white).

Smoothing
Level (Spot)

Heater - - Set the heater temperature.  "Setting the Heater
Temperature"(P. 95)

• TS: Only equipped with a post-heater. (TS330-1600 only,
the print heater is optional.)

• UCJV: Only equipped with a pre-heater.

PRE OFF/20 to 60
°C

- Preheats the media before printing to suppress rapid
temperature change.

PRINT*3 OFF/20 to 50
°C

- Helps prevent ink bleeding.

POST OFF/20 to 60
°C

- Allows ink to dry after printing.

POST 1*4 OFF/20 to 50
°C

- Allows ink to dry after printing.

6
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Item Setting Details

*1 *2

POST 2*4 OFF/20 to 60
°C

-

OFF time None / 0 to 90
min

- Sets the time before turning the heater off after printing.

Media Information - - Enter the media information.

Media Type - - Select the media type to be used. The available media types
vary depending on the model.

Media Width - - Sets the media width detection method.

Detection
Type

AUTO/
MANUAL

• AUTO: The media width is automatically detected with the
sensor.

• MANUAL:  Press  to set the media width manually.
– When media width cannot be detected correctly, set the

media width detection method to "MANUAL".

Media Operation
Form
*CJV/UCJV only

Roll/Leaf - Select whether roll media or leaf media is used.

Media Remain - - The remaining roll media amount can be displayed and printed
out in REMOTE mode. The print length will be displayed when
leaf media is in use.

Media
Remain
Manage

ON/OFF - • ON: An input screen appears once the media width is
detected.  Press  to set the media length. 
Press the [FUNC3] key on the "Origin Setup" screen to
print the date and remaining media amount.

• OFF: The remaining media amount is not displayed.

Length 0 to 500 m - Enter the roll media length.

Detail Setting - - This is used to set various functions.

Vacuum Fan Host/Weak/
Standard/

Strong

Stro
ng

Sets the force with which the medium is held down.
• This can be used to prevent media jamming and print

head damage caused by the media lifting up.

Continuous
Running

ON/OFF • ON: The media is constantly held down under vacuum.
• OFF: The media is held down by vacuum only when

required, such as during printing and feeding.

Feed Speed Host/10 to
100 to 200 %

100 Sets the media feed speed.
• Depending on print conditions, the speed may not vary for

certain settings.
• Setting to 100 % or more reduces the time required to

complete printing but may affect print quality due to
insufficient drying time.

Clamp pressure
*JV/TS only

AUTO/Weak/
Standard/

Strong

- Sets the media clamping pressure.

Pre Feed
* TS only

OFF/100 to
500 mm

- Sets the distance the media is fed backward and forward
before printing.

• Moving the media backward and forward prevents it
sticking to the platen and minimizes wrinkles in the media.

Media Name
Change

- - You can change the name of a setting type. The name can
include alphanumeric characters or symbols.
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Item Setting Details

*1 *2

Delete MediaInfo - - Delete the set media information.

Media Transport
Mode
* Only when using the

TP410.

Normal/High
quality

- Set the media transport conditions.
Under normal circumstances, set it to "Normal".
If you wish to prioritize quality after take-up, please set it to
"High quality". However, please note that printing will be
slower.

*1. The default settings are shown underlined.
*2. Settings applied if no settings can be made in the RIP software (host) or if this machine is prioritized.
*3. TS330-1600 only
*4. TS330-1800 only

6
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6.2 Maintenance Menu
This menu is used for maintenance actions. It also lets the user perform nozzle recovery if nozzle clogging
persists even after cleaning and nozzle washing.

l Menu List
Item Setting*1 Details

Station Maint. - This moves the carriage to allow station and print head
maintenance.Carriage Out -

Move To Platen
Right End

- Cleans around the station, including the cap, wiper, and NCU.
 "Cap Rubber Cleaning"(P. 206)
 "NCU Cleaning"(P. 209)

Move To Maint.
Space

- Cleans around the print head.
 "Carriage Underside Cleaning"(P. 207)
 "Media Sensor Cleaning"(P. 214)
 "DAS (Automatic Correction Function) Sensor

Cleaning"(P. 211)

Nozzle Wash 1 to 99 min Washes the print head nozzle surface with maintenance liquid to
resolve ejection failures (e.g., nozzle clogging or deflection). 
"Print Head Nozzle Washing"(P. 263)

Pump Tube
Cleaning

- Washes the suction pump tube (below the cap).  "Ink Discharge
Channel Cleaning"(P. 212)

Custody Wash 1 to 99 min Perform this step if the machine will not be used for extended
periods. The function washes nozzles and drainage channels to
maintain the machine in optimal condition.  "When this Printer is
Left Unused for a Long Time"(P. 222)

Replace Wiper - Use this function when replacing the cloth wiper. Replacing the
cloth wiper resets the cloth wiper used length stored in the
machine.  "Cloth Wiper Replacement"(P. 228)

Cap Replacement - Use this function when replacing the cap. Replacing the cap resets
the cap usage time stored in the machine.  "Cap
Replacement"(P. 232)

Test Printing - Print a test pattern to confirm that the ink prints correctly. Perform
head cleaning if you observe any ejection failures (e.g., nozzle
clogging or deflection).  "Test Printing"(P. 96)

Cleaning - Several head cleaning methods are available. Choose the head
cleaning method based on test print results.  "Head
Cleaning"(P. 98)

Nozzle Recovery - Allows other nozzles to be used for printing if maintenance actions
like nozzle washing fail to resolve ejection failures (e.g., nozzle
clogging or deflection).

Print - Prints a pattern to check nozzle condition and register the nozzle.
 "Registering Nozzle Recovery"(P. 186)

Entry - Registers the nozzle without printing a pattern.

Reset - Initializes the details set.

Test Printing ON/OFF Sets whether to perform nozzle recovery before test printing.

Nozzle Check -  "Nozzle Check"(P. 188)

Printing Check ON/OFF Performs nozzle clogging detection before printing starts.
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Item Setting*1 Details

Check Interval - Sets the nozzle clogging detection timing.

Length 0.1 to 30.0 to
100.0 m

Performs nozzle clogging detection after the length set is reached
and before the next print starts.

File 1 to 30 to
1,000 files

Performs nozzle clogging detection after the preset number of files
has been printed and before the next print starts.

Continuation
Print

Stop/
Continuous

Select whether to stop or continue printing if "Nozzle clogging" is
detected.

Action Off/1 to 10 to
100

Performs nozzle recovery (cleaning followed by nozzle checking) if
"nozzle clogging" is detected.

Cleaning Soft/Normal/
Hard

Sets the cleaning type.

Retry Count 0 to 3 times Performs nozzle recovery (cleaning followed by nozzle checking)
for the specified number of times.

Auto Nozzle
Recovery

ON/OFF Performs nozzle recovery automatically if "nozzle clogging" is
detected. See below if you wish to perform nozzle recovery
manually.

 "Registering Nozzle Recovery"(P. 186)

Judgment
Condition*2

OFF / 1 to 64
nozzles

Set the number of nozzles to be detected as clogged before
"nozzle clogging" is detected. Up to 16 nozzles per row can be set.
The next print will not start if "nozzle clogging" is detected during
continuous printing.

Auto Maint. - Sets various maintenance actions to be performed automatically.
Set the interval between individual maintenance actions.

• If the warning message "Replace Wasteinktank" appears, the
automatic maintenance function is disabled.  "Waste Ink
Tank Replacement"(P. 251)

Refresh → Sets the refresh interval (when a small amount of ink is ejected
from the print head nozzles).

• JV/CJV/TS: 0.5/1.0 h (W ink set: 0.1 to 0.5 h)
• UCJV: 0.5 to 4.0 h

Pump Tube
Cleaning
*JV/CJV/TS only

OFF / 1 to
168 h

Sets the interval for washing the suction pump tube (below the
cap).

Cleaning Interval → Sets print head cleaning intervals. This will help prevent nozzle
clogging.

• JV/CJV/TS: 1 to 48 h
(W ink set: 1 to 12 h)

• UCJV: 1 to 24 h

Type Normal/Soft/
Hard

Sets the cleaning type for head cleaning.
• JV/CJV (W ink set) Default: Soft
• UCJV Default: Soft

Nozzle Protection ON/OFF If auto cleaning fails three times in a row, nozzle protection will be
automatically triggered.

Print Maint. - Sets the maintenance to be performed automatically midway
during printing.
Auto cleaning and interval wiping cannot be performed if there is
insufficient cloth wiper remaining. If there is insufficient cloth wiper
remaining, replace with a new cloth wiper.  "Cloth Wiper
Replacement"(P. 228)

6
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Item Setting*1 Details

Auto Cleaning - Sets the conditions to perform head cleaning after the preset
number of files are printed.

Setup File/Length/
Time/OFF

Sets the conditions to perform head cleaning.

Interval - Sets head cleaning intervals.

(File) 1 to 1,000 Cleaning starts when the set number of files is exceeded.

(Length) → Cleaning starts when the set print length is exceeded.
• JV/CJV/UCJV: 0.1 to 100.0 m
• TS: 1 to 1,000 m

(Time) 10 to 240 min Cleaning starts when the set print time is exceeded.

Type Normal/Soft/
Hard

Sets the cleaning type for head cleaning.
• JV/CJV (W ink set) Default: Soft
• UCJV Default: Soft

Cleaning Check ON/OFF Sets whether nozzle checking is performed after head cleaning is
completed.

Interval Wiping OFF/3 to 255
min

Wiping starts when the set print time is exceeded.

Refresh
*JV/CJV/TS only

Weak/
Standard/

Strong

Select the refresh (flushing) type during printing.

Waste Ink Tank - Resets or corrects the waste ink tank usage count.  "Waste Ink
Tank Replacement"(P. 251)

Reset Waste Ink
Volume

- Resets the waste ink tank usage count.  "Replacing the Waste
Ink Tank"(P. 251)

Adjust Waste Ink
Volume

- Corrects the waste ink tank usage count.  "When "Check Waste
Ink Tank" message appears"(P. 251)

Tank Capacity - Displays the waste ink tank capacity.

Air PG - Expels any air in the ink paths.
• JV/CJV/TS: Use this if Ink End is still displayed after ink

replacement.
• UCJV: Use this in case of considerable nozzle clogging with

white ink (dropouts).  "There is considerable nozzle clogging
with white ink"(P. 264)

Ink Supply Maint. - • JV/CJV/TS: Use this if a "Less Supply" error occurs. (Firmware
version 4.0 or later)

• UCJV: Use this if an ink supply error occurs in the white ink
path.

White Maintenance - Prevents ink sedimentation inside the ink routes.
• Use this when uneven color occurs for the white ink.

Orange Maintenance - Prevents ink sedimentation inside the ink routes.
• Use this when uneven color occurs for the orange ink.

*1. The default settings are shown underlined.

Registering Nozzle Recovery
Allows other nozzles to be used for printing if maintenance actions like nozzle washing fail to resolve ejection
failures (e.g., nozzle clogging or deflection).
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• Nozzle recovery can be specified for up to 20 nozzles per row. The time taken for printing
remains unchanged even when nozzle recovery is set.

• Load media at least 500 mm wide. You cannot print the entire pattern if media less than 500
mm wide is used.

1 Position the media.

2 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

3 Select [Nozzle Recovery] > [Print], then press the [ENTER] key.

• Print a nozzle recovery pattern.
• The Select Entry Nozzle screen appears once printing is complete.

100 0102030405060708090

H1-D   K

H1-C   Y

H1-B   C

H1-A   M

1

101

201

301

401

510 0

No.203

H1-A   M

Nozzle row number

Head number
Approx. 300 mm

Ap
pr

ox
. 3

30
 m

m

4 Select the "head number and nozzle row" for nozzle recovery, then press the [ENTER] key.

SELECT ENTRY NOZZLE

Head1-A >

>Head1-B

>Head1-C

>Head1-D

>><<

>Head1-E

Head number Nozzle row number

5 Enter the "nozzle number" for nozzle recovery, then press the [ENTER] key.

• Select the entry number before entering the nozzle number.
• Nozzle recovery is set.

Head2-D

No.1

No.2

16

128

No.3 184

No.4 OFF

No.5 OFF

>><<

Entry number 1 to 20 Nozzle number

6 Press the [ENTER] key once entry is complete.

• Select [Maintenance] > [Nozzle Recovery] > [Test Print], then select "ON" to perform
nozzle recovery and test printing.  "Test Printing"(P. 96)

6
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Nozzle Check
This is used to check for nozzle clogging before printing starts. Sets whether to perform maintenance
functions automatically if nozzle clogging is detected.

If ≥ the set value

[Printing Check]

ON

The nozzles are not checked.
OFF

Performs nozzle recovery automatically.

Nozzle check (nozzle clogging detection)

Continue Printing

If less than the set value

[Judgment Condition] setting for nozzle clogging
detection

[Nozzle Recovery] (cleaning followed by nozzle
checking)

* Repeated by [Retry Count] cycles.

[Judgment Condition] setting for nozzle clogging
detection

Stop Printing

If ≥ the set value

[Auto Nozzle Recovery]

ON
OFF

If less than the set value
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6.3 Function Setting Menu
This is used to set various operations to ensure optimal machine performance.

l Menu List
Item Setting*1 Details

Logical Seek Host/OFF/ON Sets the range of carriage movement.
• OFF: Machine size area

Unidirectional print Bi-directional print

Carriage movement

• ON: Print data area
Unidirectional printing Bi-directional printing

Print data
Carriage movement

Take-up Unit - Sets the take-up unit operation.

Take-up Unit ON/OFF Set to "OFF" if the take-up unit is not used.

Take-up SW Continuous/
Temporary

Sets the function performed by the ON/OFF button on the take-
up unit.  "Take-up unit"(P. 71)

• Continuous: Press the button to start/stop the take-up unit.
• Temporary: The take-up unit operates only while the button

is pressed. The unit stops when the button is released.

Drying Time
*JV/CJV/TS only

- Sets the time for ink to dry.

Scan Host/0.0 to 9.9
sec

Sets the stop time of the carriage after each scan.
• The MIMAKI RIP software (RasterLink) indicates this as

"Pause Time per Scan".

Print End Host/0 to 120
min

Sets the stop time after printing. The next data is printed once
the set time has elapsed.

• The Mimaki RIP software (RasterLink) does not allow the
user to specify Print End. If the machine is set to "HOST",
the time will be "0".

Power Setting - Sets the times to turn the power on and off automatically.

Auto Power-off 5 to 15 to 60
min

Sets the time until the power is automatically turned off.

Auto Power-on - Sets the time to automatically turn on the power.

Setup ON/OFF Sets whether to turn on or off the power.

Time 0:00 to 23:59 Sets the time to turn on the power.

6
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Item Setting*1 Details

Day Monday to
Sunday

Sets whether to turn on or off the power on each day of the
week.

Nozzle Check ON/OFF Automatically executes the nozzle check function when the
machine is started with auto power-on. Performs nozzle
recovery (cleaning followed by nozzle checking) if "nozzle
clogging" is detected.

Cleaning Soft/Normal/
Hard

Sets the cleaning type.

Retry Count 0 to 3 times Performs nozzle recovery (cleaning followed by nozzle
checking) for the specified number of times.

Top Blower
*JV/CJV/TS only

ON/OFF Sets the blowing fan operation during printing.

Strength AUTO/Low/
High

Sets the blowing fan wind strength.

Drying/Exhaust Fan - Set when the deodorizing fan unit (option) is used. 
"Deodorizing fan unit"(P. 311)

Stop Time OFF/10 to 120
min

Sets the time during which the deodorizing fan operates after
printing. After the set time passes, the fan stops.

ON/OFF ON/OFF Set to "ON" to operate the deodorizing fan when printing is not
performed.

Use PR Number Query
* CJV/UCJV only

ON/OFF Sets whether to display the screen for entering the number of
pinch rollers to be used after media width detection.

• ON: Displays the input screen.
• OFF: The "host" takes priority. Set this to "OFF" when

configuring pinch roller pressure settings on this machine.
 "Setting the Pressure and Number of Pinch Rollers to

Use"(P. 93)

WhiteSpace Setting - Sets the offset value from the media left and right standard
margins (15 mm).

• The left and right margins should be set to at least -5 mm
when using the media holder. This eliminates the risk of
printing on top of the media holder.

• The Mimaki RIP software (RasterLink) does not allow the
user to specify margins. If the machine is set to "Host", the
offset value will be "0 mm" for the left and right margins.

Margin -

Margin/Left Host/-10 to 85
mmMargin/Right

Space Btwn PP. None/10 to
500 mm

The space between prints can be eliminated for continuous
printing.

• Reducing the space length may cause media sagging,
resulting in discrepancies in the distance the media is fed.

• Depending on the data size and number of passes in the
feed direction, the margins may be wider than the set value.

Space Feed Mode Intermittent/
Continuous

Alters the feed method for blank space included in the image
data.

• Intermittent: Uses intermittent feeding based on the timing of
a fraction of the pass.

• Continuous: Feeds forward by skipping blank parts.

View Feed ON/OFF Sets whether or not to feed the media forward to view the print
results—for example, during test printing.

Feeding Before Cut ON/OFF Sets whether to feed media before cutting the media.
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Item Setting*1 Details

Illumination - Turns the light inside the printer on and off.

LightingUp Type Auto/Manual Sets whether to turn the light on or off during printing and when
the cover is opened.

LightingUp
Extention

None/1 to 5 to
10 min

Displayed when LightingUp Type is set to Auto. Sets the time
during which the light is turned on after printing.

Start Up Lighting ON/OFF Sets whether to turn the light on or off when the power supply
switch is turned on.

Auto Remote ON/OFF Sets whether to automatically switch to REMOTE mode and
start printing if data is received locally.

Finisher
*JV/CJV/(UCJV: option) only

None/XY
Slitter

Selects the unit connected. The settings are displayed for the
selected unit.

XY slitter - Sets the XY slitter adjustments and functions.  "Using the XY
Slitter"(P. 141)

Slit Position
Adjustment

- Adjusts the Y slit position.  "If the Y Slit Position is
Offset"(P. 177)

X position -5.0 to 5.0 Adjusts the X position of the Y slit.

Y position -5.0 to 5.0 Adjusts the Y position of the Y slit.

Slit Position
Detection

- Detects [Afterwards slitting mark].  "Detecting slitting
marks"(P. 167)

Slitting Feed - Displays the procedures from X cutter setting to slitting when
slitting afterwards.  "Mounting the X cutter and
slitting"(P. 170)

Ionizer ON/OFF Set when the ionizer (option) is used.  "Ionizer"(P. 305)
The machine prints while the ionizer removes static electricity
from media. The electrode probes are not on unless the
machine is printing.

*1. The default settings are shown underlined.

6
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6.4 Environment Setting Menu
This is used to set various operations to ensure optimal machine performance.

l Menu List
Item Setting*1 Details

LANGUAGE English / 日本
語 / Deutsch /
Português /

Español/
Italiano /
Korean

Sets the display language.

Time Set -20 to 0 to +4
h

Sets the current time and date. (With respect to JST)
• This can be set within the range of -20 to +4 hours.

Key Buzzer ON/OFF Sets an audible tone when keys are pressed.
• Audible signals indicating errors, warnings, and operation end

cannot be muted, even if "OFF" is selected for this setting.

Unit Setting - Set the display units.

Temp. °C/°F Sets the display unit for temperature (Celsius/Fahrenheit).

Length mm/inch Sets the display units for length and area.
• Some items are displayed in "mm" even if "inch" is selected.

Network - Sets the network address. The machine must be restarted to enable
this setting.

Check IP
Address

- Displays the machine's current IP address.
• It may take some time to determine the IP address. If the IP

address cannot be determined, the display will indicate "0.0.0.0".

Check MAC
Address

- Displays the machine's current MAC address.

DHCP ON/OFF Select "ON" to use the IP address assigned by the DHCP server.

AutoIP ON/OFF Select "ON" to use the IP address set by the AutoIP protocol. Note
that DHCP takes priority if DHCP is set to "ON".

Ip Address - Sets the IP address used by the machine.
• This can be set when both [DHCP] and [AutoIP] are disabled.

Default Gateway - Sets the default gateway used by the machine.
• This can be set when both [DHCP] and [AutoIP] are disabled.

DNS Address - Sets the DNS server address used by the machine.
• This can be set when both [DHCP] and [AutoIP] are disabled.

Sub Net Mask - Sets the subnet mask used by the machine.
• This can be set when both [DHCP] and [AutoIP] are disabled.

Remote Control - An application (MRA: Mimaki Remote Access) is required to use the
remote control function. MRA is a remote access tool installed on a
computer or smartphone that allows viewing of product information
and panel operation from a remote location away from the machine
(within the same network segment).

Setup Enable/
Disable

Enable/disable remote control.
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Item Setting*1 Details

PIN code 0000 to 9999 Enter the same PIN code as MRA. The PIN code is used for
authentication between the machine and MRA.

• When the machine is set to "0000", MRA can access the
machine with any PIN code.

KeyLife 5 to 30 to 120
min

Sets the time interval before disconnecting the machine and MRA if
no operations are performed using MRA.

Machine Reset - Initializes the details set.

*1. The default settings are shown underlined.

6
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6.5 Machine Status Menu
This is used to check machine information.

l Menu List
Item Details

Usage Roll Wiper
Remain

Displays the remaining amount of cloth wiper.
• To reset the remaining amount of cloth wiper, press the [FUNC2] key while

the amount is displayed.

Capping Use
Days

Displays the number of days since the cap was replaced.

Waste Ink
Tank

Displays the approximate level of waste ink in the waste ink tank as a
percentage.

• To reset waste ink levels, press the [FUNC1] key while the level is
displayed.

Print Length Displays the total length printed.

Print Area Displays the total area printed.

Use Time Displays the total time the power has been turned on.

UV Lamp
* UCJV only

Displays the total time the UV-LED lamp has been used.

Maintenan
ce History

Maintenance Displays a record of maintenance function execution (up to 10).
• Cleaning  P. 98, Wash Wiping  P. 98, Pump Tube Cleaning

 P. 212, Nozzle Washing  P. 263, Circulation

Replace
Wiper

Displays a record of cloth wiper replacement (up to 5).  P. 228

Ink
replacement

Displays a record of ink pack replacement for each ink slot (up to 5).
"Replacing Ink"(P. 48)

• Slot 1 to 8

Version Displays the machine firmware and other versions.

Error History Displays the error and warning history.
• These are listed in chronological order. Use the keys to cycle through

occurrence time/date and error/warning information.

List This is used to print machine information.
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6.6 Cutting Menu
This is for setting the various cutting function operations (CJV/UCJV only).

l Menu List
Item Setting*1 Details

Mark Detect - Enter the conditions of the printed register marks.

Detect ON/OFF Set this to ON to cut cutting data with register marks.

Form Type1/Type2/
Zero Margin

Select three types of register mark shapes.  "Register
Marks"(P. 130)

Size 5 to 10 to 40
mm

Set the register mark length (B).  "Standards for Register Mark
Length and Line Width"(P. 131)

Line width

Register mark length (B)

Offset X -5.00 to 5.00
mm

Change the position of the register mark origin. If the cut position
shifts in the same direction, change the position of the origin.

• If "ERROR C37 Mark Org" is displayed, change the layout by
referring to the following.  "Reading Range of Register
Marks"(P. 133)

Offset Y -5.00 to 5.00
mm

Detect End Key
Start

ON/OFF If you press the [END] key on the LOCAL mode screen, the cutter
unit moves over the platen so that register marks can be detected.

Sensor sensitivity 1 to 7 Check the sensitivity of the register mark sensor. Normally, set this
to "4".

• If it cannot detect the register marks: Increase sensitivity.
• If it mis-detects the register marks: Decrease sensitivity.

Mark FillUp ON/OFF When the "Fill around the registration marks" function of the RIP
software is enabled, set this to "ON".

Detect Area - Sets the automatic register mark detection area.

Automatic registration mark detection path Start position

Scan direction
End position of the
immediately previous data

Feed direction

X offset

Scan Dir. Default/0 cm
to machine

width

Sets the scan direction for automatic register mark detection.
• When set to [DEFAULT], the detection operation is performed at

half the media width.

Feed Dir. 10 to 50 cm Sets the media feed direction for automatic register mark detection.

Offset X 0 to 100 cm Sets the automatic detection start position for the next register mark.

6



Chapter 6 Setup

196

Item Setting*1 Details

Cut Mode Normal/
HighSpd/
Quality

Sets the cutting quality.
• Normal: Normally, use this setting.
• HighSpd: This cuts media in a short period of time. This is not

suitable for use with heavy media.
• Quality: This puts priority on the cutting quality, and limits the

cutting speed to 20 cm/s. Select "Quality" when cutting the
following data.

– Text not larger than 10 mm
– Data with many acute angles
– Intricate data (However, cut lines may be jagged depending on the

data. If this occurs, change the setting to "HighSpd" to make cut
lines smoother.)

Copy - Cut the data stored in the receive buffer of the machine by the
specified number.  "Copying the Last Data"(P. 197)

No. Copies 1 to 999 Enter the number of copies.

Interval 0 to 30 mm Select the cut data interval.

Tool Change - Select this when replacing tools.  "Installing Cutting
Tools"(P. 114)

Setup Sub Menu - Useful functions when cutting.

Division Cut - Allows data larger than the sheet width to be divided before cutting.

Division Cut OFF/X/Y Sets the direction for division cutting.
• Y: Carriage scan direction
• X: Media feed direction. Helps reduce offsets due to media that

meanders. Division cutting is performed if the division cut + cross
cut is exceeded.

Division Cut 50 to 500 cm Division cutting is performed if this setting is exceeded.

Cross Cut 0 to 50 mm Set the length for overlap cutting.

Frame Cut OFF/ON Sets whether or not to automatically cut a frame to match the cut
data.

Mark Cut OFF/ON Sets whether or not to add marks for use as guides when pasting
together division-cut media.

Up Speed - Set the movement speed of the media and carriage while the tool is
up.

Up Speed X AUTO/5 to 30
cm/s

Sets the media feed speed.
Setting a slower speed can reduce media offsets.

Up Speed Y AUTO/5 to 30 Sets the carriage scan speed.

Dummy cut ON/OFF Cuts the media to make the cutting blade face a certain direction
after media detection or tool changes. (Performs a dummy cut in
front of the pinch rollers which are closest to both ends of the cutter
unit.)

Pinch roller

Dummy cut
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Item Setting*1 Details

If you wish to avoid damage to the media or cut cut-out characters,
set this to OFF. Perform test cutting to adjust the direction of the
cutting blade.  "Test Cutting"(P. 123)
If the tool condition is set to "PEN", dummy cutting is disabled.

Sheet Type Standard/
Heavy

Set the weight of the set media.

Adj-prs Offset -9 to 0 to 9 When cutting the corners, the pressure is automatically decreased
(by about 5 g) to prevent the media from lifting up. As a result, the
cutting blade might not rotate smoothly and may leave uncut parts.
Adjust the pressure for cutting the corners if they are left uncut.

Vacuum Fan Weak/
Standard/

Strong/OFF

Sets the force with which the medium is held down during cutting.
Ordinarily, use "Weak".

Over Cut OFF/0.1 to
1.0 mm

Overlaps the start and end points so that no part of the media is left
uncut.  "Preventing Uncut Media"(P. 199)

Corner Cut ON/OFF Performs over cutting at corners other than the start and end point.
 "Preventing Uncut Media"(P. 199)

Curve Mode Fast/Slow If the cut line becomes twisted, set this to "Slow". This can prevent
twisting but decreases cutting speed.

Setup Reset - Initializes the details set.

Maintenance -

Marks Sensor -

Sensor Check - Check the responsiveness of the register mark sensor. 
"Adjusting the Position of the Register Mark Sensor"(P. 273)

Pointer Offset - Adjust the position of the light pointer when the positions of the
register mark sensor and light pointer do not match.  "Correcting
the LED Pointer Position"(P. 274)

Sample Cut - Use a sample stored in the unit for cutting to troubleshoot problems
when data cannot be cut properly.  "Investigating the Cause of
Cutting Failures"(P. 275)

Auto Media Cut - Cuts the specified number of media sheets at the specified length.

Cut Interval 10 to 10,000
mm

Sets the cut length.

Front Cut Off 0 to 500 mm The front edge of the media can be cut off if cut diagonally. Sets the
cut length.

Count 1 to 9,999
times

Sets the number of media pieces to be cut.

Scale Adjust - When printing and cutting without register marks, perform
corrections when the media deviates to the left or right side of the
scan direction.

*1. The default settings are shown underlined.

Copying the Last Data
You can cut the data stored in the receive buffer of the machine by the specified number (up to 999 sheets).

6
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• The last cutting data is stored in the receive buffer. When new data is received, the already saved data is
overwritten.

• Reset the origin before executing the copy function. Failure to do so will result in overlap cutting.

Copy end origin

Copy start origin (set manually)

Last cut data
(stored in the receive buffer)

Copy interval

Copy interval

• The machine cuts the specified number of sheets of the divided cut data without separating the
data.

• With the following data, only one sheet can be cut, regardless of the number of copies specified.
(1) Data received from MIMAKI RIP software (RasterLink).
(2) Data for which "Sheet Feed Origin Renewal" has been selected in the MIMAKI cutting

software (FineCut).

• When sending the cut data from the PC, wait for at least 5 seconds before sending the next
data. If the next data is sent within 5 seconds, both pieces of data may be copied.
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Preventing Uncut Media
Overlapping the start and end points can prevent the media from being left uncut. Configure this setting for
very flexible media.
If the setting is too large, the print may also be cut. Alter the setting while checking using a test cut.  "Test
Cutting"(P. 123)

l Over Cut
The machine cuts the media in front of the cutting start point by the set value. The media is overcut by the
set value at the end point.

Over Cut: OFF Over Cut: 0.1 to 1.0 mm

l Corner Cut
When the Over Cut setting value is entered, Corner Cut is displayed. The machine performs over cutting at
corners other than the start and end point.

Corner Cut: OFF Corner Cut: ON

6
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Chapter 7 Maintenance

This chapter
To ensure years of precise performance, maintain the machine periodically based on
frequency of use. 
Read the maintenance precautions thoroughly before maintaining this product.
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7.1 Maintenance Precautions
• This machine includes parts that must be replaced periodically. We therefore recommend taking

out a maintenance contract. Carry out maintenance periodically and replace consumable items
to prevent quality defects and accidents.

• Clean periodically. Debris and dust will accumulate on electrical components when the machine
is used for extended periods. There is a risk of failure, electric shock, or fire due to current
leakage.

• Do not clean by blowing—e.g., avoid using air blowers. Doing so may lead to failure, electric
shock, or fire involving the machine if airborne debris or dust gets inside electrical components.
Wipe using a soft cloth soaked in diluted neutral detergent and thoroughly wrung out. A vacuum
cleaner may also be used for cleaning.

• Be careful to prevent liquids from getting inside the machine. Otherwise there is a risk of failure,
electric shock, or fire.

• The UV-LED unit becomes extremely hot. Be careful not to touch the LED after it has been
turned off until it has sufficiently cooled.

• For heavy soiling, wipe using a soft cloth soaked in diluted neutral detergent and thoroughly
wrung out.

• Pay close attention to ventilation and be sure to wear safety glasses, gloves, and a mask when
handling ink, maintenance liquid, waste ink, or other solutions used with the machine. Leaking
ink may adhere to the skin or get into the eyes or mouth.

• Never touch the print head nozzle surface. Do not allow water or alcohol to come into contact
with the print nozzle surface. This will increase the risk of machine failure or ejection failures
(e.g., nozzle clogging or deflection).

• Do not use cotton swabs to clean around the head or carriage. Fibers from cotton swabs may
adhere to the head nozzle surface and lead to ejection failures (e.g., nozzle clogging or
deflection).

• Do not splash ink or maintenance liquid on the covers. Exposure to splashing ink or
maintenance liquid may damage or deform the cover.

• Do not use benzine, thinner, or any chemical agent containing abrasives. Use of these
chemicals may result in damage to or deformation of parts.

• Do not use organic solvents such as acetone and IPA. Doing so may damage the machine.
• Do not move the carriage by hand. To move the carriage, use the carriage out function on the

menu.
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7.2 Maintenance Methods

Maintenance Items and Timing

l JV/CJV/TS
Timing Item

Every three days, at the
start of the work

Shake the ink.  "Ink Maintenance"(P. 205)

At the start of the
week's work

Maintain the white ink.  "White ink maintenance"(P. 206)

At the end of the week's
work

Clean the cap rubber.  "Cap Rubber Cleaning"(P. 206)

Clean the underside of the carriage.  "Carriage Underside Cleaning"(P. 207)

Check the waste ink levels in the waste ink tank.  "When "Check Waste Ink
Tank" message appears"(P. 251)

At the end of two
weeks' work
* TS only

Clean the blowing fan filter.  "Blowing Fan Filter Cleaning"(P. 220)

Every month Clean around the cloth wiper.  "Cloth Wiper Area Cleaning"(P. 208)

Clean the NCU.  "NCU Cleaning"(P. 209)

Clean the DAS sensor.  "DAS (Automatic Correction Function) Sensor
Cleaning"(P. 211)

Clean the ink discharge channel.  "Ink Discharge Channel Cleaning"(P. 212)

Clean the media sensor.  "Media Sensor Cleaning"(P. 214)

Clean the media cutter.  "Media Cutter Cleaning"(P. 215)

Clean the media holder.  "Media Holder Cleaning"(P. 216)

Clean the jam sensor detecting plate.  "Jam Sensor Detecting Plate
Cleaning"(P. 217)

Clean the platen.  "Platen Cleaning"(P. 218)

Clean the cover (exterior).  "Cover (Exterior) Cleaning"(P. 218)

When not used for
more than a week

Clean the cap and wash the ink discharge channels. After cleaning, store without
turning off the main power supply.  "When this Printer is Left Unused for a
Long Time"(P. 222)

7
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l UCJV
Timing Item

Periodically Shake the ink.  "Ink Maintenance"(P. 205)

At the start of the
week's work

Maintain the white ink.  "White ink maintenance"(P. 206)

At the end of the week's
work

Clean the cap rubber.  "Cap Rubber Cleaning"(P. 206)

Clean the underside of the carriage.  "Carriage Underside Cleaning"(P. 207)

Clean the underside of the UV-LED unit.  "Carriage Underside
Cleaning"(P. 207)

Check the waste ink levels in the waste ink tank.  "When "Check Waste Ink
Tank" message appears"(P. 251)

Every month Clean around the cloth wiper.  "Cloth Wiper Area Cleaning"(P. 208)

Clean the NCU.  "NCU Cleaning"(P. 209)

Clean the DAS sensor.  "DAS (Automatic Correction Function) Sensor
Cleaning"(P. 211)

Clean the ink discharge channel.  "Ink Discharge Channel Cleaning"(P. 212)

Clean the media sensor.  "Media Sensor Cleaning"(P. 214)

Clean the media cutter.  "Media Cutter Cleaning"(P. 215)

Clean the media holder.  "Media Holder Cleaning"(P. 216)

Clean the jam sensor detecting plate.  "Jam Sensor Detecting Plate
Cleaning"(P. 217)

Clean the platen.  "Platen Cleaning"(P. 218)

Clean the cover (exterior).  "Cover (Exterior) Cleaning"(P. 218)

Clean the mist filter. 
Soak up ink with a paper towel.  "Cleaning the Mist Filter"(P. 219)

When not used for
more than a week

Clean the cap and wash the ink discharge channels. After cleaning, store without
turning off the main power supply.  "When this Printer is Left Unused for a
Long Time"(P. 222)

Items Required for Maintenance
To order replacement consumable items, contact your local dealer or our service office. For more information
on consumable items, refer to our website (https://mimaki.com/supply/inkjet.html).

• Do not store consumable items in locations where children may enter.

https://mimaki.com/supply/inkjet.html
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Ink Maintenance
If ink constituents are sedimented, the ink density may become uneven. We recommend shaking the ink
periodically to keep printing consistent.

l JV/CJV/TS

CJV TSJV
• White/orange ink: Around once a day.
• Other colors: Around once every three days.

• Counts the time elapsed after stirring the white/orange ink. The "Shake the White (Orange) Ink
Pack" message appears on the display when the preset count is reached. If this message
appears, shake the white (or orange) ink according to the instructions below. 
Timing when the message appears: Every 24 hours (or when the power is turned on if the
power was turned off).

• Shake taking care that the ink eco-cases do not become detached from the ink supply unit.
Ink may leak out if the ink eco-cases become detached.

1 Shake the ink eco-cases slowly approximately 10 times.

• Shake the ink eco-cases back and forth while holding the top.

• Be sure to shake the ink eco-case back and forth by holding its top. Ink may leak out if the
top is not held and the ink eco-cases become detached.

l UCJV

UCJV
UV ink: once a month.
UV white ink: once a day.

• The UCJV counts the time elapsed after the white ink was stirred. The "Shake White Ink Bottle"
message appears when a preset count is reached. If the message appears, shake the white ink
by following the instructions below: 
Timing when the message appears: Every 24 hours (or when the power is turned on if the
power was turned off). 7
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1 Shake the ink bottle to the left and right slowly at least 20 times.

• Tighten the ink bottle lid securely, then shake the bottle slowly from left to right to ensure that the
ink moves inside, holding the ink bottle lid with a piece of recommended non-woven fabric.

Repeat

• Shake slowly. If the bottle is shaken too violently, ink may leak out or the air mixed in the
ink may cause nozzle clogging.

• If the ink bottle is partially used, tilt it slowly until the ink bottle is upright.

White ink maintenance

CJV UCJVJV
White ink constituents are more easily sedimented than other ink colors. If ink constituents are sedimented,
the ink density may become uneven. Perform maintenance once a week as follows before using the
machine.

1 Shake the white ink eco-case or bottle.

•  "Ink Maintenance"(P. 205)

2 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

3 Select [White Maintenance], then press the [ENTER] key.

4 Press the [ENTER] key.

• Discharging/filling/cleaning starts automatically.
• The elapsed time is displayed.

Cap Rubber Cleaning
The cap prevents the print head nozzle surface from drying out. Continuing to use a dirty cap may affect ink
take-up and lead to ejection failures (such as nozzle clogging or deflection).

• Be careful to avoid leaving fragments from the cleaning stick behind when cleaning. These
fragments will increase the risk of ejection failures (e.g., nozzle clogging or deflection).

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Platen Right End], then press the [ENTER]
key.
• The carriage moves over the platen.
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3 Open the maintenance cover on the right side.

4 Clean the cap rubber.

• Wipe off any ink and dust adhering using a cleaning stick moistened with maintenance liquid. Wipe
off the maintenance liquid. Make sure none remains.

• Clean the areas indicated in red in the diagram (the entire interior and exterior of the cap rubber,
the tabs, and the mesh retainers).

5 Close the maintenance cover, then press the [ENTER] key.

Carriage Underside Cleaning
The underside of the carriage becomes coated with ink wiped off by the wiper. Continuing to use the dirty
carriage underside will rub dried ink and attached dust on to the media, resulting in contaminated prints.
The print head uses an extremely delicate mechanism. Take great care when handling it.

• Be careful to avoid leaving fragments from the cleaning stick behind when cleaning. These
fragments will increase the risk of ejection failures (e.g., nozzle clogging or deflection).

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Maint. Space], then press the [ENTER] key.

• The carriage moves to the maintenance space.

3 Open the maintenance cover on the left side.

7
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4 (UCJV only)Clean the UV-LED lamp glass surface.

• Wipe off any adhering ink using a cleaning stick moistened with maintenance liquid. Wipe off the
maintenance liquid. Make sure none remains.

5 Clean around the print head.

• Wipe off any ink and dust adhering using a cleaning stick moistened with maintenance liquid. Wipe
off the maintenance liquid. Make sure none remains.

Never touch the
nozzles!

Clean the print head sides and all around the nozzle plate using a cleaning stick.

Clean using a cleaning stick or soft cloth.

• Never touch the print head nozzles (areas indicated in blue in the diagram).

6 Once cleaning is complete, close the cover, then press the [ENTER] key.

Cloth Wiper Area Cleaning
Continuing to use while dirty will cause dried ink and attached dust around the wiper to rub against the head
nozzle surface, and lead to ejection failures (e.g., nozzle clogging or deflection).

• Be careful to avoid leaving fragments from the cleaning stick behind when cleaning. These
fragments will increase the risk of ejection failures (e.g., nozzle clogging or deflection).

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Platen Right End], then press the [ENTER]
key.
• The carriage moves over the platen.

3 Open the maintenance cover on the right side.
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4 Clean the wiper unit cover.

• Wipe off any ink and dust adhering using a cleaning stick moistened with maintenance liquid. Wipe
off the maintenance liquid. Make sure none remains.

• Be careful to avoid splashing maintenance liquid on the cloth wiper.

5 Once cleaning is complete, close the cover, then press the [ENTER] key.

NCU Cleaning
The NCU uses a sensor to monitor the ink droplets ejected from the print head nozzles. Continuing to use
the dirty NCU may prevent the nozzle check function from operating correctly.

• Be careful to avoid leaving fragments from the cleaning stick behind when cleaning. These
fragments will increase the risk of ejection failures (e.g., nozzle clogging or deflection).

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Platen Right End], then press the [ENTER]
key.
• The carriage moves over the platen.

3 Open the maintenance cover on the right side.

4 Clean the NCU.

• Wipe off any ink and dust adhering using a cleaning stick moistened with maintenance liquid. Wipe
off the maintenance liquid. Make sure none remains.

7
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• Insert the cleaning stick as far as the line shown in the illustration.

5 Once cleaning is complete, close the cover, then press the [ENTER] key.
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DAS (Automatic Correction Function) Sensor Cleaning
The DAS sensor is located on the carriage underside. If dust or debris accumulates on the sensor, DAS
(  P. 180) may not function.

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Maint. Space], then press the [ENTER] key.

• The carriage moves to the maintenance space.

3 Open the maintenance cover on the left side.

4 Clean the DAS sensor.

• Wipe clean using cotton swabs or a soft cloth.

• For heavy soiling, wipe using a soft cloth soaked in diluted neutral detergent and
thoroughly wrung out.

5 Once cleaning is complete, close the cover, then press the [ENTER] key.

7
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Ink Discharge Channel Cleaning
Clean the ink discharge channel regularly to prevent clogging of the ink discharge channel below the cap.

l JV/CJV/TS

CJV TSJV

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Pump tube cleaning], then press the [ENTER] key.

• The cap is filled with maintenance liquid.

• Close the cover. The cap cannot be filled with maintenance liquid while the cover is open.
This is also true if the maintenance liquid cartridge is empty.

3 Open the maintenance cover on the right side.

• Check to confirm that approximately half a capful of maintenance liquid remains.

• If not, use a syringe to draw up some maintenance liquid and drip in approximately half a
capful.

4 Close the maintenance cover, then press the [ENTER] key.

• Pump tube (ink discharge channel below the cap) washing starts.

l UCJV

UCJV

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Pump tube cleaning], then press the [ENTER] key.

• The carriage moves over the platen.
• "Fill the Liquid. Exit Next [ENT]" appears on the display.

3 Open the maintenance cover on the right side.
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4 Check to confirm that approximately half a capful of maintenance liquid remains.

• Use a syringe to draw up some maintenance liquid and drip in approximately half a capful.

5 Close the maintenance cover, then press the [ENTER] key.

• Pump tube (ink discharge channel below the cap) washing starts.

7
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Media Sensor Cleaning
Media sensors are located on the rear cover and carriage underside. The media cannot be detected
correctly if dust or debris accumulates on the sensors. Remove any debris using cotton swabs or a soft cloth.

Rear of product

Carriage underside

l Cleaning the carriage underside sensor

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Maint. Space], then press the [ENTER] key.

• The carriage moves to the maintenance space.

3 Open the maintenance cover on the left side.

4 Clean the media sensor.

5 Once cleaning is complete, close the cover, then press the [ENTER] key.
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Media Cutter Cleaning
Continuing to use a dirty media cutter may cause dust to collect on the head nozzle surface or the cutter
blade to grow dull.

• Avoid touching the cutter blade. Failure to do so may result in injury.

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Platen Right End], then press the [ENTER]
key.
• The carriage moves over the platen.

3 Open the front cover.

• The carriage can be moved by hand. Move the carriage slowly to a position allowing easy
access while working.

4 Remove the media cutter.

Screw

5 Clean both sides of the media cutter.

• Wipe off any adhesive paste, ink and dust adhering using a cleaning stick moistened with
industrial alcohol. Wipe off any industrial alcohol so that none remains.

6 Return the media cutter to its original position.

• Tighten the screw securely. A loose screw may cause cutter or platen damage.

7
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7 Check the position of the media cutter.

• Lift up the media cutter by hand if it has dropped down.

Good example Bad example

8 Once cleaning is complete, close the cover, then press the [ENTER] key.

Media Holder Cleaning
Continuing to use the dirty platen will prevent proper feeding of the media. It will also cause dried ink and
attached dust to rub against the head nozzle surface and lead to ejection failures (e.g., nozzle clogging or
deflection).

Media holder

• Turn off the main power supply and unplug the power cable before carrying out maintenance.

• Be careful to prevent liquids from getting inside the machine. Otherwise there is a risk of failure,
electric shock, or fire.

• For heavy soiling, wipe using a soft cloth soaked in diluted neutral detergent and thoroughly
wrung out.
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Jam Sensor Detecting Plate Cleaning
Continuing to use the dirty carriage underside will rub dried ink and attached dust on to the media, resulting
in contaminated prints.

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Maint. Space], then press the [ENTER] key.

• The carriage moves to the maintenance space.

3 Open the maintenance cover on the left side.

4 Clean the jam sensor detecting plate.

• Clean the jam sensor detecting plate underside at the left and right sides of the carriage.
• Wipe off any ink and dust adhering using a cleaning stick moistened with maintenance liquid. Wipe

off the maintenance liquid. Make sure none remains.

5 Once cleaning is complete, close the cover, then press the [ENTER] key.

7
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Platen Cleaning
Continuing to use the dirty platen will prevent proper feeding of the media. It will also cause dried ink and
attached dust to rub against the head nozzle surface and lead to ejection failures (e.g., nozzle clogging or
deflection).

• Turn off the main power supply and unplug the power cable before carrying out maintenance.

• Be careful to prevent liquids from getting inside the machine. Otherwise there is a risk of failure,
electric shock, or fire.

• The grooves in which the media holder slides and the media is cut are susceptible to dust
accumulation. Remove any debris carefully.

• For heavy soiling, wipe using a soft cloth soaked in diluted neutral detergent and thoroughly
wrung out.

Cover (Exterior) Cleaning

• Be careful to prevent liquids from getting inside the machine. Otherwise there is a risk of failure,
electric shock, or fire.

• For heavy soiling, wipe using a soft cloth soaked in diluted neutral detergent and thoroughly
wrung out.
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Cleaning the Mist Filter

UCJV

• The description here applies to the UCJV.

The mist filter absorbs the mist generated when ink droplets are discharged from the print head. Continuing
to use it when it is dirty will result in contaminated prints.

Mist filter 1

Mist filter 2

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Maint. Space], then press the [ENTER] key.

• The carriage moves to the maintenance space.

3 Open the maintenance cover on the left side.

7
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4 Remove the mist filter.

• To remove the mist filter, pull the knob to the front while pushing the tab in the direction indicated
by the arrow.

Tab

Handle

Handle

5 Clean the filter.

• Remove the filter and press down on it with a paper towel to remove dirt.
• Wipe off the dirt adhering to the filter case.

• Replace the mist filter if it gets very dirty—for example, due to liquefaction of ink adhering
to the filter.

 "Mist Filter Replacement"(P. 254)

6 Reinstall the mist filter in its original position.

7 Once cleaning is complete, close the cover, then press the [ENTER] key.

Blowing Fan Filter Cleaning

TS

• The description here applies to the TS.

Wash the blowing fan filter in water if it is dirty.

l Recommended cleaning guide

• Check the filter for dirt every two weeks, and wash.
• Replace the filter every three months.  "Blowing Fan Filter Replacement"(P. 239)

• Turn off the main power and unplug the power cable before replacement.
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1 Remove the fan filter cover.

• Push the fan filter cover claw outward, and pull the cover to the front.

Fan filter cover

Claw

2 Remove the filter.

Blowing fan filter

3 Wash the filter.

• Dry the filter after washing.

4 Attach the dry filter together with the fan filter cover.

• Push in the fan filter cover until the tab clicks.

7
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When this Printer is Left Unused for a Long Time
Clean as follows if the product is not used for one week or longer:

Check beforehand

Is [Near End] or [Ink End] displayed?
• Maintenance liquid and ink is aspirated during the washing operation. Washing is not possible if an

error occurs during this process. Replace with new ink.

• Do not turn off the main power supply. Turning off the main power supply will disable the
automatic maintenance function (including nozzle clogging prevention function and ink
discharge channel cleaning function). This increases the risk of ejection failures (such as nozzle
clogging or deflection).

• Do not leave media loaded on the platen. This may leave irregularities or ripples in the media.

When the machine is not in use, raise the clamp lever to separate the pinch rollers from the grit
rollers.

• Leaving the pinch rollers lowered may cause them to become deformed and prevent media from
being fed correctly.

• Leaving media loaded will subject it to force from the pinch rollers, which may leave pinch roller
marks on it.

• Perform the following if the "Check Waste Ink Tank" message appears on the display.
 "Waste Ink Tank Replacement"(P. 251)

JV/CJV/TS

CJV TSJV

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Custody Wash], then press the [ENTER] key.

• The carriage moves over the platen.

3 Open the maintenance cover on the right side.

4 Clean the cap rubber.

•  "Cap Rubber Cleaning"(P. 206)

5 Once cleaning is complete, close the cover, then press the [ENTER] key.

• The cap is filled with maintenance liquid.

• Close the cover. The cap cannot be filled with maintenance liquid while the cover is open.
This is also true if the maintenance liquid cartridge is empty.
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6 Open the maintenance cover on the right side.

• Check to confirm that the cap is filled with maintenance liquid.

• If not, use a syringe to draw up some maintenance liquid and fill until it almost overflows
from the cap.

7 Close the maintenance covers.

8 Set the exposure time, then press the [ENTER] key.

• Cleaning is performed automatically once print nozzle washing has ended.
• The cap is filled with maintenance liquid.

9 Open the maintenance cover on the right side.

• Check to confirm that the cap is filled with maintenance liquid.

• If not, use a syringe to draw up some maintenance liquid and fill until it almost overflows
from the cap.

10 Close the maintenance cover, then press the [ENTER] key.

• Pump tube (ink discharge channel below the cap) washing starts.

7
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UCJV

UCJV

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Custody Wash], then press the [ENTER] key.

• The carriage moves over the platen.

3 Open the maintenance cover on the right side.

4 Clean the cap rubber.

•  "Cap Rubber Cleaning"(P. 206)

5 Once cleaning is complete, close the cover, then press the [ENTER] key.

• "Fill the Liquid. Exit Next [ENT]" appears on the display.

6 Fill the cap with maintenance liquid.

• Use a syringe to draw up some maintenance liquid and fill until it almost overflows from the cap.

7 Close the maintenance cover, then press the [ENTER] key.

8 Set the exposure time, then press the [ENTER] key.

• Cleaning is performed automatically once print nozzle washing has ended.
• "Fill the Liquid. Exit Next [ENT]" appears on the display.

9 Open the maintenance cover on the right side.

10 Fill the cap with maintenance liquid.

• Use a syringe to draw up some maintenance liquid and fill until it almost overflows from the cap.
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11 Close the maintenance cover, then press the [ENTER] key.

• Pump tube (ink discharge channel below the cap) washing starts.

7
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7.3 Replacement of Consumable Item
To order replacement consumable items, contact your local dealer or our service office. For more information
on consumable items, refer to our website (https://mimaki.com/supply/inkjet.html).

• Do not store consumable items in locations where children may enter.

• When disposing of consumable items, contact an industrial waste disposal operator or dispose
of the product in accordance with the local laws and regulations.

Consumable Item Replacement Timing

l JV
Timing Item

When run out  "Cloth Wiper Replacement"(P. 228)

When dirty  "Replacing the Absorber Around the Station"(P. 234)
 "Exhaust Fan Filter Replacement"(P. 238)
 "Blowing Fan Filter Replacement"(P. 239)

When ejection failures cannot be
remedied

 "Cap Replacement"(P. 232)

When damaged  "Cap Replacement"(P. 232)
 "Pinch Roller Replacement"(P. 240)
 "Media Holder Replacement"(P. 241)
 "Media Cutter Replacement"(P. 243)
 "Y Cutter Replacement (XY Slitter)"(P. 245)
 "X Cutter Replacement (XY Slitter)"(P. 246)
 "Media Edge Guide Film Replacement"(P. 248) (option)

When replacing ink  "Ink Supply Unit Ink Absorber Replacement"(P. 249)

When "Check Waste Ink Tank"
appears on the display

 "Waste Ink Tank Replacement"(P. 251)

l CJV
Timing Item

When run out  "Cloth Wiper Replacement"(P. 228)

When dirty  "Replacing the Absorber Around the Station"(P. 234)
 "Exhaust Fan Filter Replacement"(P. 238)
 "Blowing Fan Filter Replacement"(P. 239)

When ejection failures cannot be
remedied

 "Cap Replacement"(P. 232)

When damaged  "Cap Replacement"(P. 232)
 "Pinch Roller Replacement"(P. 240)
 "Media Holder Replacement"(P. 241)
 "Media Cutter Replacement"(P. 243)
 "Y Cutter Replacement (XY Slitter)"(P. 245)
 "X Cutter Replacement (XY Slitter)"(P. 246)
 "Media Edge Guide Film Replacement"(P. 248) (option)
 "Cutter for Cutting Machine"(P. 257)

https://mimaki.com/supply/inkjet.html
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Timing Item

 "Pen Line Replacement"(P. 257)

When replacing ink  "Ink Supply Unit Ink Absorber Replacement"(P. 249)

When "Check Waste Ink Tank"
appears on the display

 "Waste Ink Tank Replacement"(P. 251)

l TS
Timing Item

When run out  "Cloth Wiper Replacement"(P. 228)

When dirty  "Replacing the Absorber Around the Station"(P. 234)
 "Exhaust Fan Filter Replacement"(P. 238)
 "Blowing Fan Filter Replacement"(P. 239)

When ejection failures cannot be
remedied

 "Cap Replacement"(P. 232)

When damaged  "Cap Replacement"(P. 232)
 "Pinch Roller Replacement"(P. 240)
 "Media Holder Replacement"(P. 241)
 "Media Cutter Replacement"(P. 243)
 "Media Edge Guide Film Replacement"(P. 248)

When replacing ink  "Ink Supply Unit Ink Absorber Replacement"(P. 249)

When "Check Waste Ink Tank"
appears on the display

 "Waste Ink Tank Replacement"(P. 251)

l UCJV
Timing Item

When run out  "Cloth Wiper Replacement"(P. 228)

When dirty  "Replacing the Absorber Around the Station"(P. 234)
 "Exhaust Fan Filter Replacement"(P. 238)
 "Mist Filter Replacement"(P. 254)
 "UV-LED Glass Replacement"(P. 255)

When ejection failures cannot be
remedied

 "Cap Replacement"(P. 232)

When damaged  "Cap Replacement"(P. 232)
 "Pinch Roller Replacement"(P. 240)
 "Media Holder Replacement"(P. 241)
 "Media Cutter Replacement"(P. 243)
 "Y Cutter Replacement (XY Slitter)"(P. 245) (option)
 "X Cutter Replacement (XY Slitter)"(P. 246) (option)
 "Media Edge Guide Film Replacement"(P. 248) (option)
 "Cutter for Cutting Machine"(P. 257)
 "Pen Line Replacement"(P. 257)

When "Check Waste Ink Tank"
appears on the display

 "Waste Ink Tank Replacement"(P. 251)

Periodically  "Ink Bottle Cap Replacement"(P. 258)

7
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Cloth Wiper Replacement
Replace cloth wipers with new ones when they have run out.

• The cloth wipers to use depend on the model. Using inappropriate cloth wipers may damage
the print head.

Model JV/CJV/UCJV TS (Sb ink)

Code/
Package

type 

SPC-0919/Aluminum pack SPC-0905/Plastic bag

TS (TP ink)

SPC-0932/Aluminum pack

32

Seal (red) Seal (blue)

SPC-0919 and SPC-0932 cloth wipers
• Precautions are included with the cloth wipers. Thoroughly read them and make sure you

understand the contents.
• When disposing of cloth wipers, be sure to place them in a sealed bag. Contact an industrial

waste disposal operator or dispose of in accordance with the local laws and regulations.
• When handling cloth wipers, ensure adequate ventilation and take care not to inhale the solvent

fumes.

• When handling SPC-0919 or SPC-0932 cloth wipers, be sure to wear safety glasses, gloves,
and a mask. There is a risk of the liquid (solvent) contained in cloth wipers splashing and
contacting your skin, eyes, or mouth.

1 "Wiper End" appears on the display.

2 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

3 Select [Station Maint.] > [Replace Wiper], then press the [ENTER] key.

• The carriage moves over the platen.

4 Open the maintenance cover on the right side.
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5 Open the cloth wiper cover.

• Push the two tabs at the front up to open.

6 Remove the wiper together with the spindle.

7 Remove the wiper from the spindle.

• When disposing of ink, maintenance liquid or other liquid used with the product, or
containers or non-woven fabric contaminated with ink or other liquid, contact an industrial
waste disposal operator or dispose of the product in accordance with the local laws and
regulations.

8 Clean the wiper unit underside.

• Wipe off any ink and dust adhering using a cleaning stick moistened with maintenance liquid. Wipe
off the maintenance liquid. Make sure none remains.

7
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9 Clean the wipe roller.

• Wipe off any ink and dust adhering using a cleaning stick moistened with maintenance liquid. Wipe
off the maintenance liquid. Make sure none remains.

10 Clean the pinch rollers.

• Gently wipe off any dust adhering with a soft cloth.

• Do not wipe too hard. Wiping too hard may degrade the sponge.
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11 Mount a new cloth wiper.

(1) Remove the cloth wiper from the bag.
(2) Unroll the side with more cloth on it.

Wound approximately three times

[When removed from bag] [When mounted in the wiper unit]

Unwind

Do not unwind!

(3) Mount a new cloth wiper.
• Mount the cloth wiper with the gear on the left.

• If no cloth is wound around the spindle, wind the cloth around the spindle three times
before mounting. If the cloth is mounted with no cloth wound around the spindle, the cloth
may become detached from the wiper unit.

[Bad example]

No cloth wound

12 Close the cloth wiper cover.

13 Close the maintenance cover, then press the [ENTER] key.

• The remaining amount of cloth wiper is reset. 7
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Cap Replacement
If ejection failures (e.g., nozzle clogging or deflection) remain unresolved even after cleaning, replace with a
new cap.

• Be sure to replace the cap if you observe any scratches or other damage on the rim.

• When using Sb or TP ink for extended periods, the cap surface is susceptible to drying out,
which can lead to path clogging. If this occurs, either replace the cap or remove and wash it.

• We recommend replacing the cap every six to twelve months. 
(TP ink: every six months, other ink: every twelve months)

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Replace Cap], then press the [ENTER] key.

• The carriage moves over the platen.

3 Open the maintenance cover on the right side.

4 Remove the cap.

• Squeeze the lugs on either side of the cap and pull off.

5 [When using Sb ink and TP ink] Rinse the cap with the mesh side facing downward in a
container filled with maintenance liquid. Remove, then wipe clean the resin part thoroughly.
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6 Apply maintenance liquid.

• Use a syringe to apply two or three drops of maintenance liquid to the hole at the front.

7 Mount a new cap.

• Position with the slot at the front and push in until it clicks.

8 Once replacement is complete, close the cover, then press the [ENTER] key.

7
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Replacing the Absorber Around the Station
If the cap absorber or maintenance liquid absorber is very dirty or if ink drips on to the media, replace with a
new cap absorber.

• UCJV: Maintenance liquid absorber not included.

With Resin Plate

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Platen Right End], then press the [ENTER]
key.
• The carriage moves over the platen.

3 Open the maintenance cover on the right side.

4 Remove the cap absorber together with the plate.

• Push up the two tabs at the front to remove the cap absorber.

Cap absorber
Plate (resin plate)

• Avoid ink dripping when removing the cap absorbers.

5 Clean the cap base.
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6 Mount a new cap absorber (with plate).

• Push the tabs on the cap absorber into the slits at the rear of the C slider, and clip in the tabs at
the front.

Push in to engage tabs.

Tab

7 Remove the maintenance liquid absorber.

8 Wipe away any maintenance liquid from around the slider block.

9 Mount a new maintenance liquid absorber.

• Push firmly on to the protrusion.

10 Check to confirm that the absorber is not lifting or curved.

11 Once replacement is complete, close the cover, then press the [ENTER] key.

With Metal Plate

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Platen Right End], then press the [ENTER]
key.
• The carriage moves over the platen.

7
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3 Open the maintenance cover on the right side.

4 Remove the cap absorber.

Cap absorber Plate (metal plate)

• Avoid ink dripping when removing the cap absorbers.

5 Mount a new cap absorber.

• Insert the tabs on the plate into the slits in the cap absorber.

Tab

Tab

Slit Slit

• Check to confirm that the cap absorber does not become detached.

6 Remove the maintenance liquid absorber.

7 Wipe away any maintenance liquid from around the slider block.
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8 Mount a new maintenance liquid absorber.

• Push firmly on to the protrusion.

9 Check to confirm that the absorber is not lifting or curved.

10 Once replacement is complete, close the cover, then press the [ENTER] key.

7
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Exhaust Fan Filter Replacement
Check the exhaust fan filter condition. Replace if very dirty.

1 Remove the exhaust fan box.

• Push the tabs at the front to remove the exhaust fan box.

• Replace the very dirty exhaust fan box with new one.

2 Mount a new exhaust fan filter in the exhaust fan box.

• Press the exhaust fan filter into the space under the tabs of the exhaust fan box.

Exhaust fan box

Exhaust fan filter

3 Mount the exhaust fan box.

• Insert the tabs of the exhaust fan box into the slits of the machine, and clip in the tabs at the front.
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Blowing Fan Filter Replacement

CJV TSJV

• The description here applies to the JV/CJV/TS.

Replace the blowing fan filter if it is dirty.

If sublimation transfer ink is used
• Replace the filter every three months.

• Turn off the main power and unplug the power cable before replacement.

1 Remove the fan filter cover.

• Push the fan filter cover claw outward, and pull the cover to the front.

Fan filter cover

Claw

2 Remove the filter.

Blowing fan filter

3 Mount a new filter and the fan filter cover.

• Push in the fan filter cover until the tab clicks.

7
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Pinch Roller Replacement
Replace worn or dirty pinch rollers with new ones.

If sublimation transfer ink is used
• Replace the pinch rollers every month if used for approximately 12 hours per day.
• Replace the pinch rollers every two weeks if used 24 hours per day.

• Turn off the main power and unplug the power cable before replacement.

1 Open the front cover.

2 Raise the clamp lever.

3 Remove the O-ring retaining the pinch rollers.

O-ring

O-ring

[JV/TS] [CJV/UCJV]

• The pinch rollers are small. Be careful to avoid dropping them into the product interior.

4 Remove the pinch rollers or the pinch roller spindle.

Pinch roller spindle
Pinch roller

[JV/TS] [CJV/UCJV]

5 Mount new pinch rollers, and secure them using the O-ring.

6 Close the front cover.



Chapter 7 Maintenance

241

Media Holder Replacement
If the media holder becomes deformed and touches the carriage or print head, replace with a new media
holder.

• Turn off the main power and unplug the power cable before replacement.

1 Open the maintenance cover on the left side.

2 Remove the side screw, and detach the media holder stopper.

3 Remove the media holder.

7
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4 Remove the sliders from the media holder.

• Be careful to avoid misplacing the sliders.

5 Mount the sliders on to the new media holder.

• Engage the holes in the sliders on to the lugs on the media holder.

6 Mount the new media holder on to the platen.

7 Secure the media holder stopper with the screw.

8 Close the maintenance covers.
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Media Cutter Replacement
Replace cutters when blades are chipped or blunt.

• Avoid touching the cutter blade. Failure to do so may result in injury.

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Platen Right End], then press the [ENTER]
key.
• The carriage moves over the platen.

3 Open the front cover.

• The carriage can be moved by hand. Move the carriage slowly to a position allowing easy
access while working.

4 Replace the media cutter.

(1) Unscrew the cutter screw.

Screw

(2) Remove the cutter.

(3) Mount a new cutter.
(4) Tighten the screw to clamp the cutter. 7
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5 Check the position of the media cutter.

• Lift up the media cutter by hand if it has dropped down.

Good example Bad example

6 Once replacement is complete, close the cover, then press the [ENTER] key.
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Y Cutter Replacement (XY Slitter)

CJV UCJVJV

• The description here applies to the JV/CJV/(UCJV)*. (*  "Options"(P. 303))

Replace cutters when blades are chipped or blunt.

• Avoid touching the cutter blade. Failure to do so may result in injury.

1 Unscrew the cutter screw.

2 Remove the cutter.

3 Insert a new cutter straight in as far as it will go.

Insert

• Take care to ensure that the cutter is not inserted at an angle.

4 Tighten the screw to clamp the cutter.

• If the screw is difficult to tighten, tighten while pushing the cutter right in.

1

2

7
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X Cutter Replacement (XY Slitter)

CJV UCJVJV

• The description here applies to the JV/CJV/(UCJV)*. (*  "Options"(P. 303))

Replace cutters when blades are chipped or blunt.

• Avoid touching the cutter blade when replacing cutters. Failure to do so may result in injury. Use
radio pliers or tweezers to replace cutters.

1 Slide the X cutter unit to the left-hand end to remove.

2 Turn the screw and remove the cutter.

3 Insert a new X cutter with the blade up until it stops.

• If the blade does not stop, the blade is not positioned correctly. Reposition and insert the
blade again.
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4 Check to confirm that the protrusion amount of the blade is 4 mm.

4 mm4 mm

• If not, adjustment is required.

(1) Turn the white knob screw to adjust the protrusion of the blade.
• Turn the screw clockwise to protrude the blade.
• Turn the screw counterclockwise to retract the blade.

5 Tighten the screw to clamp the X cutter.

6 Insert the X cutter groove into the L-shaped slide rail.

7
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Media Edge Guide Film Replacement

CJV TS UCJVJV

• The description here applies to the JV/CJV/TS/UCJV*.
• Included as standard for the TS, and optional for the JV/CJV/UCJV.

Replace the media edge guide film if it is creased or worn.

1 Turn the knob screw and open the media edge guide cover.

1

2

2 Rotate the media edge guides to remove them.

1

2

3 Remove the media edge guide film from the media edge guide.

• Make sure no parts of the double-sided tape remain.

4 Remove the double-sided tape on the media edge guide film and attach it to the media edge
guide.
• Align and attach the film hole (x2) to the screw hole (x2) of the media edge guide.
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5 Position the media edge guides on the roll guides.

(1) Insert the media edge guides between the roll guides.
(2) Rotate the media edge guides to mount them on the roll guides.

1

2

(3) Secure the media edge guides with the knob screw.

Ink Supply Unit Ink Absorber Replacement

CJV TSJV

• The UCJV does not include this function.

We recommend replacing the ink absorber each time you replace the ink pack, to prevent dirt building up on
the pedestal of the ink supply unit.

• Pay close attention to ventilation and be sure to wear safety glasses, gloves, and a mask when
handling ink, maintenance liquid, waste ink, or other solutions used with the machine. Leaking
ink may adhere to the skin or get into the eyes or mouth.

7
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1 Push down the lever on the pedestal, and remove the Ink eco-case.

2 Remove the ink absorber, and replace with a new one.

3 Set an eco-case on the base.
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Waste Ink Tank Replacement
Ink used during head cleaning and other processes is collected in the waste ink tank at the lower right of the
machine.
This product keeps track of the waste ink level. A "Check Waste Ink Tank" message appears when the
preset level is reached. Use this a guide for replacing the waste ink tank.

• For a 2-liter tank, the preset level is 80 % (1.6 L).
• Continuing to use the product without disposing of the waste ink may result in waste ink

overflowing from the waste ink tank. Visually check ink levels in the waste ink tank about once a
week.

• Pay close attention to ventilation and be sure to wear safety glasses, gloves, and a mask when
handling ink, maintenance liquid, waste ink, or other solutions used with the machine. Leaking
ink may adhere to the skin or get into the eyes or mouth.

When "Check Waste Ink Tank" message appears

1 The "Check Waste Ink Tank" message appears on the display.

 
Check Waste Ink tank
Level: xx %

2 Check the waste ink levels in the waste ink tank.

• If you note any discrepancies from actual levels, proceed to the next step.
• If there is no discrepancy, replace (dispose of) the waste ink tank referring to  "Replacing the

Waste Ink Tank"(P. 251).

3 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

4 Select [Waste Ink Tank], then press the [ENTER] key.

5 Select [Adjust Waste Ink Volume], then press the [ENTER] key.

6 Press  to adjust the level.

7 Press the [ENTER] key once adjustment is complete.

Replacing the Waste Ink Tank

• No tank stopper is included when the waste ink tank cover is made of plastic.

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Waste Ink Tank], then press the [ENTER] key.

7
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3 Select [Reset Waste Ink Volume], then press the [ENTER] key.

4 Open the waste ink tank cover and unlock and pull the stopper forward.

Tank stopper

5 Hold the handle on the waste ink tank and slide out.

6 Attach the cap to the removed waste ink tank, and use tape to prevent leakage of waste ink.

• When disposing of ink, maintenance liquid or other liquid used with the product, or
containers or non-woven fabric contaminated with ink or other liquid, contact an industrial
waste disposal operator or dispose of the product in accordance with the local laws and
regulations.
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7 Install a new waste ink tank.

8 Return the stopper to its original position and close the waste ink tank cover.

9 Press the [ENTER] key.

• The waste ink level will be reset.

7
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Mist Filter Replacement

UCJV

• The description here applies to the UCJV.

Check the mist filter. Replace if very dirty.

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Maint. Space], then press the [ENTER] key.

• The carriage moves to the maintenance space.

3 Open the maintenance cover on the left side.

4 Remove the mist filter box.

• Push the tab in the direction indicated by the arrow and slide out in the direction of the arrow to
remove.

Tab

Handle

Handle

5 Replace the mist filter with a new one.

6 Install the mist filter box.

• Insert until it clicks into place. Confirm that the tab is engaged.

7 Once replacement is complete, close the cover, then press the [ENTER] key.
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UV-LED Glass Replacement

UCJV

• The description here applies to the UCJV.

Replace the glass on the underside of the UV-LED unit if hardened ink is adhering to it.

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Platen Right End], then press the [ENTER]
key.
• The carriage moves over the platen.

3 Open the front cover.

4 Remove the LED glass.

• Push the tabs inward and slide out the glass in the direction of the arrow to remove.
• Be careful not to apply too much force when unclipping the tabs. Disregarding this precaution may

result in breakage of the tabs.

Tab

[Same for the opposite side]

5 When replacing the glass holder at the same time, cut the tabs on the rear side.

UV-LED glass (left) UV-LED glass (right)

Cut (broken line)
Rear

Front

Rear

Front

7
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6 Install a new LED glass.

• Without touching the tabs, press on the center of the glass holder to insert it into place.
• Insert until it clicks into place. Confirm that the tabs are engaged.

[Same for the opposite side]

[Left side] [Right side]
Press the red circle.

7 Once replacement is complete, close the cover, then press the [ENTER] key.
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Cutter for Cutting Machine

CJV UCJV

• The description here applies to the CJV/UCJV.

Replace cutters when blades are chipped or blunt.

• Avoid touching the cutter blade. Failure to do so may result in injury.
• Do not shake or swing the cutter holder. Doing so may cause the blade to come off.

l Replacing Cutters
 "Installing Cutting Tools"(P. 114)

Pen Line Replacement

CJV UCJV

• The description here applies to the CJV/UCJV.

This machine can be used with the following pen lines.
• Pen line rubber

Used for pen writing or cutting
• Pen line sponge

Used for half cut (cutting across a dotted line)

• Turn off the main power and unplug the power cable before replacement.

1 Open the front cover.

2 Use tweezers to peel off the end of the pen line.

• Wipe off any adhesive remaining in the platen slot with industrial alcohol.

3 Attach double-sided tape in the platen slot.

• Peel off the base paper from the double-sided tape.

7
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4 Attach the pen line on the double-sided tape.

• Make sure the pen line lies flat.

5 Close the front cover.

Ink Bottle Cap Replacement

UCJV
As a guideline, replace annually. For replacement instructions, see  "UCJV"(P. 54).

• Pay close attention to ventilation and be sure to wear safety glasses, gloves, and a mask when
handling ink, maintenance liquid, waste ink, or other solutions used with the machine. Leaking
ink may adhere to the skin or get into the eyes or mouth.
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8.1 Troubleshooting
For information on troubleshooting, refer to this chapter. Refer to our website (https://mimaki.com/support/)
for frequently asked questions (FAQs) about this product and customer support videos.
If the recommended corrective action does not resolve the problem, contact your local dealer or our service
office.

The power does not turn on.

Points to check Corrective action

Is the machine connected to the
power outlet by the power cable?

Connect the power plug securely to the power outlet. 
"Connecting the Power Cable"(P. 39)

Are you using the power cable
provided?

Use the power cable provided.

Is the main power supply turned on? Turn on the main power supply.  "Turning On the Power"(P. 39)

Is the [END/POWER] key on the
operating panel turned on?

Turn the power on.  "Turning On the Power"(P. 39)

Printing is not possible.

Points to check Corrective action

Is a USB interface cable connected? Connect the cable securely to the USB 2.0 port.  "Using a USB
Cable"(P. 43)

Is a LAN cable connected? Connect the cable securely to the LAN port.  "Using a LAN
Cable"(P. 42)

Are you using a LAN cable approved
by Mimaki?

Check the LAN cable type.  "Using a LAN Cable"(P. 42)

Is the status lamp on the operating
panel illuminated or flashing red?

An error has occurred. Check the message on the display. 
"Operating Panel"(P. 35)

The media jams or the media is dirty.

Points to check Corrective action

Are you using the recommended
media?

Make sure you are using the recommended media. https://
mimaki.com/supply/inkjet.html

Are you using curled media? Do not use curled media or media with folded ends.

Is the media skewed? Use the take-up unit to adjust the media or reload the media. 
"Loading the Media"(P. 70)

https://mimaki.com/support/
https://mimaki.com/supply/inkjet.html
https://mimaki.com/supply/inkjet.html
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Points to check Corrective action

Does the media have ripples/surface
irregularities or lift up?

If you are using roll media, use a smooth section of the media for
initial feeding. You can also improve this problem by attaching the
NITOFLON® tape provided on the platen.

Be careful not to cover the vacuum holes.

For more information, refer to the description on transporting media
on the platen. https://mimaki.com/download/inkjet.html

Is the media lifting up and rubbing
against the carriage or head?

1. Ensure that the installation environment satisfies the requirements.
"Specifications"(P. 296)

2. Raise the head gap.

Image defects occur.

Symptom Corrective action

White streaks, blurriness, and dark
streaks occur.
(Carriage scan direction)

1. Remove any paper scraps or other debris adhering to areas over which
the head passes (e.g., media holders).  "Media Holder
Cleaning"(P. 216)  "Platen Cleaning"(P. 218)

2. Perform the procedure described in  "Head Cleaning"(P. 98).
3. Perform the procedure described in  "Feed Correction"(P. 99).
4. Perform the procedure described in  "Cap Rubber Cleaning"(P. 206).
5. Perform the procedure described in  "Carriage Underside

Cleaning"(P. 207).

Text is double- or triple-printed in the
media feed direction.

1. Perform the procedure described in  "Feed Correction"(P. 99).

Offsetting occurs during bidirectional
printing.

1. Perform the procedure described in  "Correcting the Drop
Position"(P. 101).

Ink droplets drip during printing. 1. Perform the procedure described in  "Cap Rubber Cleaning"(P. 206).
2. Perform the procedure described in  "Carriage Underside

Cleaning"(P. 207).
3. Perform the procedure described in  "Head Cleaning"(P. 98).
4. Set auto maintenance.  "Maintenance Menu"(P. 184)

Nozzles are clogged. 1. Perform the procedure described in  "Head Cleaning"(P. 98).
2. Perform the procedure described in  "Print Head Nozzle

Washing"(P. 263).
3. Perform the procedure described in  "Registering Nozzle

Recovery"(P. 186).

Are the print heads too high? Adjust the print head height.  "Adjusting Print Head
Height"(P. 65)If the print heads cannot be lowered, increase the
refresh level during printing (  P. 185) or perform regular test
printing to check for nozzle clogging. 8

https://mimaki.com/download/inkjet.html
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Symptom Corrective action

Are there any ink colors that aren't
used much?

Discharge from infrequently used nozzles tends not to be consistent.
Although increasing the refresh level during printing (  P. 185) will
enable more frequent nozzle use, note that this will also increase ink
consumption.

Are you using media easily affected
by static electricity?

Increase the refresh level during printing (  P. 185) or perform
regular test printing to check for nozzle clogging. Otherwise, use an
optional ionizer.

Is the machine installed in a location
with low humidity?

Increase the humidity by installing a humidifier or similar equipment.
When printing continuously, also increase the refresh level during
printing (  P. 185) or perform regular test printing to check for
nozzle clogging. Otherwise, use an optional ionizer.

Is the machine installed in a location
where dust or powder is present?

Install the machine in a location free of dust or powder (office
equivalent: dust level 0.15 mg/m3).

There is considerable nozzle
clogging with white ink
* UCJV only

1. Perform the procedure described in  "Head Cleaning"(P. 98).
2. Perform the procedure described in  "There is considerable nozzle

clogging with white ink"(P. 264).

Uneven coloring looking like tree
rings occurs.
* UCJV only

1. Increase the force with which the medium is held down (vacuum fan
 P. 182).

2. Increase the PRE (preheater) temperature.  "Setting the Heater
Temperature"(P. 95)
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Print Head Nozzle Washing
If ejection failures (e.g., nozzle clogging or deflection) remain unresolved even after head cleaning (
"Head Cleaning"(P. 98)), apply nozzle wash to the print head.

JV/CJV/TS

CJV TSJV

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Nozzle Wash], then press the [ENTER] key.

• The carriage moves over the platen.

3 Open the maintenance cover on the right side.

4 Clean the cap rubber.

•  "Cap Rubber Cleaning"(P. 206)

5 Once cleaning is complete, close the cover, then press the [ENTER] key.

• The cap is filled with maintenance liquid.

• Close the cover. The cap cannot be filled with maintenance liquid while the cover is open.
This is also true if the maintenance liquid cartridge is empty.

6 Open the maintenance cover on the right side.

• Check to confirm that the cap is filled with maintenance liquid.

• If not, use a syringe to draw up some maintenance liquid and fill until it almost overflows
from the cap.

7 Close the maintenance covers.

8 Set the exposure time, then press the [ENTER] key.

• Cleaning is performed automatically once print nozzle washing has ended.

• If ejection failures (e.g., nozzle clogging or deflection) remain unresolved even after
washing the nozzles several times, contact your local dealer or our service office. 8
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UCJV

UCJV

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Nozzle Wash], then press the [ENTER] key.

• The carriage moves over the platen.

3 Open the maintenance cover on the right side.

4 Clean the cap rubber.

•  "Cap Rubber Cleaning"(P. 206)

5 Once cleaning is complete, close the cover, then press the [ENTER] key.

• "Fill the Liquid. Exit Next [ENT]" appears on the display.

6 Fill the cap with maintenance liquid.

• Use a syringe to draw up some maintenance liquid and fill until it almost overflows from the cap.

7 Close the maintenance cover, then press the [ENTER] key.

8 Set the exposure time, then press the [ENTER] key.

• Cleaning is performed automatically once print nozzle washing has ended.

• If ejection failures (e.g., nozzle clogging or deflection) remain unresolved even after
washing the nozzles several times, contact your local dealer or our service office.

There is considerable nozzle clogging with white ink
If there is considerable nozzle clogging with white ink (dropouts), perform Air PG. Note that this consumes a
large amount of ink.

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Air PG], then press the [ENTER] key.
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3 Press , then select [YES].

Air PG 
A large amount of ink will be consumed.
Continue?
NO < > YES

4 Press , then select [YES].

Air PG 
Do ejection failures involving large amounts of
white occur?
NO < > YES

5 The "Check Waste Ink Tank" message appears on the display.

 
Check Waste Ink tank
Level: xx %

6 Check the waste ink levels in the waste ink tank.

• If there are discrepancies from actual levels, correct the waste ink amount.  "When "Check
Waste Ink Tank" message appears"(P. 251)

• If there is no discrepancy, replace (dispose of) the waste ink tank referring to  "Replacing the
Waste Ink Tank"(P. 251).

7 Press the [ENTER] key to start air purging.

Air PG 
Air PG
Start
NO <

[ENT]
> YES

8 Perform a test print and check the print results.

•  "Test Printing"(P. 96)

8
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The media adheres to the platen, preventing it from being transported
correctly.

Media with low stiffness such as thin film may adhere to the platen, leading to incorrect transportation. If this
happens, do the following to prevent it.

Media adheres
and lifts up

• Leaf media cannot be used, as the procedure uses the take-up unit.
• The media may adhere to the preheater after the pinch roller. The media may also become

wrinkled or jammed. For this reason, do not feed the media backward continuously or use
functions (such as pullback printing and view feeding) that involve backward feeding.

l Before setting the media
1. Affix Nitoflon tape to the post-heater.

– Affix the Nitoflon tape provided to the post-heater. 
Recommendation: Affix five strips of tape at equal intervals (70 mm apart).

70 mm intervals
Nitoflon tape

2. Configure the take-up torque setting, pinch roller pressure, and the number of pinch rollers used.
 "Adjusting the torque limiter"(P. 72)  "Setting the Pressure and Number of Pinch Rollers to

Use"(P. 93)
– To prevent the media adhering, set a strong take-up torque.
– For media that stretches easily when pulled, set a weak take-up torque.

Points to check Setting procedure

For media that does not
stretch easily

• Adjust the take-up torque between "Max" and "Mid".
• The pinch roller pressure must be set to a high value to match the take-

up torque. Set to between "HIGH" and "MID".
• Use as many pinch rollers as possible, ensuring that they are evenly

spaced.

For media that stretches
easily

• Adjust the take-up torque to "Min".
• Set the pinch roller pressure to between "MID" and "LOW".
• Use as many pinch rollers as possible, ensuring that they are evenly

spaced.
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l Loading the media on to the take-up unit (when using media with low stiffness)
For details of how to load roll media, refer to  "Loading the Roll Media"(P. 80).

1 Follow the procedure up to "14. Load an empty paper core on the take-up unit." in 
"Loading the Roll Media"(P. 80).

Paper core Take-up unit

2 With the clamp lever raised, perform steps (1) to (4) below to secure the media to the paper
core.

• With media that stretches easily when pulled, tension differences may occur between the
left and right sides of the media, preventing consistent feeding. 
The media must also be secured to the paper core in the take-up unit with minimal tension
difference between the left and right sides.

(1) Check that there is no sagging or wrinkling in the media, and affix tape along the entire end of
the media.

Tape

(2) Pull the media toward the take-up unit while spreading it out slightly evenly on both sides to
prevent sagging.

8
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(3) Attach the media to the take-up unit, ensuring an even tension on both sides.
[Conventional method] [For media with low stiffness]
Secure at one point (center) or three
points (left, right, center) Secure across entire width

(4) Press the ON/OFF button on the take-up unit to start the take-up operation, then press the
ON/OFF button to stop it once the media has wound around the paper core about one and a
half times.

3 Lower the clamp lever.

4 Secure the media in the media holder.

Media holder

• Do not use the media holder when printing on thicker media.
• Do not use the media holder when cutting media.

5 Close the front cover.
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6 Select "Flexible Packaging Film" for the media to be used.

Media selection
● Flexible Packaging Film
○ Tarpaulin
○ Unregistered
○ Unregistered

1/2
1300 mm
1600 mm

○ Unregistered

• To use unregistered media, select [Unregistered] to register the media.  "Registering
the Media"(P. 89)

7 The media width is detected.

• No change: Only the right side of the media is detected.
• Media width re-detection: The media width is detected.

PVC
Media Width 1300 mm

No change
Media width re-detection

• Media width may not be detected correctly for certain colors or types of media. When
media width cannot be detected correctly, set the media width detection method to
"MANUAL".

• If the media width detection method is set to "MANUAL", set the media width manually
([MENU] > [Media Setting] > [Media Information] > [Media Width] > [Detection Type]

 P. 182).
• A notification reading "Media Set Position R" will appear after media width detection if the

media is too far to the right of the specified position. Reload media in the specified
position.

• If Media Remain Manage is set to "ON", the Input Media Length screen will be displayed.
([MENU] > [Media Setting] > [Media Information] > [Media Remain] > [Media Remain
Manage]  P. 182).

8 (CJV/UCJV only) Enter the number of pinch rollers being used.

• If the setting for [Function Setting] > [Use PR Number Query] is "OFF", the screen for entering the
number of pinch rollers will not be displayed.

l Checking the vacuum fan settings
Set the vacuum fan to "Low", as media is susceptible to adhering to the platen.

• Optimizing the settings when registering the media will set the vacuum fan to the low setting.

l Miscellaneous
• Check to confirm that the media is not lifting up before starting printing.

– The media is susceptible to lifting up (forming wrinkles) in front of the pinch rollers. 8
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– If wrinkling occurs, raise the clamp lever slightly and smooth out the wrinkles before starting
printing.
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The heater temperature does not rise to the specified value.
This may indicate a problem with the setting.

Points to check Corrective action

Is the 100V/200V selector
switch set correctly?

Set the selector switch according to the power supply voltage.

Is the heater temperature set? Set the heater temperature.  "Setting the Heater Temperature"(P. 95)
 "Media Setting Menu"(P. 180)

The ink has leaked out

• If an ink leak occurs, turn off the main power immediately and unplug the power cable. Then,
contact your local dealer or our service office.

The light-blocking cover comes off.

UCJV
If the light-blocking cover is left off, the ink inside the ink supply unit may be exposed to light and begin to
harden.
If the light-blocking cover comes loose, reattach as follows:

1 Insert the lug on one side of the light-blocking cover into the corresponding hole in the tank.

2 Insert the lug on the other side while pushing in toward the first hole in Step 1.

8
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Abnormal noise occurs during cleaning
Cloth wiper may be entangled in the cloth wiper gear. Remove the cloth wiper and replace it.

• Perform the following procedure: Use the [Replace Wiper] menu to reset the wiper remaining
amount.

• When handling SPC-0919 or SPC-0932 cloth wipers, be sure to wear safety glasses, gloves,
and a mask. There is a risk of the liquid (solvent) contained in cloth wipers splashing and
contacting your skin, eyes, or mouth.

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Platen Right End], then press the [ENTER]
key.
• The carriage moves over the platen.

3 Open the maintenance cover on the right side.

4 Open the cloth wiper cover.

• Push the two tabs at the front up to open.

5 Remove the cloth wiper together with the spindle, then replace it.
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Cutting Related

CJV UCJV

Symptom Corrective action

The cut position shifts. This may indicate a problem with the register mark sensor. Perform the
operation used to check the responsiveness of the register mark sensor.
You cannot check the responsiveness of the register mark sensor
manually.  "Adjusting the Position of the Register Mark Sensor"(P. 273)

Cutting is not possible. Cut a sample stored in the machine to identify the cause. Executing a
sample cut will clear any data saved in the receive buffer.  "Investigating
the Cause of Cutting Failures"(P. 275)

The print and cut positions are
misaligned.

Use the MIMAKI RIP software (RasterLink) to print a correction pattern.
Check the correction pattern and input correction values manually. 
"Adjusting to Correct Misalignment Between Printing and Cutting"(P. 275)

The print and cut positions are
misaligned in the scan
direction.

Print the correction pattern to perform automatic correction.
1. Position the media.

– Prepare white media used to print a correction pattern.
2. On the LOCAL mode screen, select [MENU] > [Cutting], then press the

[ENTER] key.
– The Cutting menu is displayed.

3. Select [Maintenance] > [Scale Adjust], then press the [ENTER] key.
4. When the confirmation screen is displayed, press the [ENTER] key.

– Print the correction pattern to perform automatic correction.

Adjusting the Position of the Register Mark Sensor

1 Prepare the media on which register marks are printed.

•  "Creating Register Marks"(P. 130)

2 On the LOCAL mode screen, select [MENU] > [Cutting], then press the [ENTER] key.

• The Cutting menu is displayed.

3 Select [Maintenance] > [Marks Sensor] > [Sensor Check], then press the [ENTER] key.

• The cutting unit moves over the platen.

4 Press  to move the LED pointer.

LED pointer position

1 mm or more

LED pointer position

1 mm or more

[(Mark shape) Type 1] [(Mark shape) Type 2]

5 Register the information corresponding to the printed register mark conditions.

•  "Setting Mark Detection Conditions"(P. 136)
• The set register mark conditions are also stored in [Cutting] > [Mark Detect]. The settings are

retained even when the power is turned off.

8
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6 Press [ENTER] to start the detection operation.

• The machine automatically detects the lines in the X and Y directions (automatic detection
operation: plus X direction > minus X direction > plus Y direction > minus Y direction).

+ -

+

-Y direction

X direction

• A buzzer sounds each time a line is detected (four buzzers in all). If any of the buzzers fails to
sound, refer to the following:

 "Correcting the LED Pointer Position"(P. 274)

Correcting the LED Pointer Position
If the register marks cannot be read properly, the register mark sensor may be misaligned. Refer to the
following to correct the position of the register mark sensor:

1 Attach a pen to the tool holder.

•  "Using a Pen"(P. 118)

2 Load copy paper.

3 On the LOCAL mode screen, select [MENU] > [Cutting], then press the [ENTER] key.

• The Cutting menu is displayed.

4 Select [Maintenance] > [Marks Sensor] > [Pointer Offset], then press the [ENTER] key.

• A 10 mm cross pattern is drawn.
• The LED pointer turns on and moves to the center of the cross pattern.

5 Press  to move the LED pointer to the center of the cross pattern.

6 Press the [ENTER] key to complete the settings.

• The settings are retained even if [Setup Reset] is selected.

7 Check the following again.

•  "Adjusting the Position of the Register Mark Sensor"(P. 273)
• If the buzzer does not sound four times, check the printed register mark conditions and contact

your local distributor, our sales office, or service center.



Chapter 8 Troubleshooting

275

Investigating the Cause of Cutting Failures

1 On the LOCAL mode screen, select [MENU] > [Cutting], then press the [ENTER] key.

• The Cutting menu is displayed.

2 Select [Maintenance] > [Sample Cut], then press the [ENTER] key.

3 Select the sample data, then press the [ENTER] key.

• There are two sample types: "Cut" and "Logo".

[Cut] [Logo]

• If you select "Cut", press the [ENTER] key to start cutting.
• If you select "Logo", refer to the following:

(1) Press   to specify the scaling factor (1 to 999 %).
(2) Press the [ENTER] key to start cutting

• The settings are retained even if [Setup Reset] is selected.

l Sample Cut Results
• Sample data can be cut properly, but not other data.

– There is a problem with the host PC.
• Sample data as well as other data cannot be cut properly.

– There is a problem with the printer. Increase the pressure in the Adj-prs Offset menu.  "Cutting
Menu"(P. 195)

Adjusting to Correct Misalignment Between Printing and Cutting
In the procedure described below, MIMAKI RIP software (RasterLink) is used to print a correction pattern.
When printing and cutting, correction is required for each resolution in the scan (Y) direction. (The corrected
value is saved for each resolution.) Print a pattern for each resolution, then input the correction value.

1 Switch the machine to REMOTE mode.

2 Set the print conditions (profile/cut conditions) for the job you want to print in RasterLink.

• Specify the following settings by clicking the function icons shown on the right-hand side of the
screen: 

 (General Print): Specifies settings like enlargement/reduction and rotation. 
 (Quality): Selects a color profile for the media and ink set loaded in this machine.

• For more information, refer to the RasterLink reference guide. https://mimaki.com/
download/software.html

8

https://mimaki.com/download/software.html
https://mimaki.com/download/software.html
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3 Click  (General Print) and click on [Print & Cut origin adjust] on the [Cut Edit] tab.

• Note that the input units vary depending on whether or not register marks are used.

Without register marks

1 Click [OK] to print a correction pattern.

2 On the REMOTE mode screen, select [Adjust].

3 Select [PC Origin Offset], then press the [ENTER] key.

• A correction pattern is cut. Detach the cut part of the pattern and check the adjustment values.

 

+ -
-

+

4 Input the numerical value of the position with the lowest vertical misalignment.

• In the illustration below, enter "-4".

-2 -5-4-3 -6

Enlarged X

5 Input the numerical value of the position with the lowest horizontal misalignment.

• In the illustration below, enter "2".

4 123 0

Enlarged Y
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With register marks

1 Select [Add register mark].

2 Click [OK] to print a correction pattern.

3 On the REMOTE mode screen, select [Adjust].

4 Select [TP Offset], then press the [ENTER] key.

• The register marks are detected, and a correction pattern is cut. Detach the cut part of the pattern
and check the adjustment values.

 

+ -

-
+

5 Input the numerical value of the position with the lowest vertical misalignment.

• In the illustration below, the value is "-4", so enter "-0.4 mm".

-2 -5-4-3 -6

Enlarged X

6 Input the numerical value of the position with the lowest horizontal misalignment.

• In the illustration below, the value is "2", so enter "0.2 mm".

4 123 0

Enlarged Y

8
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8.2 To Stop Circulation Operation
CJV UCJVJV

• The description here applies to the JV/CJV/UCJV.

When white or orange ink is installed, the ink is circulated periodically to prevent it from sedimenting. The
procedure to stop circulation while the power is turned on is as follows:

1 Press the [END] key when [Preparing for circulation] or [Circulation] is displayed on the
screen.

Preparing for circulation
PLEASE WAIT 

Circulation
00:04:00

2 Use the  keys to select [OK], then press the [ENTER] key.

During ink circulating
Does it stop circulation?

Cancel
OK

• The ink is automatically supplied and circulation stops.

Ink Supplying
PLEASE WAIT 

• When circulation has been stopped, it will restart after a preset period of time has elapsed.

• With the UCJV, circulation takes approximately 20 minutes.
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8.3 Problems Causing Messages to
Appear
If a problem arises, the buzzer sounds and a message appears on the display.
You can also check the local guidance.  "Displaying Machine Information (Local Guidance)"(P. 38)
Take the appropriate action in accordance with the content of the message. If a message reappears even
after taking the prescribed action, contact your local dealer or our service office.

Warning Messages

Message Cause Corrective action

Replace NCU Ink Pad • The ink absorber needs to
be replaced.

• The NCU ink absorber must be
replaced. Contact your local distributor,
our sales office, or service center.

Replace NCU • A problem was detected
with the nozzle clogging
assessment.

• Clean the NCU.  "NCU
Cleaning"(P. 209)

• Replace the NCU if the error does not
clear. Contact your local distributor, our
sales office, or service center.

NCU Sensor Lv Low • The sensor's sensitivity is
impaired.

• Clean the NCU.  "NCU
Cleaning"(P. 209)

• Replace the NCU if the error does not
clear. Contact your local distributor, our
sales office, or service center.

NCU Sens Adj Err H • Sensor sensitivity
adjustment failed.NCU Sens Adj Err L

NCU Connect • A problem was detected
with the NCU connection.

• Turn off the power on the machine and
turn it on after a while.

Ink Error • An ink error occurred. • Check the ink error details.  "Ink
Error"(P. 281)

COVER OPEN • The cover is open. • Close the cover.

Lower the clamp lever • The clamp lever is raised. • Lower the clamp lever. 
"Front"(P. 28)

Data Remain • Print (RIP) data was
received.

• Switch to REMOTE mode and start
printing or clear the data and abort
printing.

Temporary Suspension • Printing has been paused. • Switch to REMOTE mode and resume
printing or clear the data and abort
printing.

Printing not possible/ink IC • An unusable ink IC chip is
used.

• Replace with new ink and a new ink IC
chip.  "Replacing Ink"(P. 48)

No Media • No media is loaded, or the
sensors are faulty.

• Load the media.  "Loading the
Media"(P. 70)

• Clean the media sensor.  "Media
Sensor Cleaning"(P. 214)

Please load media • No media is loaded, or the
sensors are faulty.

• Load the media.  "Loading the
Media"(P. 70)

Media Undetected • The media width has not
been detected.

• Detect the media width.  "Loading
the Media"(P. 70)

8
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Message Cause Corrective action

Wiper Move Failure • The wiper is not operating
correctly.

• Turn off the power on the machine and
turn it on after a while.

Replace Wasteinktank • The waste ink tank count
exceeded the preset
value (90%).

Automatic maintenance is not possible
while the covers are open. Perform the
following steps:
1. Check the waste ink levels in the waste ink

tank.  "When "Check Waste Ink Tank"
message appears"(P. 251)

2. Replace the waste ink tank, then reset the
waste ink level.  "Replacing the Waste
Ink Tank"(P. 251)

Check Waste Ink tank • The waste ink tank count
exceeded the preset
value (80%).

1. Check the waste ink levels in the waste ink
tank.  "When "Check Waste Ink Tank"
message appears"(P. 251)

2. Replace the waste ink tank, then reset the
waste ink level.  "Replacing the Waste
Ink Tank"(P. 251)

WashLiquidCart.None • No maintenance liquid
cartridge is loaded.

• Load the maintenance liquid cartridge.

Please replace wash liquid
cartridge

• The maintenance liquid
has run out.

• Replace with a new maintenance liquid
cartridge.

Washing liquid end • The maintenance liquid
has run out.

• Replace with a new maintenance liquid
cartridge.

High ambient temp ** ﾟC • Ambient temperatures are
too high.

• Adjust ambient temperatures to
temperatures within the specified range.
Optimum print quality may not be
possible unless ambient conditions are
within the specified range. 
"Installation Precautions"(P. 19)

Low ambient temp ** ﾟC • Ambient temperatures are
too low.

Perform an air purge. • The message is displayed
every month to keep ink
inside the ink routes from
hardening.

• Perform an air purge.  "There is
considerable nozzle clogging with white
ink"(P. 264)

Auto-correction failed • White media is not used.
• The media is dirty.
• The media lifts up.
• There is dirt around the

sensor.

• Load white and clean media.
• Load media so it does not lift up.
• Clean the area around the sensor. 

"DAS (Automatic Correction Function)
Sensor Cleaning"(P. 211)

• If automatic correction fails repeatedly,
correct the position manually.  "Feed
Correction"(P. 99)  "Correcting the
Drop Position"(P. 101)

Wiper End • The cloth wiper has run
out.

• Replace with a new cloth wiper. 
"Cloth Wiper Replacement"(P. 228)

Wiper Near End • The remaining amount of
cloth wiper is low.

• The ink will run out soon. Have a new
cloth wiper ready.  "Cloth Wiper
Replacement"(P. 228)

Cleaning was executed
because a large ambient
temp. change was detected.
Check the nozzle condition.

• A large temperature
change than expected*1

was detected. (*1: 330

• Perform a test print to check the nozzle
state.  "Test Printing"(P. 96)
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Message Cause Corrective action

Series: 10 °C or more/
UCJV Series: 8 °C or
more)

• Cleaning was performed
automatically when the
power was turned on to
protect the nozzle
condition if a temperature
changed after the power
was turned off.

Ink Error

Message Cause Corrective action

Ink End • The ink has run out. • Replace with new ink.  "When Ink
End is Displayed"(P. 47)

• If you use UISS, you may perform
cleaning.

Ink Near End • Ink levels are low. • The ink will run out soon. Have new ink
ready.  "When Ink Near End is
Displayed"(P. 47)

Non Ink IC • No ink IC chip was
detected.

1. Insert the ink IC chip.  "Replacing
Ink"(P. 48)

2. Check to confirm the ink IC chip was
inserted correctly.  "Mounting the
ink"(P. 51)

3. Turn off the power on the machine and turn
it on after a while.

Wrong Ink IC • An error occurred with the
information on the ink IC
chip.

1. Check to confirm the ink IC chip was
inserted correctly.  "Mounting the
ink"(P. 51)

2. Turn off the power on the machine and turn
it on after a while.

3. Replace with new ink.  "Replacing
Ink"(P. 48)

Ink Color • The ink color registered
on the IC chip is different
from the ink color filled.

• Insert an ink IC chip for the correct ink
color.  "Mounting the ink"(P. 51)

Ink Type • The ink type registered on
the IC chip is different
from the ink type filled.

• Insert an ink IC chip for the correct ink
type.  "Mounting the ink"(P. 51)

Expiration Near • The ink has expired. • Replace with new ink or use up as
quickly as possible. Printing is possible.

 "When Ink End is Displayed"(P. 47)

Expiration Over • The ink is two months
past its expiration date
and cannot be used.

• Replace with new ink. Printing is not
possible.  "When Ink End is
Displayed"(P. 47)

8
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Error Message

Error
number

Message Cause Corrective action

04 PARAM ROM • A problem was detected
with the main PCB.

• Turn off the power on the machine
and turn it on after a while.

108 HD THERMIS[12] • A problem was detected
with print head
temperature control.

108 HD CONNECT[12] • A problem was detected
with the print head
connection.

108 HD MEM EMP[12] • A problem was detected
with the print head.

10e FROM CLEAR • A problem was detected
with the main PCB.10f FROM WRITE

115 PCB MAIN-F1

122 CHECK:SDRAM • A problem was detected
with the SDRAM.122 PRAM NONE

123 PRAM DATA • A problem was detected
with the main PCB.124 PRAM ADDR

127 POWER OFF

128 HDC FIFO OVER • A problem was detected
with the print head control
PCB.128 HDC FIFO UNDER

129 Battery Exchange • The internal clock battery
is spent and must be
replaced.

• Contact your local distributor, our
sales office, or service center.

12a HDC SPEED • A problem was detected
with the print head control.

• Turn off the power on the machine
and turn it on after a while.

12d PCB MAIN-F4 • A problem was detected
with the main PCB.

130 HD DATA SEQ • A problem was detected
with the print head control.

147 DS-IC BUSY • Ink IC control abnormality
detected.

148 E-LOG SEQ • A log control abnormality
was detected.

151 Main PCB V1R2 • A problem was detected
with the main PCB power
supply circuit.152 Main PCB V2R5

153 Main PCB V3R3

154 Main PCB V05

155 Main PCB V42-1

15f HEAD DRIVE HOT • The HDCE PCB COM
driver is hot.
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Error
number

Message Cause Corrective action

171 NEW HEAD CONNECT • A new print head
connection was detected.

17e PCB IIO
(PCB INKCTR*)
*JV/CJV/TS:
Firmware earlier than
version 4.0

• A communication error
was detected between the
boards.

186 HDC OVERFLOW/HDC
UNDERFLOW

• A problem was detected
with the print head control.

187 HDC SLEW RATE

188 HDC MEMORY

18c Main PCB V12 • A problem was detected
with the main PCB power
supply.

18e FLS NOT COMP • A problem was detected
with the print head control.18f OFFSET START [12]

18f OFFSET END [12]

19f LED CONNECT • The UV- LED PCB could
not be detected.

• Turn off the power on the machine
and turn it on after a while.

1b5 SLIDER CONNECT • Unable to detect the
HDCE PCB.

• Turn off the power on the machine
and turn it on after a while.

1bf PCB MAIN-F2 • A problem was detected
with the main PCB.

1c5 PCB IIO-F* • A blown fuse on the ink
supply 2LC PCB was
detected.

– JV/CJV/TS: Firmware
version 4.0 or later

1d8 HEAD XHOT[12] • A problem was detected
with the print head.

1e6 PRAM Size Shortage • Insufficient memory

1e9 PCB INKCTR-F* • A blown fuse on the ink
supply 2LC PCB was
detected.

– JV/CJV/TS: Firmware
earlier than version 4.0

201 Command Error • Data other than print (RIP)
data was received, or a
problem was detected
with the print (RIP) data
received.

1. Clear the data and resend.
2. Check the USB/Ether cable connection.

 "Connecting a PC to the
Product"(P. 42)

3. Use a compatible cable. 
"Connecting a PC to the Product"(P. 42)

4. Turn off the power on the machine and
turn it on after a while.

202 Parameter Error • A problem was detected
with the print (RIP) data
received.

206 Print Mode Error • Print (RIP) data was
received with print
parameters that do not
allow printing.

• Change the output parameters and
profile using RIP software.

8
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Error
number

Message Cause Corrective action

20A Driver Version • Printing is not possible
because the Mimaki driver
version is old.

• Install the latest Mimaki driver
available from: 
https://mimaki.com/download/
inkjet.html

303 PCB MAIN ET • A problem was detected
with the main PCB.

1. Turn off the power on the machine and
turn it on after a while.

304 USB INIT ERR • A problem was detected
with the USB cable
connection.

1. Check the USB cable connection. 
"Using a USB Cable"(P. 43)

2. Use a compatible cable.  "Using a
USB Cable"(P. 43)

3. Turn off the power on the machine and
turn it on after a while.

305 USB TIME OUT

315 No resp from
XY Slitter

• Unable to detect a
response from the XY
slitter.

• The XY clamp lever was
operated (raised or
lowered) when one of the
following errors had
occurred:

– Error 48f: 
XY Slitter Motor X

– Error 490: 
XY Slitter Motor Y

– Error 491: 
XY Slitter X Current

– Error 492: 
XY Slitter Y Current

– Error 55a: 
XY Slitter Y Origin

1. Check to confirm that the XY slitter
cable is connected to the machine.

2. Check to confirm that the XY carriage is
stopped.

3. Select [MENU] > [Function Setting] > [
Finisher] > [None].

4. Select [MENU] > [Function Setting] >
[Finisher] > [XY Slitter].

316 XYSlitter
transmit error

• A problem was detected
with the transmission data
sent to the XY slitter.

• Turn off the power on the machine
and turn it on after a while.

317 XYSlitter
response error

• A problem was detected
with the response data
from the XY slitter.

318 SDcard Connection
ERR

• A problem was detected
with the SD card.

1. Turn off the power on the machine and
turn it on after a while.

401 Motor X • The X motor was
overloaded.

1. Check to confirm the media is loaded
correctly.  "Loading the
Media"(P. 70)

2. Open the front cover and check for
anything that may obstruct carriage
movement.

3. Turn off the power on the machine and
turn it on after a while.

402 Motor Y • The Y motor was
overloaded.

403 X Current • An overcurrent error was
detected in the X motor.

404 Y Current • An overcurrent error was
detected in the Y motor.

406 Wiper Move Failure • The wiper origin could not
be detected.

• Turn off the power on the machine
and turn it on after a while.

44f Take-up Roll Sns Err • A problem was detected
with the take-up unit
sensor spindle.

1. Check to confirm the [Function Setting]
> [Take-up Unit] setting is "ON".

https://mimaki.com/download/inkjet.html
https://mimaki.com/download/inkjet.html
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Error
number

Message Cause Corrective action

2. Check to confirm the media is loaded
correctly.  "Loading the Roll
Media"(P. 80)

3. Check to confirm the take-up unit switch
functions properly.  "Take-up
unit"(P. 71)

45a Failed Cutter unit joint • The carriage could not be
disconnected.

• Turn off the power on the machine
and turn it on after a while.

45b Failed Cutter unit
detach

• Unable to connect to
carriage

45e Check PR/GR Position • A problem was detected
with the pinch roller
positions.

• Place the pinch rollers above the
grit rollers.

47f Take-up Diameter Max • The take-up unit media
diameter has reached the
maximum value.

1. Replace the paper core in the take-up
unit.

48a Detect winding failure • A problem was detected
with the take-up unit.

1. Check to confirm the [Function Setting]
> [Take-up Unit] setting is "ON".

2. Check to confirm the media is loaded
correctly.  "Loading the Roll
Media"(P. 80)

3. Check to confirm the take-up unit switch
functions properly.  "Take-up
unit"(P. 71)

48b Y MOTOR COM • Y motor communication is
not possible.

• Turn off the power on the machine
and turn it on after a while.

48c Y MTR I2C COM • Y motor communication is
not possible at startup.

48f XYSlitter
MOTOR X

• The X motor of the XY
slitter was overloaded.

1. Lower the XY clamp lever (unclamp).
 "XY Clamp Lever"(P. 143)

2. Check to confirm the media is loaded
correctly.  "Loading the
Media"(P. 150)

3. Check to confirm that the XY slitter X
cutter is correctly mounted. 
"Mounting the X cutter"(P. 157)

4. Raise the XY clamp lever (clamp).
– The origin of the XY slitter will be

detected. If the error message
"ERROR 315 No resp from XY
Slitter" is displayed after origin
detection is attempted, take the
corrective measure for error 315.

491 XYSlitter
X CURRENT

• An overcurrent was
detected in the X motor of
the XY slitter.

490 XYSlitter
MOTOR Y

• The Y motor of the XY
slitter was overloaded.

492 XYSlitter
Y CURRENT

• An overcurrent was
detected in the Y motor of
the XY slitter.

493 XYSlitter
TBar Abnormal

• A problem was detected
with position control of the
XY slitter tension bar.

1. Lower the XY clamp lever (unclamp).
 "XY Clamp Lever"(P. 143)

2. Check to confirm the media is loaded
correctly.  "Loading the
Media"(P. 150)

3. Raise the XY clamp lever (clamp).

494 XYSlitter
TBar Position

495 XYSlitter
TBar Shelter

• The XY slitter tension bar
is still at the retract
position.

1. Lower the XY clamp lever (unclamp).
 "XY Clamp Lever"(P. 143)

2. Check to confirm whether the tension
bar is at the retract position.

8
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Error
number

Message Cause Corrective action

3. Check to confirm the media is loaded
correctly.  "Loading the
Media"(P. 150)

4. Raise the XY clamp lever (clamp).

49f Slit not detected • Slitting feed was
performed with guidelines
without detecting the
slitting marks.

1. Detect the slitting marks.  "Detecting
slitting marks"(P. 167)

2. If the slitting marks cannot be detected
(there are no guidelines), perform
slitting feed without guidelines. 
"Mounting the X cutter and
slitting"(P. 170)

496 Y MOTOR DIR • The Y motor operating
direction cannot be
specified.

• Turn off the power on the machine
and turn it on after a while.

504 CLAMP UP • The clamp lever is lifted. • Lower the clamp lever.

505 Media Jam • The media jam sensor
was triggered.

1. Remove the media in contact with the
carriage and reload with fresh media.

 "Loading the Media"(P. 70)
2. Open the front cover and check for

anything that may obstruct carriage
movement.

509 HDC POSCNT • A problem was detected
with position control.

• Turn off the power on the machine
and turn it on after a while.

50a Y Org Detect Error • A problem was detected
with Y origin detection
(initialization).

50c Check Media With
Sensor

• A problem was detected
with media width
detection.

1. Check the media loading position. 
"Loading the Media"(P. 70)

2. Clean the media width sensor. 
"Media Sensor Cleaning"(P. 214)

50f L-SCALE BLACK • A problem was detected
with the linear scale.

• Turn off the power on the machine
and turn it on after a while.

516 Media Set Position R
(L)

• The media was loaded
outside the range of valid
positions.

1. Check the media loading position. 
"Loading the Media"(P. 70)

2. Clean the media width sensor. 
"Media Sensor Cleaning"(P. 214)

523 Check PR Sensor • The pinch roller position
detection failed.

• Turn off the power on the machine
and turn it on after a while.

525 Wrong Ionizer • The ionizer internal circuit
is defective, or an
abnormal discharge
occurred.

• Turn off the power on the machine
and turn it on after a while.

526 Ionizer Ion Level • The amount of generated
ions was reduced by
fouling and abrasion of the
electrode needle.

• Refer to the instruction manual for
the ionizer and clean the electrodes.

527 Ionizer Condition • Ambient conditions may
cause ions to be absorbed
by metals in the vicinity
and affect discharge
capability.

• Remove any conductors or
discharge devices close to the
ionizer.
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Error
number

Message Cause Corrective action

528 Pump Motor • A problem was detected
with the pump motor.

• Turn off the power on the machine
and turn it on after a while.

546 CLPADJORG SNS • The clamp pressure unit
origin detection failed.

54b Media Press • Media retainer detection
failed.

1. Check the media loading position. 
"Loading the Media"(P. 70)

2. Clean the media width sensor. 
"Media Sensor Cleaning"(P. 214)

54c Vacuum Fan Err • A problem was detected
with the vacuum fan.

• Turn off the power on the machine
and turn it on after a while.

54d HDCE Cooling Fan Err • An HDCE cooling fan
rotation abnormality was
detected.

54e UV-LED Fan Err • A UV-LED cooling fan
rotation abnormality was
detected.

• Turn off the power on the machine
and turn it on after a while.

55A XYSlitter
Y ORIGIN

• A problem was detected
with Y origin detection of
the XY slitter.

• Turn off the power on the machine
and turn it on after a while.

55B XYSlitter
Clamp ON

• Backward Feed was
performed with [MENU] >
[Function Setting] >
[Finisher] set to [XY
Slitter].

• The XY clamp lever was
left up (clamped) with
[MENU] > [Function
Setting] > [Finisher] set
other than to [XY Slitter].

• Use with the XY clamp lever
lowered (unclamped).  "XY
Clamp Lever"(P. 143)

55C XYSlitter
Clamp OFF

• The XY clamp lever was
left down (unclamped)
with [MENU] > [Function
Setting] > [Finisher] set to
[XY Slitter].

• Use with the XY clamp lever raised
(clamped).  "XY Clamp
Lever"(P. 143)

602 Ink End • The ink has run out. • Replace with new ink.  "When
Ink End is Displayed"(P. 47)

604 Check Waste Ink tank • The waste ink tank count
exceeded the preset value
(80%).

1. Check the waste ink levels in the waste
ink tank.  "When "Check Waste Ink
Tank" message appears"(P. 251)

2. Replace the waste ink tank, then reset
the waste ink level.  "Replacing the
Waste Ink Tank"(P. 251)

608 Wrong Ink IC • An error occurred with the
information on the ink IC
chip.

1. Check to confirm the ink IC chip was
inserted correctly.  "Mounting the
ink"(P. 51)

2. Turn off the power on the machine and
turn it on after a while.

3. Replace with new ink.  "Replacing
Ink"(P. 48) 8
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60a Excess Ink Usage • The ink usage amount
stored in the ink IC chip
exceeded the preset
value.

• The ink IC chip was not
replaced during ink
replacement. (The same
chip continued to be
used.)

• The machine was used
with nozzle clogging.

• Replace with new ink.  "When
Ink End is Displayed"(P. 47)

60c Ink Type • The ink type registered on
the IC chip is different
from the ink type filled.

• Insert an ink IC chip for the correct
ink type.  "Mounting the
ink"(P. 51)

61b Ink supply • Ink cannot be supplied. • Turn off the power on the machine
and turn it on after a while.

627 Set Eco-cases • The ink IC chip could not
be read for a certain
period of time.

1. Check to confirm the ink IC chip was
inserted correctly.

2. Turn off the power on the machine and
turn it on after a while.

629 Expiration Near • The ink has expired. • Replace with new ink or use up as
quickly as possible. Printing is
possible.  "When Ink End is
Displayed"(P. 47)

62a Expiration Over • The ink is two months
past its expiration date
and cannot be used.

• Replace with new ink. Printing is not
possible.  "When Ink End is
Displayed"(P. 47)

631 Ink Color • The ink color registered
on the IC chip is different
from the ink color filled.

• Insert an ink IC chip for the correct
ink color.  "Mounting the
ink"(P. 51)

637 INK LEAK _ • The ink leak sensor
detected an ink leak.

• Contact your local distributor, our
sales office, or service center.

650 NCU Connect • A problem was detected
with the NCU connection.

• Turn off the power on the machine
and turn it on after a while.

651 Replace NCU • A problem was detected
with the nozzle clogging
assessment.

• Clean the NCU.  "NCU
Cleaning"(P. 209)

• Replace the NCU if the error does
not clear. Contact your local
distributor, our sales office, or
service center.

652 NCU Nzk Chk (Hw) • A problem was detected
with the nozzle clogging
assessment.

• Clean the NCU.  "NCU
Cleaning"(P. 209)653 NCU Nzk Chk (Mark)

654 NCU Center Pos • Printing position
adjustment failed.655 NCU Flush Pos

656 NCU SN Adjst • Sensor sensitivity
adjustment failed.
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657 Replace NCU Ink Pad • The NCU ink absorber is
full.

• The NCU ink absorber must be
replaced. Contact your local
distributor, our sales office, or
service center.

658 NCU Sensor Lv Low • The sensor's sensitivity is
impaired.

• Clean the NCU.  "NCU
Cleaning"(P. 209)

• Replace the NCU if the error does
not clear. Contact your local
distributor, our sales office, or
service center.

659 Less Supply • There is a problem with
the ink supply.

1. Check to confirm that there is sufficient
ink in the ink pack for the path where
the error occurred.

2. Check to confirm that the ink pack for
the path where the error occurred is not
bent over.

3. Use [Maintenance] > [Ink Supply Maint.]
to check that the error clears.

65b NCU Sens Adj Err H • Sensor sensitivity
adjustment failed.

• Clean the NCU.  "NCU
Cleaning"(P. 209)

• Replace the NCU if the error does
not clear. Contact your local
distributor, our sales office, or
service center.

65c NCU Sens Adj Err L

683 Wiper Near End • The remaining amount of
cloth wiper is low.

• The cloth wiper will run out soon.
Have a new cloth wiper ready.

684 Wiper End • The cloth wiper has run
out.

• Replace with a new cloth wiper. 
"Cloth Wiper Replacement"(P. 228)

702 Thermistor Connect • A problem was detected
with the thermistor
connection.

• Turn off the power on the machine
and turn it on after a while.

703 Heater Brk • A problem was detected
with the heater
temperature.

706 UV Lamp Temp. High • The UV-LED unit became
hot.

• If this occurs frequently, contact
your local distributor, our sales
office, or service center.

707 Head Heater Break • The head heater is
defective. (The
temperature does not rise
even when heated beyond
the stipulated duration.)

• Turn off the power on the machine
and turn it on after a while.

70b DRV OVHT • The UV-DRV PCB
became hot.

710 Heater Temp Error • A problem was detected
with the heater
temperature.

• This error will be automatically
resolved. If the error is not resolved,
Turn off the power on the machine
and turn it on after a while.

711 LED OVHT* • The UV-LED PCB
became hot.

• Turn off the power on the machine
and turn it on after a while.

8
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Error
number

Message Cause Corrective action

715 Ink Heater Therm Brk • The ink heater thermistor
cannot be read properly.

716 Ink Heater Temp • An ink heater temperature
abnormality was detected.

717 InkHeater Brk • The ink heater is
defective. (The
temperature does not rise
even when heated beyond
the stipulated duration.)

71a UV-DRV Fuse • A blown fuse on the UV-
DRV PCB was detected.

• The fuse must be replaced. Contact
your local distributor, our sales
office, or service center.

71e Head Temp Error • A head temperature
abnormality was detected.

• Turn off the power on the machine
and turn it on after a while.

71f Head Therm Break • The head thermistor
cannot be read properly.

753 Ink Heater Temp (HW) • An ink heater temperature
abnormality was detected.

• Turn off the power on the machine
and turn it on after a while.

754 Ink Heater Temp • An ink heater temperature
abnormality was detected
for a specified time.

755 Head Temp Error (HW) • A head temperature
abnormality was detected.

756 Head Temp Error • A head temperature
abnormality was detected
for a specified time.

801 (C) OPCODE • A problem was detected
with the main PCB.

• Turn off the power on the machine
and turn it on after a while.802 (C) SWI

803 (C)PFTCHABRT

804 (C)DATAABRT

806 FW/SIO bit • A communication error
was detected between the
boards.

808 FW/STP-MTR** • A problem was detected
with the main PCB.

80f FW/SIO Vch • A communication error
was detected between the
boards.

811 FW/SIO read • A communication error
was detected between the
boards.

81b FW/STACK OV • A problem was detected
with the main PCB.828 PRG ERR L*****

901 Operation Error • The function is disabled
due to an error.

• Check the error details.
– Media Undetected
– Ink Error
– Waste ink tank, etc.
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Error
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Message Cause Corrective action

902 Data Remain • Print (RIP) data was
received.

• Switch to REMOTE mode and start
printing or clear the data and abort
printing.

90f Print Area Short • The media is too small for
the print.

• Replace with wider or longer media.
• If the printable area is reduced due

to a shift in the origin, move the
origin to increase the size of the
printable area.

b02 PCB CTC • The cutter IO PCB could
not be detected.

• Turn off the power on the machine
and turn it on after a while.

b09 CTC 20pinFFC • A connection error was
detected between the
boards.

b1a PCB BaseIO • A communication error
was detected between the
boards.

• Turn off the power on the machine
and turn it on after a while.

b1b BaseIO PCB Vpow-s • A problem was detected
with the Base IO PCB
power supply.b1c BaseIO PCB V24

b1e PCB BaseIO-F** • The Base IO PCB fuse
blow was detected.

• The fuse must be replaced. Contact
your local distributor, our sales
office, or service center.

b32 INKCT PCB V2R5 • A problem was detected
with the ink supply 2LC
PCB power supply.

– JV/CJV/TS: Firmware
earlier than version 4.0

• Turn off the power on the machine
and turn it on after a while.b3c INKCT PCB V3R3

b36 PCB INKIO • A communication error
was detected between the
boards.

– JV/CJV/TS: Firmware
earlier than version 4.0

b3f BaseIO Unconform • The PCB could not be
detected.

b42 PCB UVD32B • A communication error
was detected between the
boards.

• Turn off the power on the machine
and turn it on after a while.

b46 PCB SubIO • A communication error
was detected between the
boards.

b47 UVD32B PCB Uvpow • A problem was detected
with the UVD32B PCB
power supply.

b48 PCB HDCE • A communication error
was detected between the
boards.

• Turn off the power on the machine
and turn it on after a while.

b49 PCB HDCE-
VHVFET[12]

• A problem was detected
with the HDCE PCB
power supply.

8
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Error
number

Message Cause Corrective action

b4a PCB HDCE*-F* • A blown fuse on the
HDCE PCB was detected.

• Contact your local distributor, our
sales office, or service center.

b4b HDCE* PCB V1R2 • A problem was detected
with the HDCE PCB
power supply.

• Turn off the power on the machine
and turn it on after a while.b4c HDCE* PCB V2R5

b4d HDCE* PCB V3R3

b4e PCB SubIO-F* • A blown fuse on the
SubIO PCB was detected.

• The fuse must be replaced. Contact
your local distributor, our sales
office, or service center.

b4f SubIO PCB Vpow-s • A problem was detected
with the SubIO PCB
power supply.

• Turn off the power on the machine
and turn it on after a while.

b50 SubIO PCB FANPOW • A problem was detected
with the SubIO PCB
power supply.

b51 BaseIO PCB V24adj • A problem was detected
with the Base IO PCB
power supply.

• Turn off the power on the machine
and turn it on after a while.

b53 XY slitter
No slider PCB

• The XY slitter CG
common slider PCB could
not be detected.

• Turn off the power on the machine
and turn it on after a while.

b54 PCB INKIO-F* • A blown fuse on the ink
PCB was detected.

• The fuse must be replaced. Contact
your local distributor, our sales
office, or service center.b62 PCB CutterIO-F* • A blown fuse on the Cutter

IO PCB was detected.

b63 IIO PCB V3R3 • A problem was detected
with the ink supply 2LC
PCB power supply.

– JV/CJV/TS: Firmware
version 4.0 or later

• Turn off the power on the machine
and turn it on after a while.b64 IIO PCB V2R5

C10 Command • Received a code other
than a COMMAND code.

1. Clear the data and resend.
2. Check the USB/Ether cable connection.

 "Connecting a PC to the
Product"(P. 42)

3. Use a compatible cable. 
"Connecting a PC to the Product"(P. 42)

4. Turn off the power on the machine and
turn it on after a while.

C11 Parameter • Received parameter
outside numerical value
range

C12 Device • Received an invalid
device control command.

C31 No Data • "COPY" was executed,
but no data is saved to the
receive buffer.

• Transmit the same data once more.

C32 DataTooBig • The received data is too
big for multiple sheet
cutting.

• Change the data size.

C33 Sheet Size • The sheet is too short in
the feed direction.

• Use a longer sheet.

C36 Mark Detect • Unable to detect register
marks

1. Check to confirm the register marks are
placed properly.  "Register
Marks"(P. 130)

2. Load the uncurled media.
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3. Check the mark detection start position.
4. Check to confirm the register marks are

black and printed on a white
background.

5. Check to confirm the area between the
register marks is clean and free of print.

6. Check to confirm there are no errors in
the mark detection settings.

7. If the area around the register marks is
filled in, set [Mark Detect] > [Mark
FillUp] setting to "ON".

C37 Mark Org • The mark detection result
shows that the register
marks were detected
outside the plotting range.

• Change the layout by referring to
the following:  "Reading Range
of Register Marks"(P. 133)

C38 Register mark scale • Unable to detect register
marks

1. Check to confirm the register marks are
placed properly.  "Register
Marks"(P. 130)

2. Load the uncurled media.
3. Check the mark detection start position.
4. Check to confirm the register marks are

black and printed on a white
background.

5. Check to confirm the area between the
register marks is clean and free of print.

6. Check to confirm there are no errors in
the mark detection settings.

7. If the area around the register marks is
filled in, set [Mark Detect] > [Mark
FillUp] setting to "ON".

C60 PenEncoder • Unable to detect pen
height.

• Turn off the power on the machine
and turn it on after a while.

C61 Pen Stroke • The pen height is
incorrect.

1. Make sure the pen line rubber is not
worn or deformed and remains intact.

2. Check to confirm nothing adheres to the
pen line rubber.

3. After installing the pen in a
commercially available pen holder,
check to confirm the installed position is
correct.

C63 Cutter Head • The cutter vertical
movement is slow.

• Turn off the power on the machine
and turn it on after a while.

d1b COM VOLT[12] • A problem was detected
with the HDCE PCB
voltage.

• Turn off the power on the machine
and turn it on after a while.

SYSTEM HALT

• If a SYSTEM HALT number is displayed, Turn off the power on the machine and turn it on after
a while.
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9.1 Specifications
Item JV330 Series CJV330 Series UCJV330

Series
TS330-1600,
TS330-1800

TS330-1600
TRAPIS

Print
head

Type On-demand piezo head

Specifications Two staggered heads with 400 nozzles × 8 rows each

Resolu
tion

Y 600 dpi, 1,200 dpi 600 dpi, 1,200
dpi

300 dpi, 600
dpi

600 dpi

X 600 dpi, 900 dpi, 1,200 dpi 600 dpi, 1,200
dpi, 1,800 dpi

600 dpi, 900
dpi, 1,200 dpi

900 dpi

Ink Type SS21, BS4, SS22*1 LUS-170/175,
LUS-200,
LUS-190/210

Sb411 TP410*2

Ink set 4-color C, M, Y, K (UISS) C, M, Y, K BL, M, Y, K
(UISS)
-

-

6-color, W C, M, Y, K, Lc, Lm, W - -

6-color - - - • BL, M, Y,
K, Lbl, Lm
(Y, K:
UISS)

• BL, M, Y,
K, FP, FY
(BL, M:
UISS)

-

7-color - - - BL, M, Y, K,
Lbl, Lm, Lk (Y:
UISS)
-

-

8-color C, M, Y, K, Lc, Lm, Lk, Or - • BL, M, Y,
K, Lbl, Lm,
Vi, Or

• BL, M, Y,
K, Lbl, Lm,
FP, FY

• BL, M, Y,
K, Vi, Or,
FP, FY

C, M, Y, K, R,
G, BL, Lk

4-color, W, Cl - - C, M, Y, K, W,
Cl

- -

4-color, W - - C, M, Y, K, W - -

Media Type*3.4 Label paper (paper base), PVC sheet (not more
than 0.25 mm in thickness, including laminating
layer), fluorescent sheet, reflective sheet
(UCJV: excluding high-luminosity reflective
sheet), window film, tarpaulin, flexible
packaging film

Transfer paper Pigment
transfer paper

Maximum
printing width*5

160 size: 1,610 mm
130 size: 1,360 mm

1600 size:
1,610 mm
1800 size:
1,940 mm

1,610 mm
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Item JV330 Series CJV330 Series UCJV330
Series

TS330-1600,
TS330-1800

TS330-1600
TRAPIS

Maximum width 160 size: 1,620 mm
130 size: 1,370 mm

1600 size:
1,620 mm
1800 size:
1,950 mm

1,620 mm

Minimum width 210 mm

Thickness Max. 1.0 mm

Roll external
diameter*6

Paper media: Max. 250 mm
Other media: Max. 210 mm

Max. 250 mm*5

Roll weight*6, 8 Max. 45 kg per roll
Three rolls (feeding unit): Max. 90 kg

Max. 45 kg

Paper core
internal
diameter*9

2 inches or 3 inches

Printing face Exterior/interior Exterior

Roll end Taped or loosely affixed to paper core Wrapped
around the
paper core,
not taped.

Print
margin
s

Left/right 15 mm (default), minimum: Left/right 5 mm

Top end 70 mm (default), minimum: Left/right 10 mm

Bottom end 70 mm (default), minimum: Left/right 10 mm

Distan
ce
accura
cy*10

Absolute
accuracy

±0.3 mm or ±0.3 % of specified distance, whichever is greater

Duplicability ±0.2 mm or ±0.1 % of specified distance, whichever is greater

Perpendicularity ±0.25 mm/1,000 mm

Media skew Not more than 2.5 mm/10 m

Printing gap Manual, three settings (2.0, 2.5, 3.0 mm) Manual, three settings (3.0,
3.5, 4.0 mm)

Clamp pressure Auto switch
(three settings)

Auto switch (four settings)*11 Auto switch (three settings)

Media cutting Cutting precision (steps): Not more than 1.0 mm*12

Origin alignment LED pointer

Ink supply Ink eco-case (ink pack) Ink bottle Ink eco-case (ink pack)

Maintenance liquid feed Cartridge - Cartridge

Waste Ink Tank Bottle type (2,000 ml)

Take-up unit Selectable inside/outside winding Inside winding

Media heater PRE, PRINT, POST
(Independent control)

PRE POST*13

POST1*14

POST2*14

(Independent
control)

POST/PRINT

9
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Item JV330 Series CJV330 Series UCJV330
Series

TS330-1600,
TS330-1800

TS330-1600
TRAPIS

NCU (Nozzle clogging
detection)

Provided

DAS (Automatic
correction function)

Provided

Interior lighting Provided

UV unit - - Air-cooled
LED UV
emitters x2

- -

Interfa
ce

Data transfer
function

Ethernet 1000BASE-T (recommended)*15, 16, USB 2.0 Hi-speed*16, 17

Command MRL-V

Languages English, Japanese, Chinese, Turkish, Portuguese, Spanish, Italian, Korean

Noise
levels

During standby Not more than 45 dB (FAST-A, 1 m on all sides)

Continuous
operation

Not more than 59 dB (FAST-A, 1 m on all sides)

Non-continuous
operation

Not more than 65 dB (FAST-A, 1 m on all sides)

Compliance with
standards

VCCI Class A, FCC Class A, IEC 62368-1 ETL compliance, CE marking (EMC
Directive, Low Voltage Directive, Machinery Directive, RoHS Directive), CB
certified, REACH, EnergyStar, RCM marking, KC certified, UKCA marking

Power supply
specifications*18

Single-phase 100 to 120 V AC
±10 %/12 A,
single-phase 200 to 240 V AC
±10 %/6 A,
50/60 Hz ±1 Hz ×2

Single-phase 100 to 120 V AC ±10 %/12 A,
single-phase 200 to 240 V AC ±10 %/6 A,
50/60 Hz ±1 Hz ×1

Power
consu
mption

Maxim
um*19

Inlet 1 100 to 120 V AC: Max. 1,440 W
200 to 240 V AC: Max. 1,440 W

Inlet 2 100 to 120 V AC: Max. 1,440
W
200 to 240 V AC: Max. 1,440
W

- - 100 to 120 V
AC: Max.
1,440 W
200 to 240 V
AC: Max.
1,440 W

Standa
rd

Inlet 1 800 W

Inlet 2 750 W - - 400 W

Minim
um*20

Inlet 1 4.5 W or less

Inlet 2 -

Installa
tion
enviro
nment*
21

Permissible
ambient
temperature

20 to 30 °C 20 to 25 °C

Relative
humidity

35 to 65 %RH (no condensation) 35 to 45 %RH

Temperature
range in which
accuracy is
guaranteed

20 to 25 °C
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Item JV330 Series CJV330 Series UCJV330
Series

TS330-1600,
TS330-1800

TS330-1600
TRAPIS

Temperature
gradient

Not more than ±10 °C/h

Dust 0.15 mg/m3 (typical office)

Maximum
operating
altitude

2,000 m

Extern
al
dimen
sions*2

2

Width 160 size: 3,170 mm (3,550
mm)
130 size: 2,920 mm (3,300
mm)

160 size:
2,890 mm
(3,550 mm)
130 size:
2,640 mm
(3,300 mm)

1600 size:
3,170 mm
(3,550 mm)
1800 size:
3,500 mm
(3,880 mm)

3,170 mm
(3,550 mm)

Depth 1,215 mm*23 (1,130 mm) 805 mm
(1,130 mm)

820 mm (1,130 mm)

Height 1,305 mm (950 mm) 1,480 mm*24

(950 mm)

1,305 mm
(950 mm)

Weight
*22

130 size 358 kg (453
kg)

363 kg (458
kg)

217 kg (300
kg)

- -

160 size 368 kg (460
kg)

373 kg (468
kg)

227 kg (310
kg)

240 kg (300
kg)

240 kg (300
kg)

180 size - - - 250 kg (310
kg)

-

9
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*1. When using SS22 ink, use firmware version 4.0 or later.
*2. The OPT-J0562 "TP-Ink Heater Unit 1600" option must be installed when using the TP410 ink set.
*3. The XY slitter is limited to the types of media that can be used with it.  "Specifications (XY

Slitter)"(P. 302)
*4. Media with low stiffness is more likely to adhere to the platen, preventing correct media transportation, and

possibly causing media jamming. For details of how to prevent this, refer to  "The media adheres to the
platen, preventing it from being transported correctly."(P. 266). Perform test prints in advance with the
same printing conditions to confirm correct transportation of the media and the presence of any image
defects.

*5. With setup menu margins set to the minimum (5 mm) on either side.
*6. External diameter and weight after winding media.
*7. 120 to 200 mm when the (take-up unit) media edge guide is used (depending on the position of the edge

guide).
*8. Free of sagging due to weight.
*9. 3 inch only for high-speed printing.

*10. Excluding media size variation and initial loading fluctuations.
*11. Partial switch supported. Including clamp off.
*12. Excluding V-shaped cutting.
*13. TS330-1600 only
*14. TS330-1800 only
*15. Printing is not possible if local guidance shows any speed other than "1000Mbps".  "Using a LAN

Cable"(P. 42)
*16. The print speed may be decreased depending on the connection environment or print data. 

"Connecting a PC to the Product"(P. 42)
*17. Data may be transferred to the machine too slowly, causing the carriage to pause at the left-hand or right-

hand end during printing.
*18. Excluding options.
*19. Varies depending on print mode.
*20. In sleep.
*21. If the installation environment does not satisfy the requirements, there is a risk of poor ink ejection

consistency or media transport stability. In particular, when performing high-density printing on roll media
at low ambient temperatures, the media may lift up (wrinkles) due to shrinkage.

*22. The figures in parentheses indicate package dimensions. Excluding the external supply unit.
*23. Excluding the media chute.
*24. Excluding the ink bottles.
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9.2 Specifications (Cutting)
Item Details

Maximum speed*1 300 mm/s (420 mm/s at 45 °)

Maximum acceleration 0.5 G

Cut pressure 10 to 450 gf

Cutter response count 10 times/second

Usable tools Eccentric cutter, ballpoint pen (commercially sold)*2

Usable media Label paper (paper base), PVC sheet*3 (not more than 0.25 mm in
thickness, including laminating layer), fluorescent sheet*4, reflective sheet*4

(excluding high-luminosity reflective sheet)

Repetition accuracy ±0.2 mm or less (excluding expansion and contraction due to temperature)

Receive buffer memory 32 MB

Command MGL-II c2

Program steps 25 μm/step

*1. Depending on media size, the maximum speed may be limited. It is not possible to operate at both
maximum speed and maximum acceleration.

*2. Use one free of protrusions and tapers on the clamped part. Depending on the ballpoint pen, optimal
image quality may not be possible.

*3. When using Mimaki Engineering specified sheet
*4. When using fluorescent sheet blade (SPB-0007) or reflective sheet blade (SPB-0006)

9
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9.3 Specifications (XY Slitter)
Item Details

Cutting accuracy*1 X slit Within ±2 mm/2 m or ±5 mm/30 m

Y slit Within ±2 mm

Cutter blade durability X 4000 m or more

Y 5500 m or more

Media Type* 2, 3 Label paper (paper base), PVC sheet, window film

Thickness Max. 1.0 mm

Maximum cutting width 130 size: 1,310 mm
160 size: 1,560 mm

Minimum cutting width 210 mm (horizontally) × 297 mm (vertically)

Left/right margins Minimum values: Left 25 mm, right 35 mm

Margin between cut
data

Minimum values: X 62 mm, Y 30 mm

*1. Excluding media size variation and fluctuations at initial loading.
*2. Low stiffness media cannot be used.
*3. Tarpaulin and laminated media cannot be used.

Clamp position

Y slit mark

Cut line

Guide lines (X cutter position)

Max. 1,560 mm

Min. 35 mm

Min. 25 mm Min. 35 mmMin. 25 mm Min. 30 mm

Min. 210 mm

M
in

. 2
97

 m
m

Min. 62 mm Min. 62 mm
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9.4 Options
l Compatibility table

Name Code JV CJV TS UCJ
V

Reference page

Small Relay Box OPT-J0370 ○ ○ ○ ○  "Relay Box"(P. 304)

Relay Box 2 OPT-J0407 ○ ○ ○ ○  "Relay Box"(P. 304)

XY slitter 160: OPT-J0558
130: OPT-J0559

Stan
dard

Stan
dard

- ○  "Using the XY Slitter"(P. 141)

X Slitter Unit OPT-J0532 ○ ○ -  "X Cutter"(P. 144)

Media Changer 160: OPT-J0556
130: OPT-J0557

Stan
dard

Stan
dard

- ○  "Media Changer"(P. 78)

Media Edge Guides OPT-J0553 ○ ○ Stan
dard

○  "Media Edge Guide Film
Replacement"(P. 248)

10 kg ink supply unit OPT-J0529
OPT-J0575

- - ○ - Separate operating manual
(D203605)

T Bar 1600 Unit OPT-J0530 - - ○*1 - Separate operating manual
(D203635)

T Bar 1800 Unit OPT-J0479 - - ○*2 - Separate operating manual
(D203325)

Mini Jumbo Unit OPT-J0477 - - ○ - Separate operating manual
(D203635)

Electrical Box (for Mini-
Jumbo)

OPT-J0480 - - ○ -

 Ionizer 160: OPT-J0545
130: OPT-J0546

○ ○ - ○  "Ionizer"(P. 305)

 Static-Cling
Prevention Sheet Kit

160: OPT-J0549
130: OPT-J0550

○ ○ - ○  "Static-Cling Prevention
Sheet Kit"(P. 308)

 Deodorizing fan
unit

160: OPT-J0540
130: OPT-J0541

○ ○ - ○  "Deodorizing fan unit"(P. 311)

 Proofing Light 160: OPT-J0547
130: OPT-J0548

- - - ○  "Proofing Light"(P. 317)

 UCJV330 Heater
Unit

160: OPT-J0560
130: OPT-J0561

- - - ○  "UCJV330 Heater
Unit"(P. 319)

 TP Ink Heater Unit OPT-J0562 - - ○*1 -  "TP Ink Heater Unit"(P. 322)

*1. TS330-1600 only
*2. TS330-1800 only

9
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Relay Box

• A fire may occur if another manufacturer's external drying heater is used. Be sure to connect to
the machine using either the compact relay box or relay box 2 specified as options.

• The 330 Series allows only one relay box (OPT-J0370 or OPT-J0407) to be connected.

• The optional connection relay cable (OPT-J0512 drying fan connection kit) is required when
using a relay box.

l Overview
The relay box switches the heater power on and off automatically in conjunction with the machine
operations.

• The heater is turned off when printing stops to prevent heating while the machine is not moving.
• The relay box cannot function to control the temperature of an external drying heater. The temperature

should be set on the external heater itself.

l Specifications
Small relay box (OPT-J0370) Power

supply
specificatio

ns

Single-phase 100 V to 120 V AC, 12 A, single-phase
200 V to 240 V AC, 8 A, 50/60 Hz, single-circuit main
power supply

Type Resistance heater or electric heater using lamp

Relay box 2 (OPT-J0407) Power
supply

specificatio
ns

Single-phase 100 V to 240 V AC, 30 A, 50/60 Hz,
single-circuit main power supply

Type Resistance heater or electric heater using lamp
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Ionizer

CJV UCJVJV
Be sure to read and understand the following information before use.

l Before use
• The machine prints while the ionizer removes static electricity from media. The electrode probes are not

on unless the machine is printing.
• May not be sufficiently effective in removing static electricity in certain environments or for certain media.
• We recommend checking to ensure that static electricity has been sufficiently removed before use.

• Make sure you fully understand the following details. The same precautions apply to optional
items.
(1)  "Introduction"(P. 7)
(2)  "To Ensure Safe Use"(P. 9)
(3)  "Installation Precautions"(P. 19)

• This is a high-voltage device. Avoid exposure to substances such as water, oil, or flammable
solvents. Failure to follow this precaution may cause insulation breakdown and pose a risk of
mechanical failure or electric shock.

• Keep metal objects and body parts such as face and hands away from the ionizer. This may
pose a risk of failure or electric shock.

• Always use ventilation. If the ionizer is used in an enclosed area, the ozone generated may be
harmful.

• Do not touch the electrode probes with tools or other hard objects. This may pose a risk of
failure or electric shock.

• Clean periodically. As the ionizer is used, dust, ink, and the like will adhere to the electrode
probes. Continuing to use the ionizer in this state may make it less effective at removing static
electricity and may result in failure or electric shock.

• Never attempt to repair the machine yourself, which is hazardous. This may pose a risk of
failure or electric shock. In case of abnormalities, contact your local dealer or our service office.

• Do not use where the temperature may change suddenly or where condensation may occur.
• Do not use for purposes other than removing static electricity.

• Be careful not to touch the electrode probes. There is a risk of injury from the tips, which are
sharp.

Using the Ionizer

l Enable use of the ionizer

1 On the LOCAL mode screen, select [MENU] > [Function Setting], then press the [ENTER] key.

• The Function Setting menu is displayed.

2 Select [Ionizer] > [ON], then press the [ENTER] key.

9
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l How to use
Tilt the ionizer on the back of the printer so that it rests at the stopping position.

l Maintenance
Before printing, examine the electrode probes and clean off any dirt.

• Turn off the main power supply and unplug the power cable before carrying out maintenance.

1 Remove the electrode probes from the ionizer.

• Using the included replacement kit enables easy removal.

Replacement kit

2 Wipe off the electrode probes and the area around them with a cotton swab soaked in alcohol.

• Recommended: Ethyl alcohol, isopropyl alcohol

• Use an ultrasonic bath if especially dirty. Industrial alcohol can also be used as a cleaning
solution.

• After cleaning, dry well before reattaching to the ionizer. Any liquid remaining on the
probes may cause failure or electric shock.

Ionizer indicator light (alarm function)

Indicator light
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Indicator
light

Ionizing
status

Error display Cause Corrective action

Flashes
three times
every
second

Stoppe
d

Error 525
Wrong 
Ionizer

• Defective internal circuit.
• Abnormal electrical

discharge.

• Contact your local dealer or
our service office.

Flashes
about
twice per
second

Continu
ous

Error 526
Ionizer 
Ion Level

• Lower ion generation due
to fouling or abrasion of
the electrode probes.

• This is a sign that
electrode probe cleaning
is needed.

• Clean the electrode probes.
• If the problems persist,

replace the corresponding
probes.

– SPA-0208 replacement
tungsten probes for ionizer
(includes 4)

Flashes
about once
per second

Continu
ous

Error 527
Ionizer 
Condition

• Removal of static
electricity has been
affected by the installation
environment (temperature,
humidity, nearby metal,
etc.).

• Investigate the environment
and nearby metal.

9
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Static-Cling Prevention Sheet Kit

CJV UCJVJV

l Kit contents
• 160 size

– Electrostatic sheets: 4, brackets: 4, springs: 12, adhesive tape
• 130 size

– Electrostatic sheets: 3, brackets: 3, springs: 9, adhesive tape

l When using an electrostatic sheet (loading instructions)

1 Hook the tab of the antistatic sheet onto the bracket and pull downward slightly.

3

2
1

2 Keep the sheet taut as you bring it to the front of the platen.

3 Hook the tab into the groove in front of the platen.

• There are three tabs on the sheet.

4 Make sure the sheet bracket is magnetically held to the bottom of the post-heater.
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5 Apply adhesive tape over the platen and sheet.

• When applying the tape, make sure it does not extend over the platen cutting slot.
• Avoid wrinkles or slack in the tape as you apply it from one end of the platen to the other.

Adhesive tape

Adhesive tape Cutting slot

l When the sheet will not be used (unloading instructions)

1 Remove the sheet from the bracket attached to the bottom of the printer.

2

1

2 Push the sheet toward the platen as you remove it.

• After removing the sheet from the machine, store it separately in a safe place.
• Leave the bracket magnetically attached to the bottom of the post-heater.

Troubleshooting

l Spring and brackets have come off.
Attach from the back of the printer.

9



Chapter 9 Appendix

310

1 Remove the spring from the printer.

2 Reattach the spring to the bracket.

3 Reattach to the printer.
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Deodorizing fan unit

CJV UCJVJV
Be sure to read and understand the following information before use.

Deodorizing fan unit

Deodorizing fan unit
electrical box

Duct hose

l Before use
• The filter should be replaced approximately once a year. Replace the filter sooner if a large amount of ink

has accumulated on it.
• When opening the left-hand maintenance cover, either adjust the angle of the duct hose or remove the

duct hose.
– Removing the duct hose  "Using the deodorizing fan unit"(P. 313)

• (CJV/UCJV) Pull the media to the front slightly before starting cutting.
• The duct hose extends to a maximum length of approximately 3 m.

• Make sure you fully understand the following details. The same precautions apply to optional
items.
(1)  "Introduction"(P. 7)
(2)  "To Ensure Safe Use"(P. 9)
(3)  "Installation Precautions"(P. 19)

9
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• This is a high-voltage device. Avoid exposure to substances such as water, oil, or flammable
solvents. Failure to follow this precaution may cause insulation breakdown and pose a risk of
mechanical failure or electric shock.

• Use the power cable provided. Otherwise there is a risk of deodorizing fan unit failure, electric
shock, or fire. The power cable cannot be used with electrical equipment other than the
deodorizing fan unit.

• Never attempt to repair the machine yourself, which is hazardous. This may pose a risk of
failure or electric shock. In case of abnormalities, contact your local dealer or our service office.

• Perform the following when turning off power:
(1) Turn off the power to the printer.
(2) Turn off the power to the deodorizing fan unit.
(3) Disconnect all of the power cables connected to the printer.
(4) Unplug the deodorizing fan unit power cable from the power outlet.

• Do not use where the temperature may change suddenly or where condensation may occur.

• A number of different power cables are provided with the product. Use the power cable to suit
the region where used.

Japan

Rated input: 15 A, 125 V
Type: B

China

Rated input: 10 A, 250 V
Type: D

North America, Central
America

Rated input: 15 A, 125 V
Type: B

Europe

Rated input: 10 A, 250 V
Type: D

Argentina

Rated input: 10 A, 250 V
Type: D

• The end of the duct hose is extremely sharp. Always wear gloves.

l Warning Label
Make sure you fully understand the details indicated on the various warning labels.
If any of the warning labels becomes dirty and illegible or peel off, contact your local dealer or our service
office to request new warning labels.

No. Order code Label Details

1 M911354 Unplug all of the power cables when
turning off the power.
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l Check the power cable connection

1 Check to confirm that the power cable is connected to the deodorizing unit inlet.

2 Check to confirm that the power plug is connected to the power outlet.

Power plug

Power outlet

• Do not handle the power plug with wet hands. Disregarding this precaution may result in
electric shock.

l Check the main unit connection

1 Check to confirm that the cable (D-sub) is connected to the printer.

Upside

Using the deodorizing fan unit

l Enable the deodorizing fan unit

1 On the LOCAL mode screen, select [MENU] > [Function Setting], then press the [ENTER] key.

• The Function Setting menu is displayed.

2 Select [Drying/Exhaust Fan] > [ON], then press the [ENTER] key.

•  "Function Setting Menu"(P. 189)  P. 190

9
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l Adjust the deodorizing level
Adjust the deodorizing level to suit the usage environment, the type of media, and the print data.

l Extend the deodorizing time
The deodorizing fan operates while printing is in progress. Set as follows to operate the deodorizing fan even
after printing has ended:

1 On the LOCAL mode screen, select [MENU] > [Function Setting], then press the [ENTER] key.

• The Function Setting menu is displayed.

2 Select [Drying/Exhaust Fan] > [Stop Time], then set the time until it stops.

•  "Function Setting Menu"(P. 189)  P. 190

l Operating the deodorizing fan when printing is not in progress
Set as follows to operate the deodorizing fan when printing is not in progress:

1 On the LOCAL mode screen, select [MENU] > [Function Setting], then press the [ENTER] key.

• The Function Setting menu is displayed.

2 Select [Drying/Exhaust Fan] > [ON/OFF].

•  "Function Setting Menu"(P. 189)  P. 190

l Using the roll screen
Using the roll screen when printing can help to prevent odors spreading.

Roll screen

Roll screen spindle rest
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When not in use, the roll screen can be rolled up and stowed at the front.

l Removing the duct hose

1 Remove the plastic point screw.

Plastic point screw

2 Detach the slots, and slowly remove the duct hose.

Slot

9
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Specifications (deodorizing fan unit)

Item 160 size 130 size

Power supply specifications Single-phase 100 to 240 V AC ±10 %/1.4 A, 50/60 Hz ±1 Hz

Power
consumpti
on

Max Inlet 100 to 120 V AC: Max. 140 W, 200 to 240 V AC: Max. 140 W

Standar
d

Inlet 50 W

External
dimension
s*1, 2

Width 1,915 mm (1,980 mm) 1,650 mm (1,980 mm)

Depth 400 mm (325 mm)

Height 270 mm (285 mm)

Weight*1 20 kg (21 kg) 19 kg (20 kg)

*1. The figures in parentheses indicate package dimensions.
*2. Excluding the duct hose.
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Proofing Light

UCJV
Be sure to read and understand the following information before use.

l Before use

• Make sure you fully understand the following details. The same precautions apply to optional
items.
(1)  "Introduction"(P. 7)
(2)  "To Ensure Safe Use"(P. 9)
(3)  "Installation Precautions"(P. 19)

• This is a high-voltage device. Avoid exposure to substances such as water, oil, or flammable
solvents. Failure to follow this precaution may cause insulation breakdown and pose a risk of
mechanical failure or electric shock.

• Use the power cable provided. Otherwise there is a risk of proofing light failure, electric shock,
or fire. The power cable cannot be used with electrical equipment other than the proofing light.

• Never attempt to repair the machine yourself, which is hazardous. This may pose a risk of
failure or electric shock. In case of abnormalities, contact your local dealer or our service office.

• Do not use where the temperature may change suddenly or where condensation may occur.

• A number of different power cables are provided with the product. Use the power cable to suit
the region where used.

Japan

Rated input: 15 A, 125 V
Type: B

China

Rated input: 10 A, 250 V
Type: D

North America, Central
America

Rated input: 15 A, 125 V
Type: B

Europe

Rated input: 10 A, 250 V
Type: D

Argentina

Rated input: 10 A, 250 V
Type: D

l Check the AC adapter connection

1 Check to confirm that the AC adapter plug is connected to the DC jack.

2 Check to confirm that the power plug is connected to the power outlet.

Power plug

Power outlet

• Do not handle the power plug with wet hands. Disregarding this precaution may result in
electric shock.

9
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Using the proofing light

1 Turn on the power to the light

• Turn the power switch to "I".

[Brightness dial]

Power Supply
Switch

DC jack

High Low

2 Adjust the brightness.

• Turn the "Brightness dial" to the right of the proofing light to adjust the brightness.

• To adjust the brightness while printing is in progress, load the media so that it does not
cover the "Brightness dial".  "Loading the Media"(P. 70)

l Maintenance
Clean if it becomes dirty.

• Turn off the main power supply and unplug the power cable before carrying out maintenance.

• Be careful to prevent liquids from getting inside the machine. Otherwise there is a risk of failure,
electric shock, or fire.

• For heavy soiling, wipe using a soft cloth soaked in diluted neutral detergent and thoroughly
wrung out.



Chapter 9 Appendix

319

UCJV330 Heater Unit

UCJV
Be sure to read and understand the following information before use.

l Before use

• Make sure you fully understand the following details. The same precautions apply to optional
items.
(1)  "Introduction"(P. 7)
(2)  "To Ensure Safe Use"(P. 9)
(3)  "Installation Precautions"(P. 19)

• This is a high-voltage device. Avoid exposure to substances such as water, oil, or flammable
solvents. Failure to follow this precaution may cause insulation breakdown and pose a risk of
mechanical failure or electric shock.

• Use the power cable provided. Otherwise there is a risk of heater unit failure, electric shock, or
fire. The power cable cannot be used with electrical equipment other than the heater unit.

• Never attempt to repair the machine yourself, which is hazardous. This may pose a risk of
failure or electric shock. In case of abnormalities, contact your local dealer or our service office.

• Do not use where the temperature may change suddenly or where condensation may occur.

• A number of different power cables are provided with the product. Use the power cable to suit
the region where used.

Japan

Rated input: 15 A, 125 V
Type: B

China

Rated input: 10 A, 250 V
Type: D

North America, Central
America

Rated input: 15 A, 125 V
Type: B

Europe

Rated input: 10 A, 250 V
Type: D

Argentina

Rated input: 10 A, 250 V
Type: D

l Warning Label
Make sure you fully understand the details indicated on the various warning labels.
If any of the warning labels becomes dirty and illegible or peel off, contact your local dealer or our service
office to request new warning labels.

No. Order code Label Details

1 M903239 Indicates hot parts.

9
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l Check the power cable connection

1 Check to confirm that the power cable is connected to the heater unit inlet.

• There are two inlets for optional heaters on the right side of the main unit.

2 Check to confirm that the power plug is connected to the power outlet.

Power plug

Power outlet

• Do not handle the power plug with wet hands. Disregarding this precaution may result in
electric shock.

Using the heater

l Turn on the heater power
Turn the heater power switch to "I".

• Power switch 2: For preheater/print heater
• Power switch 3: For post-heater

Power switch 2

Power switch 3

l Setting procedure
Refer to the following:

•  "Setting the Heater Temperature"(P. 95)
•  "Media Setting Menu"(P. 180)  P. 181
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• The recommended heater temperatures are as follows: PRE: 50 °C, PRINT: 45 °C, POST: 60
°C. 
Alter the settings appropriately to suit the print conditions (ink and media used) to prevent media
feeding problems occurring.

l Troubleshooting
Refer to the following:

•  "The heater temperature does not rise to the specified value."(P. 271)
•  "Problems Causing Messages to Appear"(P. 279)

Specifications (UCJV330 Heater Unit)

Item 160 size 130 size

Power supply specifications Single-phase 100 to 120 V AC ±10 %/12 A, single-phase 200 to 240 V AC
±10 %/6 A, 50/60 Hz ±1 Hz ×1

Power
consumpti
on

Max Inlet 2 100 to 120 V AC: Max. 1,440 W, 200 to 240 V AC: Max. 1,440 W

Inlet 3 100 to 120 V AC: Max. 1,440 W, 200 to 240 V AC: Max. 1,100 W

Standar
d

Inlet 2 650 W

Inlet 3 350 W

Available
temperatur
e setting

PRINT 20 °C to 50 °C

POST 20 °C to 60 °C

*1. The figures in parentheses indicate package dimensions.

9
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TP Ink Heater Unit

TS
This option is only available for the TS330-1600. 
Be sure to read and understand the following information before use.

l Before use

• Make sure you fully understand the following details. The same precautions apply to optional
items.
(1)  "Introduction"(P. 7)
(2)  "To Ensure Safe Use"(P. 9)
(3)  "Installation Precautions"(P. 19)

• This is a high-voltage device. Avoid exposure to substances such as water, oil, or flammable
solvents. Failure to follow this precaution may cause insulation breakdown and pose a risk of
mechanical failure or electric shock.

• Use the power cable provided. Otherwise there is a risk of heater unit failure, electric shock, or
fire. The power cable cannot be used with electrical equipment other than the heater unit.

• Never attempt to repair the machine yourself, which is hazardous. This may pose a risk of
failure or electric shock. In case of abnormalities, contact your local dealer or our service office.

• Do not use where the temperature may change suddenly or where condensation may occur.

• A number of different power cables are provided with the product. Use the power cable to suit
the region where used.

Japan

Rated input: 15 A, 125 V
Type: B

China

Rated input: 10 A, 250 V
Type: D

North America, Central
America

Rated input: 15 A, 125 V
Type: B

Europe

Rated input: 10 A, 250 V
Type: D

Argentina

Rated input: 10 A, 250 V
Type: D

l Warning Label
Make sure you fully understand the details indicated on the various warning labels.
If any of the warning labels becomes dirty and illegible or peel off, contact your local dealer or our service
office to request new warning labels.

No. Order code Label Details

1 M906144 Indicates hot parts.
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l Check the power cable connection

1 Check to confirm that the power cable is connected to the heater unit inlet.

2 Check to confirm that the power plug is connected to the power outlet.

Power plug

Power outlet

• Do not handle the power plug with wet hands. Disregarding this precaution may result in
electric shock.

l Media path
Understanding the media path before loading will make loading easier. 
The media path when the media is loaded is shown in the following figure.

Media path

For details of how to load roll media, refer to  "Loading the Roll Media"(P. 80).

9



Chapter 9 Appendix

324

Using the heater

l Turn on the heater power
Turn the heater power switch to "I".

• Power switch 2: For print heater/post heater

Power switch 2

l Setting procedure
Refer to the following:

•  "Setting the Heater Temperature"(P. 95)
•  "Media Setting Menu"(P. 180)  P. 181

l Troubleshooting
Refer to the following:

•  "The heater temperature does not rise to the specified value."(P. 271)
•  "Problems Causing Messages to Appear"(P. 279)

Specifications (TP Ink Heater Unit)

Item TS330-1600

Power supply specifications Single-phase 100 to 120 V AC ±10 %/12 A, single-phase 200 to 240 V AC
±10 %/6 A, 50/60 Hz ±1 Hz ×1

Power
consumpti
on

Max Inlet 2 100 to 120 V AC: Max. 1,440 W, 200 to 240 V AC: Max. 1,440 W

Standar
d

Inlet 2 400 W

Available
temperatur
e setting

PRINT 20 °C to 50 °C
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9.5 LICENSE Library
Mimaki printer Firmware

Copyright @2020 MIMAKI ENGINEERING CO.,LTD. All rights reserved.

This product contain open source software listed in the tables below.

Component License

StarterWare for ARM® based TI Sitara Processors BSD-TI

The following license terms and conditions shall apply to the open source software listed in the table above:
BSD-TI
Copyright (C) 2010 Texas Instruments Incorporated - http://www.ti.com/

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the

following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the

following disclaimer in the documentation and/or other materials provided with the distribution.
3. Neither the name of Texas Instruments Incorporated nor the names of its contributors may be used to

endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

9
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Index
Icons

Post-heater 1, Post-heater 2 ..........................................................................................................................  95

A

Adj-prs Offset .......................................................................................................................................  197, 275

Adjust Waste Ink Volume .............................................................................................................................  251

Air PG.............................................................................................................................................  98, 186, 264

Auto Cleaning...............................................................................................................................................  186

Auto Maint. .......................................................................................................................................  28, 29, 185

Auto Media Cut.............................................................................................................................................  197

Auto Nozzle Recovery..................................................................................................................................  185

Auto Power-off..............................................................................................................................................  189

Auto Power-on..............................................................................................................................................  189

Auto Remote ................................................................................................................................................  191

Auto-correction (DAS) ..........................................................................................................................  180, 280

B

Blowing fan.............................................................................................................................  30, 203, 220, 239

Bottle cap ...........................................................................................................................................  55, 56, 57

C

Cancel ............................................................................................................................................................  35

Cap.................................................................................................................................  32, 203, 204, 206, 232

Cap absorber................................................................................................................................................  234

Cap Replacement.........................................................................................................................................  184

Capping Use Days .......................................................................................................................................  194

Carriage..............................................................................................................  28, 32, 35, 184, 203, 204, 207

Carriage Out .................................................................................................................................................  184

Clamp lever ..............................................................................................................................................  28, 30

Clamp pressure ............................................................................................................................................  182

Cleaning .................................................................................................................................................  98, 184

Color profile ....................................................................................................................................................  45

Connection relay cable.................................................................................................................................  304

Copy .............................................................................................................................................  196, 198, 292

Corner Cut ............................................................................................................................................  197, 199

Curve Mode..................................................................................................................................................  197

Custody Wash ..............................................................................................................................  184, 222, 224

Cut Mode......................................................................................................................................................  196

Cutter for Cutting Machine ...........................................................................................................................  257
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Cutter unit .......................................................................................................................................................  28

Cutting Menu ................................................................................................................................................  195

Cutting slot .....................................................................................................................................................  32

D

DAS (Dot Adjustment System) .............................................................................................  180, 203, 204, 211

Delete MediaInfo ..........................................................................................................................................  183

Deodorizing fan unit .............................................................................................................................  190, 311

Detail Setting ................................................................................................................................................  182

Detect Area ..................................................................................................................................................  195

Detect End Key Start ....................................................................................................................................  195

DISCLAIMERS .................................................................................................................................................  7

Display......................................................................................................................................................  35, 36

Display language..........................................................................................................................................  192

Drop.PosCorrect.......................................................................................................................  38, 64, 101, 180

Dropouts .........................................................................................................................................  98, 186, 264

Drying Time ..................................................................................................................................................  189

Drying/Exhaust Fan......................................................................................................................  190, 313, 314

Dummy cut ...................................................................................................................................................  196

E

Ejection failures ................................................................................................  96, 98, 184, 186, 208, 232, 260

[END/POWER] key.............................................................................................................................  34, 35, 40

[ENTER] key...................................................................................................................................................  35

Environment Setting Menu ...........................................................................................................................  192

Error........................................................................................................................................................  35, 279

Error History .................................................................................................................................................  194

Exhaust fan box......................................................................................................................................  30, 238

F

FCC ..................................................................................................................................................................  8

Feed Comp.........................................................................................................................  38, 64, 99, 180, 181

Feed Speed..................................................................................................................................................  182

Feeding Before Cut ......................................................................................................................................  190

Feeding unit..............................................................................................................................................  30, 78

FineCut .........................................................................................................................................................  135

Finisher.........................................................................................................................  150, 165, 166, 191, 284

Front cover .....................................................................................................................................................  29

[FUNCTION] key ......................................................................................................................................  35, 38

Function Setting Menu .................................................................................................................................  189

G
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Grit roller.............................................................................................................................................  28, 33, 67

H

Half Cut ................................................................................................................................................  122, 257

Head Cleaning................................................................................................................................................  35

Head height ....................................................................................................................................................  65

Heater...........................................................................................................................  28, 30, 34, 95, 181, 271

Heater unit ....................................................................................................................................................  319

Height adjustment lever..................................................................................................................................  65

High Power.....................................................................................................................................................  98

I

ID Cut Guide.........................................................................................................................................  134, 138

ID Cut ...................................................................................................................................................  133, 138

Illumination ...................................................................................................................................................  191

Ink absorber ...........................................................................................................................................  49, 249

Ink bottle .......................................................................................................................................  31, 54, 56, 58

Ink caps ..........................................................................................................................................................  54

Ink discharge channel ..................................................................................................................  203, 204, 212

Ink Eco-case.................................................................................................................................  31, 48, 50, 51

Ink End ...................................................................................................................................................  47, 186

Ink Error..........................................................................................................................................................  37

Ink IC chip ..................................................................................................................  31, 48, 49, 52, 55, 58, 59

Ink IC chip slot ....................................................................................................................................  31, 52, 58

Ink leak check tube.........................................................................................................................................  31

Ink lever ..........................................................................................................................................................  31

INK NEAR-END..............................................................................................................................................  47

Ink pack ....................................................................................................................................................  48, 49

Ink replacement ............................................................................................................................................  194

Ink status ........................................................................................................................................................  36

Ink Supply Error............................................................................................................................................  186

Ink Supply Maint. ..........................................................................................................................................  186

Ink Supply Unit .................................................................................................................................  31, 49, 249

Ink wipe pad .............................................................................................................................................  31, 55

Inlet...................................................................................................................................  30, 39, 313, 320, 323

Installation guide ......................................................................................................................................  45, 46

Installation Space ...........................................................................................................................................  20

Interference ......................................................................................................................................................  7

Interlocks ........................................................................................................................................................  22

Interval Wiping..............................................................................................................................................  186

Ionizer...........................................................................................................................................................  305
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J

Jam sensor .............................................................................................................................  28, 203, 204, 217

[JOG] key .......................................................................................................................................................  35

Judgment Condition .....................................................................................................................................  185

K

Key Buzzer ...................................................................................................................................................  192

KeyLife .........................................................................................................................................................  193

L

LAN cable.................................................................................................................................................  30, 42

LAN port .........................................................................................................................................................  30

LANGUAGE .................................................................................................................................................  192

Light-blocking cover .........................................................................................................................  31, 54, 271

List ................................................................................................................................................................  194

Local guidance ...............................................................................................................................................  38

LOCAL mode............................................................................................................................................  35, 36

Logical Seek.................................................................................................................................................  189

M

Machine Status Menu...................................................................................................................................  194

Main power switch..............................................................................................................................  30, 34, 39

Maintenance.................................................................................................................................................  194

Maintenance cover .........................................................................................................................................  28

Maintenance History.....................................................................................................................................  194

Maintenance liquid absorber ........................................................................................................................  234

Maintenance liquid cartridge ..........................................................................................................................  30

Maintenance Menu.......................................................................................................................................  184

MAPS (Mimaki Advanced Pass System) .....................................................................................................  181

Margin ..................................................................................................................................................  133, 190

Mark Detect ..................................................................................................  131, 133, 136, 137, 195, 292, 293

Mark FillUp ...................................................................................................................................................  195

Marks Sensor .......................................................................................................................  142, 197, 273, 274

Media..............................................................................................................................................................  70

Media Changer ...............................................................................................................................................  30

Media Chute .........................................................................................................................  142, 145, 146, 148

Media cutter....................................................................................................................  28, 203, 204, 215, 243

Media Edge Guides..........................................................................................................................  29, 74, 248

Media feed......................................................................................................................................................  35

Media guides ................................................................................................................................................  142

Media holder.........................................................................................................................  203, 204, 216, 241

Media Information.........................................................................................................................................  182
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Media Name Change ...................................................................................................................................  182

Media Operation Form .................................................................................................................................  182

Media Remain ..............................................................................................................................................  182

Media Sensor ...................................................................................................................  30, 33, 203, 204, 214

Media Setting Menu .....................................................................................................................................  180

Media stopper...........................................................................................................................................  76, 79

Media Width .................................................................................................................................................  182

MENU mode...................................................................................................................................................  36

Mimaki driver ..................................................................................................................................................  45

MIST FILTER................................................................................................................................  204, 219, 254

MRA (Mimaki Remote Access).....................................................................................................................  192

Multi-layer printing ..........................................................................................................................................  93

N

NCU (Nozzle Check Unit).......................................................................................................  32, 203, 204, 209

Network ........................................................................................................................................................  192

NOT-READY mode ........................................................................................................................................  36

Nozzle Check .......................................................................................................................................  184, 188

Nozzle clogging ......................................................................................................................................  98, 188

Nozzle Deflection ...........................................................................................................................................  98

Nozzle Recovery ..................................................................................................................................  184, 186

Nozzle Wash ................................................................................................................................  184, 263, 264

O

Offset ............................................................................................................................................................  122

Operating Panel .......................................................................................................................................  28, 35

Orange Maintenance....................................................................................................................................  186

Over Cut ...............................................................................................................................................  197, 199
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